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Preface

Audience

This document is intended for all Argus Insight administrators.

Documentation Accessibility

Our goal is to make Oracle products, services, and supporting documentation
accessible to all users, including users that are disabled. To that end, our
documentation includes features that make information available to users of assistive
technology. This documentation is available in HTML format, and contains markup to
facilitate access by the disabled community. Accessibility standards will continue to
evolve over time, and Oracle is actively engaged with other market-leading
technology vendors to address technical obstacles so that our documentation can be
accessible to all of our customers. For more information, visit the Oracle Accessibility
Program Web site at http: //www.oracle.com/accessibility/.

Accessibility of Code Examples in Documentation

Screen readers may not always correctly read the code examples in this document. The
conventions for writing code require that closing braces should appear on an
otherwise empty line; however, some screen readers may not always read a line of text
that consists solely of a bracket or brace.

Accessibility of Links to External Web Sites in Documentation

This documentation may contain links to Web sites of other companies or
organizations that Oracle does not own or control. Oracle neither evaluates nor makes
any representations regarding the accessibility of these Web sites.

Access to Oracle Support

Oracle customers have access to electronic support through My Oracle Support. For
information, visit http://www.oracle.com/support/contact.html or visit
http://www.oracle.com/accessibility/support.html if you are hearing
impaired.

Conventions

The following text conventions are used in this document:
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Convention

Description

Note

Bold Text

Italic Text
UPPERCASE TEXT

Bold Underline
Initial Capitals

A Note identifies information you should be aware of before
proceeding with the current task.

Bold text is used to emphasize words such as does not and must.
It is also used to identify user interface elements such as buttons,
dialog boxes, check boxes, combo boxes, drop-down lists, labels,
option (radio) buttons, tabs, text boxes, etc.

Italic text identifies information that may appear on the screen
(such as error message) or information the user must provide.

Uppercase text identifies keyboard keys. For example, SHIFT,
ENTER, CTRL, etc.

Identifies a link indicating that additional information is available.

Initial capitals are used to identify modules, applications, proper
nouns, etc.
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Introduction

Argus Insight Overview

This manual describes the various components of Argus Insight and explains the
interaction between them.

Argus Insight Overview

This topic explains the typical workflow followed in Argus Insight to generate a report.

Argus Insight Components

Argus Insight Process Flow

Argus Insight Components
In Argus Insight, you can generate a report in either of the following ways:

Use a query to retrieve a specific set of cases (Case Series) from the datamart and
then run a predefined report for those cases. Use the following Argus Insight
components to retrieve the Case Series:

- Query By Example (QBE)
— Filters
— Advanced Conditions

Run one of the following reports on the Case Series to create and store these in the
Reports Library:

—  Built-in Standard Reports
— Custom Reports

Create custom reports and analyze the data using the Report Writer, Cubes and
Dashboard Indicators.

Use Report Writer, Cubes and Dashboard Indicators to:
— Directly query the datamart

— Generate reports from the datamart using the Dashboard Indicators
component. Dashboard Indicators are pre-configured by the administrator.

Introduction 1-1



Argus Insight Overview

Note: The Report Writer is primarily used to directly query the
datamart and create custom reports. However, you can apply the
active Case Seriesfilter on the reports to reduce the data set and
improve report performance. Please note, that the Case Series might
become obsolete each time the datamart is refreshed by running an
ETL. This is because new cases with similar attributes might get
added to the datamart.

The following table describes the various components of Argus Insight:

Component Description

Query by Example Lets you create simple queries by entering specific values in fields on a form that

(QBE) looks substantially like the Argus Safety case form

Filters Lets you create queries by selecting a set of predefined fields and specifying
multiple values in a field

Advanced Lets you create complex queries by selecting any of the various different fields in

Conditions the datamart and applying Boolean and Set operations on them

Case Series

Standard Reports

Report Writer

Cubes

Dashboard Indicators

A listing of cases that match the query criteria

Predefined reports built into Argus Insight These reports are grouped into these
categories: Compliance, Management, Pharmacovigilance, Configuration, and
General Typically, these reports are run on the Case Series

Lets you directly query the datamart and create custom reports by selecting any
datamart fields as report columns; in the report output, you can apply filters,
create nested groupings, and perform operations such as sort, total, count, and
drill

The custom reports you create can be stored in the Report Writer Library or added
to the Argus Insight application; you can run the stored reports on a Case Series

Lets you run complex queries on the datamart and statistically analyze,
drill-down, and explore the results

Argus Insight has six predefined Cubes: Reporting-Compliance, Workflow,
Pharmacovigilance-Detail, Pharmacovigilance-General,
Pharmacovigilance-Clinical, and Pharmacovigilance-Interaction

Special reports that provide an insight into key parameters that let you monitor
product performance and workflow efficiency Dashboard Indicator reports are
pre-configured by the administrator and are generated directly from the datamart

Argus Insight Process Flow

The following flowchart depicts the set of steps that are typically followed in Argus
Insight to generate a report. Please refer to your company's guidelines for the exact
workflow for generating reports and analyzing data in Argus Insight.
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Argus Insight Overview

Log onto

Create a

FAegus Irsight

-

Execute
Query to

Query

_‘

Generate

Case Seﬁoi'

Generate
Standard
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the Case
Series

Create
Custom
Reports on
the Case
Sories

Query the
Datamart

The following table describes the tasks shown in the process flow diagram.

Task Description

Log on to Argus Log on to the Argus Insight application.

Insight

Create a Query Depending on the complexity of the query, use these Argus Insight

components to create a query:

Query by Example (QBE) - to create simple queries based on the fields in

Argus Case Form

Filters - to create queries based on multiple values in a set of predefined

fields

Advanced Conditions - to create complex queries by directly selecting
datamart fields and applying Boolean and Set operations on them

Execute the Query to Execute the query to have the system search the entire datamart and retrieve a

Generate a Case

Series the query.

Generate Standard

Reports on the Case  on the Case Series.

Series

Generate Custom

list of cases (Case Series) that match the criteria you specified while creating

Select and run a built-in Standard Report. You can limit this report to only run

Select and run a custom report you created and stored in the Report Writer

Reports on the Case  Library. You can limit this report to only run on the Case Series.

Series

Query the Datamart  Use the Report Writer, Cubes, or Dashboard Indicators, to directly query the
datamart and generate the required report.

Use the Report Writer to create new reports

Perform data analysis using Cubes

View the Dashboard Indicator Reports
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2

Upgradability and Compatibility

About Upgradability and Compatibility

It is essential for any software to be upgradable to higher versions as well as
compatible with multiple versions. This chapter describes about the upgrade and
compatibility of Argus Insight.

Upgrade Path

You can upgrade directly to this (6.0) version of Insight from Argus Insight version 5.1
and 5.1.1. After completing the upgrade, you must execute an initial ETL.

Product Compatibility
This version of Insight is compatible with the following products/versions.
= Argus Safety 6.0,5.1.1,5.1, and 5.0.3
= Argus Perceptive 6.0
This version of Insight has also been tested for SSL. compatibility.

Copy Configuration

You can Import configuration information from the following Insight versions and
export it to Argus Insight 6.0.

= Argus Insight 6.0

Upgradability and Compatibility 2-1
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Getting Started

Using Argus Insight

Argus Insight, formerly called Power Reports is a highly optimized reporting module
that compliments Argus Safety. The Argus Insight Extract Transfer and Load (ETL)
engine extracts data from the Argus Safety database and populates a data warehouse in
a format that allows efficient querying. The various query, drill-down, and output
components of Argus Insight let you analyze your safety, workflow, or product data
from all angles and produce reports that provide immediate business impact and
maximum efficiency in decision-making.

This chapter describes the tasks performed when logging into Argus Insight.

Getting Started
The following tasks help you get started with Argus Insight.

To launch the web-based Argus Suite of Products:
1. Open the Web browser.
2. Type the Argus Web URL (Universal Resource Locator) in the address bar.

The system uses the Secure Socket Layers to support third-party digital certificates for
secure transmissions at the system level. The System Administrator configures the
URL is configured by the System Administrator.

The system opens the login screen.

Getting Started  3-1



Using Argus Insight

e ARGUS INSIGHT

Version 6.0

User Name
l |

Password

l |

7/2/2010 11:34:02 AM

Copyright ® 2010 Oracle Corporation. All rights reserved.

Single Sign on

Be aware of the following;:

Users can have single-sign on capabilities.

The Argus Safety Administrator defines access to various modules in User
Maintenance. If a user is assigned to more than one group, the system provides the
user with the highest access level.

- Based on module access rights, the system enables / disables the application
buttons access rights in the Menu Structure.

- Group access permissions are assigned in Web Admin.

A user with access to Argus or Insight can launch the application modules. The
system does not ask the user to enter a password again for the PR or Argus
modules. This also applies when the user launches other applications.

In User Maintenance, the administrator can link the Argus, Perceptive, and Insight
Mart databases. When a user logs into the system, the system identifies the
available application modules for each Argus Instance.

When the user clicks the application modules, the system opens a New dialog
where the other application (Insight or Argus Safety) can be worked on.

When the user launches another application through Argus,or vice versa, the
application module buttons do not appear in the new dialog windows because the
user is already logged into the earlier application.

The initial login screen is the launching dialog forall other modules.

Logout is available only on the Parent Application dialog. Logging out of the Main
application dialog closes all child dialogs without saving information in the child
applications.

Getting Started 3-2



Using Argus Insight

= Sharing a Case Series
The system enables a user to share a case series between the following:
— Perceptive to Insight

* A case series is available from Perceptive through the Alert Preview and
Alert Details.

* If a case series from Perceptive contains cases not in the Insight data mart
(due to latency of the scheduled update), Insight drops these cases from
the case series and notifies the user of the dropped cases.

= Insight to Perceptive
— A case series is available from Insight through the Active Case Series.

— Case Series tab a Import Cases From Insight is available on the Alert Details
screen. This adds the cases from latest (current) Active Case Series for the
Insight user to the Case Series in Perceptive.

— If there are no cases in the Active Case Series in Insight or no Active Case
Series exists, Perceptive presents the user with the following message:

No cases have been exported from Insight

Logging On

The Argus Insight installation program automatically creates an account for the
system administrator and assigns the default user name and password as
administrator and password, respectively. The administrator account cannot be
deleted. This ensures that the system administrator can always log on to the system. In
a given session, only one system administrator can log on to the system.

We recommend that you change the administrator password after logging on to Argus
Insight for the first time. You can access Argus Insight through Argus Safety. This
feature has been introduced to enable you to use a single login id and password for all
Argus Modules. The modules that are enabled when you login to Argus Safety depend
on your access right to various Argus modules.

To log on to Argus Insight as an administrator:
1. Start Internet Explorer.
2. Type the Argus Insight Universal Resource Locator (URL) in the address bar.

3. Press Enter. The Argus Insight logon screen appears.

Getting Started 3-3



Using Argus Insight

orace  ARGUS INSIGHT

Version 6.0

HEALTH SCIENCES

User Name
| |

Password

7/2/2010 11:34:02 AM

Copyright ® 2010 Oracle Corporation. All rights reserved.

4. Type in the Username and Password.

Note: Type in username as administrator and password as password
to log in as the administrator.

5. Click Login. The Argus Insight home page appears.

3 oo . |t e Lot |
ORACLE |ARGUS INSIGHT  Sutarday Joiy 10 300 (ANHETINN

e e e
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Frarmaiooglance Prezanigures Pharrecrogastce fler BRm-2910 sdmratrattr Prarmacs g

Voanfew Precetned Warkfow Fler b s U Canernl L

T ke i | | e ik S || o 1| - Dot | E | it Ouery 1o Acve Case Sers  Luscuin
.
Changing the Password

Use the following procedure to change the password.

1. Click Tools on the global toolbar. The Administration Tools page appears with the
Personal Options tab displayed.

2. In the Old Password text box, enter the existing password.

Getting Started 3-4



Using Argus Insight

Administration Tools

| Porsonai List Maintenance | Security | Evischsduer | Dashmosrdindicator Optioes | Austiog
s oners
User Name:  phna User Full Hame: fcans
Oid Password Hew Password: Confirm Password:
Password Expires in 83 days.
Homepage:

Fiter Libeary -

Overwrite Confirmation Group Membershlp
[] Case Seres Gverwrie

[] ©BE overwree

[] Faer Overwrie

[] Advanced Condton Overwre

3. Inthe New Password text box, enter a new password. Your new password must
be different than your old password.
Note: Argus Insight passwords are case sensitive. The password
requirements are configured by the Administrator.
4. Re-enter the new password in the Confirm Password text box.
5.

In the New Password text box, enter a new password. Your new password must
be different than your old password.

6. Click OK. The system saves the new password.

Changing the Default Home Page

Use the following procedure to change the default Home page.
1. Click the Tools button on the global toolbar. The Administration Tools page
appears with the Personal Options tab displayed.

2. Select a home page from the Homepage drop-down list box.

Administration Tools

| Porsonai List Maintenance | Security | Evischsduer | Dashmosrdindicator Optioes | Austiog
v
User Name:  phna User Full Hame: fcans
Oid Password Hew Password: Confirm Password:
Password Expires in 83 days.
Homepage:

Fiter Libeary -

Overwrite Confirmation Group Membershlp

[] Case Seres Overwrte
[] GBE Overwres
[] Faer Overwrie

[] Advanced Condton Overwre

3. Click OK. The system changes the default home page to the selected page.

Tip: You can set any page as the default home page, by clicking the
Home Page button on the global toolbar.

You can make changes to the Personal Option tab page to configure

the password, default home page, overwrite confirmation, and group
membership of users.

Configuring the Argus Insight Application

You may need to configure Argus Insight and change certain factory defaults to
conform to the specific business requirements of your organization. Use the following
TheAdministration Toolschapter has information on configuring the following:

= Personal Options - password, default home page, overwrite confirmation, and

group membership of users.

Getting Started 3-5



Using Argus Insight

» List Maintenance - profile switches, countries, workflow mappings with Argus,
and categories.

= Security - creating, modifying, and enabling/disabling user groups and accounts.
= ETL Scheduler - configuring ETL.

= Dashboard Indicators - assigning specific dashboard reports to users and
applying filters to dashboard reports.

= Audit Log - monitoring user activities on the system.

Entering Dates in Various Argus Insight Fields

Throughout Argus Insight, you are required to enter dates in several fields. Fields that
accept full dates appear in the dd-mmm-yyyy format. You can enter the month using
numbers instead of three letters. When you enter a valid month number, the system
automatically converts the number to letters corresponding to that month. For
example, 03 for the month automatically gets converted to MAR.

Tip: To enter the current date in a datefield, press the = key on the
keyboard

You can enter partial dates in certain fields. Fields that accept partial dates appear in
approximated to the 15th of the month and missing months are approximated to the

month of June

Valid partial dates must comprise either a year, or a year and a month. If you enter the
day, you also need to enter the month.

The following fields in the QBE form, which is similar to the Argus Case form, accept
partial dates.

QBE Form Tab Field
Patient Date of Birth

Other Relevant History
Start Date

Other Relevant History
Stop Date

Lab Data
Date

Patient > Parent Date of Birth
Product Expiration Date

Dosage Regimen

Start Date/Time

Dosage Regimen
Start Date/Time

Summary of all regimens

First Dose

Summary of all regimens

Last Dose

Getting Started 3-6



Using Argus Insight

QBE Form Tab Field

Product > Vaccine Date

History

Product > Device Date Explanted

Event

Event > Death

Event > Hospitalized

Date Implanted
Expiration Date
Onset Date
Stop Date
Death Date
Start Date

End Date

The following table lists some examples of partial dates.

Date to be Entered Partial Date Formats
March, 2005 Enter any one of

these sequences:

= 0032005

= 00305

= 7?7305

= 72305

= /32005

= /305

= 00MAR2005

= 00MARO05

= 7232005

= ??MAR2005

= /MAR2005
2005 Enter any one of

these sequences:

= 00002005

= 000005

= 7?2005

= 2205

= //2005

= //05

= ??27?272005

s 2277205

Getting Help

Click the Help button on the global toolbar to access the Online Help. You can find
information by using the Contents, Index, or Search tabs in the Online Help.
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Logging Out

Use the following procedure to log out.

1. Click Logout on the global toolbar. A confirmation dialog box appears.

Argus Insight

@ Are you sure you wish to logout?

Egk] | cancel |

2. Click OK. The system logs you out. The Argus Insight logout screen appears.
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Creating Queries

Creating Queries

In Argus Insight, you use queries to search the datamart and retrieve a set of cases
(Case Series) with similar attributes. Based on your reporting requirements, your
querying criteria may be as simple as a few Argus case form fields with specific values
or as complex as a SQL query that uses Boolean/Set operations between various
datamart fields.

This chapter explains how to use the Argus Insight querying tools and in what
situations. Depending on how complex or detailed a query you want to create, you can
use these Argus Insight querying tools:

QBE
Filters
Advanced Conditions

Library

Note: You may be allowed to enter more than 4000 characters in text
box, but the query search is limited to the first 4000 characters.
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QBE

If you are familiar with the Argus case form, you may choose Query by Example (QBE)
to create simple queries. For a QBE, the querying criteria consists of specific values
entered in the fields on the QBE form, which looks substantially like the Argus case
form. For example, your QBE may consist of the values in these fields:

QBE Form Tab > Field Value

Entered /Selected
General > Country of Incidence United States
Products > Product Name Algoheal Injection

Events > Event Description to be Coded Injection site rash

Events > Seriousness Criteria Hospitalized

When you execute this QBE, the system retrieves only those cases where the values of
Country of Incidence, Product Name, CodedEvent Description, Event Description to
be Coded and Seriousness Criteria are the same as specified in your QBE.

These topics explain how to work with QBE:

s Creating a New QBE

»  Working with the Last Modified or Executed QBE
= Working with Saved QBEs

= Using QBEs with Advanced Conditions

Creating a New QBE

Begin creating a QBE by entering values in the QBE form. The QBE form has a
tab-based interface consisting of eight multiple section tabs.

The first seven tabs in the QBE form let you enter the query criteria about a specific
aspect of a case:

QBE Form Tab Type of Information to Enter

General Lets you enter querying criteria based on general, study, reporter, and
literature information about the case

Patients Lets you enter querying criteria based on information about the patient, lab
data, other relevant history, and the patient's parent

Products Lets you enter querying criteria based on product information and dosage
regimens

Events Lets you enter querying criteria based on information about the event and
its seriousness criteria

Analysis Lets you enter querying criteria based on information about case analysis
and imputability

Activities Lets you enter querying criteria based on case activity information, such as

contact logs, action items, and case lock/archive dates

Additional Info Lets you enter querying criteria based on additional information about the

case such as references

The eighth tab in the QBE form, Advanced Conditions, lets you integrate a QBE with
an Advanced condition stored in Argus Insight. You can also convert a QBE into an
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Advanced Condition. The Using QBEs with Advanced Conditions topic explains this
in detail.

Note: For more sophisticated queries, use Filters or Advanced
Conditions.

While specifying the query criteria in Query By Example page (QOBE form), Argus
Insight provides the functionality of Type Ahead in few fields. Type Ahead
functionality offers you to type-in a value and the like values are displayed in the list
box. It also enables you to select the desired value from the list of values. The fields
having this functionality are as follows:

Accidental Exposure  Action Taken Action Type Age Groups Age Units
Anatomical Locations Attachment Birth Type Case Classification Causality Category
Classification
Condition Type Contact Type Delivery Types Device Device Type
Subcomponents
Dosage Frequency Dosage Units Ethnicity Event Frequency Event Intensity
Event Outcome Fetal Outcome Formulation Gender Group
(Activities:contact
log)
Group (Action item) Intermediary Locked or Closed By Manufacturers Occupations
Package Units, Reference Type Report Media Report Type Reporter Type
Routes of User User (Action item)
Administration (Activities:contact
log)
Type Ahead
Report Type

co|

| Compassionate Use

You can use the type-ahead functionality to select data suggestions by double-clicking
on a textbox to display all the suggestions for a field in a list of values. Alternatively,
you can also you can type-in a value and suggestions are displayed for the typed
value.

Use the following procedure to create a new QBE and work with it. To log out of
Argus Insight:

1. Start the new QBE. In Argus Insight, select Create Query > Query By Example >
New. The Query By Example page (OBE form) appears; the General tab page is
displayed.
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Specify the querying criteria. Enter values in the fields within the various tab
pages, as appropriate.

Refer to these pages for descriptions of all the fields in the various tab pages of the
QBE form:

Note: The QBE field labels are displayed as per the field labels
configured in Argus

= General Page

= DPatient Page

= Products Page

= Events Page

= Analysis Page

»  Activities Page

= Additional Info Page
Tip: While entering values in a tab, if you wish to clear all the values
you entered, click the Clear Tab button. If you wish to clear all the
values you entered in all the tabs, click the Clear All button.

Examine the QBE result.

Click Execute. While the system searches for matching cases, the following dialog
box is displayed.
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e | Argus Insight - Case Series Building -- Webpage Dialog g‘

Building Case Series.
Please wait...

»  If the system does not find any cases that match the querying criteria, the
following screen is displayed. Click Cancel to return to the QBE form, modify
the criteria and execute the QBE again.
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»  If the system finds cases that match the query criteria, a list of such cases is
displayed in the Active Case Series page.
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5. Examine the Case Series. If the Case Series is too large, you may want to modify
the QBE by specifying additional field values in the QBE form to narrow down the
Case Series. Alternatively, if you find the Case Series to be appropriate, you can
save the QBE to the system.

6. To return to the QBE form, click View Query in the Active Case Series page. The
Active Query by Example page appears.
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Note: When you save the modifications to a QBE or execute a QBE,
the system assigns the Active status to the QBE. Therefore, when you
return to the QBE form after executing the QBE, the page title changes
to ActiveQuery By Example. The field values you specified in the
QBE form before executing are retained. See the Working with the Last
Modified or Executed QBE topic for details on Active QBEs.

7. If required, modify the QBE and examine the result again or proceed to save the
QBE.

8. Save the QBE to the system.

9. Use the Category list box to assign a category to the QBE you are going to save. A
category indicates the reporting aspect to which your QBE pertains: Compliance,
Configuration, General, Management, or Pharmacovigilance. Specifying the
category also helps you in searching the relevant QBEs from a list of all the QBEs
saved in the system.

10. Type a description of the QBE in the Description text box. For example, you can
describe the type of cases the QBE retrieves.

11. Click Save As in the ActiveQuery By Example page. The Save QBE dialog box
appears.

A Argus Insight - Save OBE As -- Webpage Dialog rg|

Save QBE As

Name:

I 0K I Cancel
———

12. Type the name of the QBE in the Name text box.

Note: A name cannot contain any of the following: % "' A ~; | #

13. Click OK. The system refreshes the Query By Example page. Note that the
following new elements appear on the page.

»  The page title changes to Query By Example.

»s  The Active Query Name field in the upper-right corner of the page now
displays the name of the QBE you specified while saving the QBE.

= Two new buttons appear at the bottom of the page: Save and Permissions.

Note: All the QBEs that you save to the system are listed in the
Query By Example - Library page. The Working with Saved QBEs
topic explains how to work with saved QBEs.
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Tip: If you make modifications to the field values after you have
saved the QBE to the system, use the Save button to save the changed
field values.

Assign group-level permissions on the saved QBE
Use the following procedures to assign group-level permissions to a saved QBE

To assign group-level permissions to a saved QBE:

1. Click the Permissions button. The Permissions dialog box appears. A list in this
dialog box displays the names of all the groups (except the Administrator group)
that the system administrator has created.

Permiszions for OBE: New QBE
Legend
Blinded No Access ¥ R = Read
UnBlinded No Access hd W= "Write
D = Delete
P = Object
Permizsion
No Access
[ ok || cancel |

Use the list box next to a group name to assign permissions to the group members
on the QBE you have created. You can select from these options:

Permission Description

No Access (Default)  No group members will be able to access the QBE

R Group members will be able to only view the QBE

R/W Group members will be able to view and modify the QBE
R/W/D Group members will be able to view, modify, and delete the QBE
R/W/D/P Group members will be able to view, modify, delete, and assign

permission on the QBE

2. Click OK. The system saves the permission settings.
3. Execute the QBE.

4. Click Execute. The system retrieves the list of cases that match the QBE criteria
and displays it in the Active Case Series page.

After generating the Case Series, you can manually modify it or save it. See the
Working with Case Series chapter for more information on working with Case
Series.
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General Page
The General page differs from what you might be used to seeing in Argus in the
following ways:

= You can specify only one follow-up date
= You can specify only one case classification
= You can specify information only about one reporter

= You need to scroll down the page to view all the fields available.
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The following table describes the various fields in the General page. The field
values you specify are used as the query criteria to retrieve matching cases.

Section

Field Description

General Information =~ Report Type Use this list box to select the case source that the query

should look for in cases.

Country Use this list box to select the country of incidence that the
query should look for in cases.

Initial Receipt Date In this date field, enter the date when you company first
became aware of the case.

Central Receipt Date In this date field, enter the date on which the Central Safety
received the case.

Case Status Use this list box to select the workflow state that the query
should look for in cases.

Follow-up Received In this date field, enter the follow-up information receipt
date that the query should look for in cases.

Safety Received In this date field, enter the date on which follow-up
information was received by Central Safety.

Significant Check this checkbox to retrieve cases that had a significant
follow up.

Aware Date In this date field, enter the most recent significant follow-up

date or initial receipt date (if there are no follow ups), that
the query should look for in cases.
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Section Field Description

StudyInformation Study Num Click the Select button associated with this text box to
select the study protocol number, study number and center
id that the query should look for in cases.
See theSelecting the Study Numbersection for details.

Study Type Select the study type that the query should look for in cases.

Other Study ID In this text box, enter any other ID that can be relevant to
the study.

Study Week In this text box, enter the week number of the study during
which the adverse event occurred. The query will only look
for such cases.

Study Visit In this text box, enter the visit number of the study during
which the adverse event occurred. The query will only look
for such cases.

Study Blinding Status ~ Use this list box to select the study blinding status that the
query should look for in cases.

Study Broken Date In this date field, enter the date on which the study was

broken. The query will only look for cases with matching
study broken date.
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Section

Field

Description

Reporter Information

Reporter Sal.

Reporter First Name

Reporter Middle Name

Reporter Last Name
Reporter Suffix
Health Care
Professional
Reporter Occupation
Reporter Address
Reporter Institution
Reporter Department
Reporter City
Reporter State
Reporter Postal Code
Reporter Country ID
Reporter Phone

Number

Reporter Alternate
Phone

Reporter Fax Number
Reporter ID
Reporter's Reference #
Reporter Email
Address

Reporter Type

Report Media

Intermediary

Report Sent to
Regulatory Authority
by Reporter

Reporter Protect
Confidentiality

Enter the reporter salutation that the query should look for
in cases.

Enter the reporter's first name to look for in cases.
Enter the reporter's middle name to look for in cases.
Enter the reporter's last name to look for in cases.
Enter the reporter's suffix to look for in cases.

Select an option from this list box to include a query
criterion based on whether the reporter is a health care
professional.

Use this list box to select the reporter's occupation that the
query should look for in cases.

In this text area, enter the report address that the query
should look for in cases.

In this text box, enter the reporter's institution that the
query should look for in cases.

In this text box, enter the reporter's department that the
query should look for in cases.

In this text box, enter the reporter's city that the query
should look for in cases.

In this text box, enter the reporter's state that the query
should look for in cases.

In this text box, enter the reporter's postal coded that the
query should look for in cases.

In this text box, enter the reporter's country ID that the
query should look for in cases.

In this text box, enter the reporter's phone number that the
query should look for in cases.

In this text box, enter the reporter's alternate phone number
that the query should look for in cases.

In this text box, enter the reporter's fax number that the
query should look for in cases.

In this text box, enter the reporter ID that the query should
look for in cases.

In this text box, enter the reporter's reference number that
the query should look for in cases.

In this text box, enter the reporter's email address that the
query should look for in cases.

Use this list box to select the reporter type that the query
should look for in cases.

Use this list box to select the report media that the query
should look for in cases.

Use this list box to select the intermediary that the query
should look for in cases.

Select the Yes, No, Unknown, or Ignore option button, as
appropriate, to indicate whether the query should look for
cases where the reporter has already informed a regulatory
authority about the event.

Check this checkbox to have the query retrieve only those
cases where reporter information is specified as
confidential.
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Section Field Description
Literature Literature Journal In this text box, enter the literature journal name that the
Information query should look for in cases.

Literature Author

Literature Title

Literature Vol

Literature Year

Literature Pgs

In this text box, enter the literature author name that the
query should look for in cases.

In this text box, enter the literature title that the query
should look for in cases.

In this text box, enter the literature volume that the query
should look for in cases.

In this text box, enter the literature publication year that the
query should look for in cases.

In this text box, enter the journal page number in which the
article appeared. The query will look for this information in
cases.

Selecting the Study Number

Argus Insight lets you select the Study Protocol #, Study Num and Center ID fields in
the Study Information section, by selecting the study number from the Clinical Study

Lookup dialog box.

Use the following procedure to select a clinical study:

To select a clinical study:

1. Click the Select button associated with the Study Num field. The Clinical Study
Lookup dialog box appears.

2 Argus Insight -- Webpage Dialog 3]

Clinical Study Lookup

Project Study Center

[ 1T | [ search | [ clear |
Clinical Studies 0-0/0 [=f=f=]=]

Select | [ Cancel

2. Enter the first few letters of the project name, study ID, or study center name in
their respective text boxes.

Tip: If you are not sure about the information you are looking for, as
an alternative, click search to list all the associated data for Study

Num.

3. Click Search. The system searches for the specified search strings. The Clinical
Study Lookup dialog box displays the search result in a grid format.
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2 Argus Insight -- Webpage Dialog

Clinical Study Lookup

Project Study Center
[cure I[ ||
Ciinical Studies 1-2481248
CURE CURE ALL US 002 A
CURE CURE ALLUS 001 =
CURE CURE ALL PL 001 Sweden
cuRE CURE ALL PL 001 Spain
CURE CURE ALLPL 001 Folang
CuRE CURE ALL PL 01 Horway
CURE CURE ALLPL 001 Netheriand
CuRE CURE ALL PL 01 Luxemburg
CURE CURE ALLPL 001 Latvia
CURE CURE ALL L 01 taly
CURE CURE ALLPL 001 reland
CURE CURE ALL L 001 Hungary
CURE CURE ALL PL 001 Greece
CURE CURE ALLFL 001 Great britain v
select | | Cancel

4. Select a study from the Clinical Studies listed.

5. Click Select in the Clinical Study Lookup dialog box. The Study Protocol #,
Study Num (*) and Center ID(*) fields in the Study Information section of the
QBE form are automatically selected.

Note: The Study Num and Center ID are optional fields.

Patient Page
The Patient page has two views: Patient and Parent.

The Patient view differs from what you might be used to seeing in Argus in the
following ways:
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= You can specify information only about one lab data element
= You can specify details of only one relevant history
You need to scroll down the page to view all the fields available.

The following table describes the various fields in the Patient view of the Patient page.
The field values you specify are used as the query criteria to retrieve matching cases.
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Section

Field

Description

Patient Information

Patient Sponsor
Identifier

Patient Subject #
Patient First Name
Patient Last Name
Patient MI

Patient Initials

Patient
Randomization
Number

Patient Protect
Confidentiality

Number of Patients

Patient Address
Patient City

Patient State

Patient Postal Code
Patient Country
Patient Date of Birth
Patient Age

Patient Age Units
Patient Age Group
Patient Gender

Patient Weight

Patient Height

Patient Ethnicity

Patient Occupation

In this text box, enter the study sponsor's ID. The query will
look for this information in cases.

In this text box, enter the patient subject number that the
query should look for in cases.

In this text box, enter the patient's first name that the query
should look for in cases.

In this text box, enter the patient's last name that the query
should look for in cases.

In this text box, enter the patient's middle initials that the
query should look for in cases.

In this text box, enter the patient's initials that the query
should look for in cases.

In this text box, enter the patient randomization number
that the query should look for in cases.

Check this checkbox to retrieve those cases where patient
information is marked as confidential.

In this text box, enter the number of patients.

In this text box, enter the patient's address that the query
should look for in cases.

In this text box, enter the patient's city that the query should
look for in cases.

In this text box, enter the patient's state that the query
should look for in cases.

In this text box, enter the patient's postal code that the query
should look for in cases.

In this text box, enter the patient's country that the query
should look for in cases.

In this date field, enter the patient's date of birth that the
query should look for in cases.

In this text box, enter the patient's age that the query should
look for in cases.

Select the age unit for the value you specified in the Patient
Age text box.

Select the patient age group that the query should look for
in cases.

Select the patient gender that the query should look for in
cases.

In this text box, enter the patient weight that the query
should look for in cases. Select the 1bs or kg option button,
as appropriate.

In this text box, enter the patient's height that the query
should look for in cases. Select the in or cm option button,
as appropriate.

Select the patient's ethnicity that the query should look for
in cases.

Select the patient occupation that the query should look for
in cases.
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Section Field Description

Pregnancy Select the Yes, No, Unknown, N/A, or Ignore option button,
as appropriate, to indicate whether the query should look
for cases where the patient's pregnancy status is specified.
This field is available only if you specify the patient gender
as Female

Pregnancy In this date field, enter the date of last menstrual period that
Information Date of  the query should look for in cases.
Last Menstrual Per.

Lab Data Lab Data Test Name  Click the associated Select button to select the lab test that
the query should look for in cases. See theSelecting Lab
Testsection for more information.

Lab Data Result In this text box, enter the lab data result that the query
should look for in cases.

Lab Data Normal In this text box, enter the lab data normal low value that the

Low query should look for in cases.

Lab Test Date In this date field, enter the lab test date that the query

should look for in cases.

Lab Data Result Unit Enter the lab data result unit for the value you specified in
the Lab Data Result field.

Lab Data Normal In this text box, enter the lab data normal high value that
High the query should look for in cases.
Other Relevant Relevant History In this date field, enter the relevant history start date that
Information Start Date the query should look for in cases.
Relevant History Select the relevant history condition type that the query
Condition Type should look for in cases.
Relevant History In this text box, enter the relevant history notes that the
Notes query should look for in cases.
Relevant History In this date field, enter the relevant history stop date that
Stop Date the query should look for in cases.
Relevant History Click the associated Encode button to select the relevant
Condition history condition by using the MedDRA browser. The query

will look for the encoded term.

See theUsing the MedDRA Browser section for details.

Relevant History Check this checkbox to retrieve cases where the relevant
Continues history condition is continuing/ongoing.

Patient Relevant Tests In this text area, enter the relevant patient tests that the
query should look for in cases.

This Parent view differs from what you might be used to seeing in Argus in the
following ways:
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= You can specify details of only one relevant history
= You can specify details of only one medical history

The following tables describes the various fields in the Patient view of the Patient
page. The system uses the field values you specify the query criteria to retrieve
matching cases.

Section Field Description
Parent Parent Initials In this text box, enter the parent's initials that the query
should look for in cases.
Parent Age In this text box, enter the parent's age that the query
should look for in cases.
Parent Age Unit Select the age unit for the value you specified in the
Parent Age text box.
Parent Gender Select the parent gender that the query should look for in
cases.
Parent LMP In this date field, enter the parent's LMP date that the

query should look for in cases. This field is available only
if the parent gender is specified as Female.

Parent Weight In this text box, enter the parent's weight that the query
should look for in cases. Select the Ibs or kg option
button, as appropriate.

Parent Height In this text box, enter the parent's height that the query
should look for in cases. Select the in or cm option
button, as appropriate.

Parent Breast feeding Check this checkbox to retrieve cases where parent is
breast feeding.
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Section Field Description
Other Relevant Relevant History In this date field, enter the relevant history start date that
Information Start Date the query should look for in cases.
Relevant History Select the relevant history condition type that the query
Condition Type should look for in cases.
Relevant History In this text box, enter the relevant history notes that the
Notes query should look for in cases.
Relevant History In this date field, enter the relevant history stop date that
Stop Date the query should look for in cases.
Relevant History Click the associated Encode button to select the relevant
Condition history condition by using the MedDRA browser. The
query will look for the encoded term.
See theUsing the MedDRA Browsersection for details.
Relevant History Check this checkbox to retrieve cases where the relevant
Continues history condition is continuing / ongoing.
Selecting a Lab Test

Use the following procedure to select a Lab Test:

1.

Click the Select button associated with the Lab Data Test Name field. The Lab

Test Name dialog box appears.

e | Argus Insight -- Webpage Dialog

Lab Test Hame

Enter portions of the test name and click on Search:
Description
|| | | Search

Lab Test Types

| select || cancel |

2. Type a few initial letters of the test name.

3. Click Search. The matching test names appear in a list.
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| Argus Insight -- Webpage Dialog

Lab Test Hame

Enter portions of the test name and click on Search:
Description
Blood

Lab Test Types
Blood albumin
Blood Area
Blood bilirubin
Blood calcium

|

Blood creatining
Blood fibrinogen

Blood glucose

Blood lactate dehydrogenase
Blood magnesium

Blood potassium

v
Bland nndi

| select || cancel |

4. Select the required test name.

5. Click Select. The test name appears in the Lab Data Test Name field in the QBE
form.

Using the MedDRA Browser
Use the following procedure to use the MedDRA Browser to search and select
MedDRA terms for an event.

1. Click the Encode button associated with the QBE tabs to launch MedDRA
browser. The MedDRA Browser appears.

a Argus Insight - MedDRA Browser -- Webpage Dialog

MedDRA Browser

Current Coding Version: 12.0 MedDRA SMQ: v | |:| Full Search

Clear

NOTE: The QBE only supports single selection in the MedDRA Browser

s0C HLGT HLT

HLGT
HLT

LLT

Add & Close | [ Cancel
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Note: The output returned by the MedDRA browser for the Patient,
Product and Analysis tabs of QBE is the Preferred Term (PT). The
Events tab of QBE provides output for multiple options. You can
select and search the required term(s), based on the Seriousness
Criteria.

2. Enter the first few letters of the SOC, HLGT, HLT, PT, or LLT term in the respective
text box. If you want the system to search for the specified word in the entire event
term, check the Full Search checkbox.

Note: The Special Category drop-down list displays all the SMQs
that can be selected. The selected SMQ searches across PT and LLT
levels of the MedDRA dictionary.

The Special Category drop-down list is hidden in MedDRA 10. The
MedDRA SMQs drop-down list is hidden in versions lesser than
MedDRA 9.

3. Press Tab. The system searches for the specified word in the event terms. The
MedDRA Browser displays the search result in a column below the text box in
which you entered the text string.

a Argus Insight - MedDRA Browser -- Webpage Dialog

MedDRA Browser

Current Coding Version: 12.0
s0C HLGT HLT PT LLT
|| Il || Il
Ganglioneuroma
s0C
HLGT
HLT
PT
LLT
| Add&cse | | cancel |

4. Select the required event term from the search result. The SOC, HLGT, HLT, PT,
and LLT fields in the MedDRA Browser display the respective terms for the
selected event. The fields that are highlighted in the colors listed below have the
following significance.
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a Argus Insight - MedDRA Browser -- Webpage Dialog

MedDRA Browser

Current Coding Version: 12.0 MedDRA SMQ: (M) SMQ PT_LLT_CHLSMQPL v | [] Full Search
Clear
NOTE: The QBE only supports single selection in the MedDRA Browser
50C HLGT HLT PT LLT
Neoplasms benign, Nervous system Neuromas Ganglioneuroma Gangliocytoma
malignant and unspecified neoplasms benign Ganglioneuroma
{incl cysts and polyps) Vo
Nervous system disorders
s50C 10029104 Neoplasms benign, malignant and unspecified (incl cysts and polyps)
HLGT 10029209 Nervous system neoplasms benign
HLT 10028312 Neuromas
PT 10017709 Ganglioneuroma
LLT
Add & Close | [ Cancel
If the row coloris...  This signifies...
Yellow The selected hierarchy is the primary SOC path.
Grey The selected hierarchy is not the primary SOC path.

5. Check the SOC, HLGT, HLT, PT, and LLT checkboxes to populate the
corresponding fields in the QBE form.

6. Click Select.

7. The selected codes for the selected event are displayed in the respective fields in
the QBE form.

Products Page

The Products page differs from what you might be used to seeing in Argus in the
following ways:

= You can enter information only about one product
= You can specify details of only one dosage regimen

= You need to scroll down the page to view all the fields available.
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The following table describes the various fields in the Products page. The field values
you specify are used as the query criteria to retrieve matching cases.
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Section

Field

Description

Product Information

Dosage Information

Product Name

Product WHO Drug
Code

Product Type

Product
Manufacturer

StudyDrug

ATC Code
ATC Description

Drug Formulation

Drug Concentration

Drug Primary
Indication

Drug Interaction

Drug
Contraindicated

Dosage Regimen
Start Date

Dosage Regimen
Stop Date

Dosage Regimen
Ongoing

Dosage Regimen
Outside Therapeutic
Range

Click the associated Select button to use the Product Browser to
specify the product as the query criteria.

Selecting the product name automatically populates the Product
Name, Product Generic Name, and Company Drug Code fields in
the QBE form.

See theUsing the Product Browsersection for details.

Click the associated Encode button to use the Drug Coding Browser
to specify the WHO drug name as the query criteria.

See theUsing the WHO Drug Browsersection for details.

Select the Suspect, Concomitant, Treatment, or Ignore option
button, as appropriate, to indicate whether the query should look
for cases where product type is specified.

Select the product manufacturer that the query should look for in
cases.

Click the associated Select button to use the Study Drug Lookup
dialog box to specify the study drug name as the query criteria. Use
this field to retrieve clinical trial cases with the selected study drug.

See theUsing the Study Drug Lookupsection for details.

Enter the Anatomical, Therapeutic, Chemical (ATC) classification
code that the query should look for in cases.

Enter the Anatomical, Therapeutic, Chemical (ATC) classification
description.

Select the drug formulation that the query should look for in cases.

Enter the drug formulation that the query should look for in cases.
Select the concentration unit from the Drug Product Concentration
Units ID list box.

Click the associated Encode button to use the MedDRA Browser to
specify the drug primary indication event term as the query
criteria.

See theUsing the MedDRA Browsersection for details.

Select the Yes, No, Unk, or Ignore option button, as appropriate, to
indicate whether the query should look for cases where drug
interaction status is specified.

Select the Yes, No, or Ignore option button, as appropriate, to
indicate whether the query should look for cases where drug
contraindication status is specified.

In this date field, enter the dosage regimen start date that the query
should look for in cases.

In this date field, enter the dosage regimen start date that the query
should look for in cases.

Check this checkbox to retrieve cases where the dosage regimen is
ongoing.

Check this checkbox to retrieve cases where the dosage regimen is
outside therapeutic range.

This means that the drug has not been used in accordance with the
label or has been used for outside the Therapeutic Range. Consult
your Administrator for further company-specific information on
the use of this field.
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Section Field

Description

Dosage Regimen
Duration

Dosage Regimen
Accidental Exposure

Dosage Regimen
Dose No.

Dose
Dose Units
Frequency

Dosage Regimen
Dose Description

Regimen Daily Dose
Regimen Daily
Dosage Unit

Total Regimen
Dosage

Total Dosage
Regimen Unit

Dosage Regimen
Route of
Administration

b | Argus Insight - Duration Calculator. -- Webpage Di... rz|

Duration Calculator
(& Minutes Duration Value Band
Time Unit
| Hours v|| Calculate
Duration Band Value
Calculated to:
| select || cancel |

In this text box, enter the dosage regimen duration in minutes as
the query criteria.

OR

Click Calculate to view the duration calculator, to calculate the
dosage regimen duration in minutes or duration value bands.

1. Click the associated Calculate button to convert hours, days,
weeks, months, or years to minutes

2. Enable the Duration value band option.

3. Select the duration band and its value from the drop-down
lists. These ranges are configured by the administrator through
List Maintenance.

4. Click Select to confirm the operation. The values are displayed
in the Products page.

Select the area of accidental exposure as the query criteria.
In this text box, enter the drug dose number as the query criteria.

In this text box, enter the drug dose received by the patient as the
query criteria.

Use this list box to specify the units for the value you specified in
the Dose field.

Use this list box to specify the dosage frequency as the query
criteria.

In this text box, enter the dose description based on the values you
specified in Dose, Dose Units, and Frequency fields.

In this text box, enter the daily dose based on the values you
specified in Dose and Frequency fields.

Select the same option you selected in the Dose Units list box.
daily dose, duration, and frequency
Select the total dose regimen unit based on the values you specified

in Dose, Dosage Regimen Duration, and Frequency fields.

Select the route of dosage administration as the query criteria.

Creating Queries 4-22



Creating Queries

Section

Field

Description

Dosage Regimen
Route (Parent)

Dosage Regimen
Package ID

Dosage Regimen
Package Units

Dosage Regimen
Batch/Lot #

Expiration Date
Drug First Dose
Drug Last Dose

Drug Duration of
Administration

Total Drug Dosage

Drug Product Total
Dose Unit

Product Event Delay

Product Event
Latency

Drug Cumulative
Dose

Drug Info Action
Taken

Other Information

Drug Taken
Previously

Drug Dechallenge

Drug Dechallenge
Date

Drug Rechallenge

Drug Rechallenge
Start Date

Drug Rechallenge
Stop Date

Select the route of dosage administration of the parent as the query
criteria.

Enter the package ID as the query criteria.
Select the package units.
Enter the batch/lot number as the query criteria.

Enter the product expiration date as the query criteria.
Enter the earliest dosage regimen start date as the query criteria.
Enter the latest regimen stop date as the query criteria.

Enter the duration of drug administration as the query criteria.

This duration is the difference between the first and last dose for all
dosage regimens.

Enter the total drug usage duration as the query criteria.

Enter the total dosage unit as the query criteria.

This is based on the daily dose, duration and frequency.
Enter the time between the event onset and the fist dose

Enter the time between the event onset and the last dose
Enter the total dose for the drug
Select the action taken to mitigate the adverse event

Check the Drug Abuse, Drug Overdose, and Tampering
checkboxes

Select the Yes, No, Unk, or Ignore option button, as appropriate, to
indicate whether the query should look for cases where drug was
taken previously.

Select the Yes, No, Unk, N/A or Ignore option button, as
appropriate, to indicate whether the query should look for cases
where drug dechallenge status is specified.

Enter the drug dechallenge date as the query criteria.

Select the Yes, No, Unknown, N/A or Ignore option button, as
appropriate, to indicate whether the query should look for cases
where drug rechallenge status is specified.

Enter the rechallenge start date as the query criteria.

Enter the rechallenge stop date as the query criteria.

Using the Product Browser
Use the following procedure to explain how to select a product by using the Product
Browser.

Click the Select button associated with the Product Name field. The Product

Browser appears.
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e | Argus Insight - Product Browser, -- Webpage Dialog

Product Browser

[] Full Search Clear

Ingredient Family Product Hame Trade Name

Family
Ingredient
Product Hame
Trade Hame

| select | | cancel |

Enter the first few letters of the product ingredient, family name, product name, or
trade name in the respective text box. If you want the system to search for the
specified string in the entire product information, check the Full Search checkbox.

Press Tab. The system searches the database for the specified search string. The
Product Browser displays the search result in a column below the text box in which
you entered the search string.
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e | Argus Insight - Product Browser, -- Webpage Dialog

Product Browser

[] Full Search Clear
Ingredient Family Product Hame Trade Name
| |[cure I
Cure All - Family Cure All

Family

Ingredient

Product Hame

Trade Hame

| select | | cancel |

4. Select an item from the search result list. The details for the selected item are
displayed in all the Product Browser fields.

e | Argus Insight - Product Browser -- Webpage Dialog

Product Browser

[] Full Search

Clear

Ingredient

Family

Product Hame

Trade Hame

||Cure ||

Cure All (ING1)
Cure All (ING2)
Cure All (ING3)
Cure All (ING4)
Cure All (INGS)

Cure All - Family Cure All

Cure All [Capsule, 1000 mg]
Cure All [Capsule, 250 mg]
Cure All [Capsule, 500 mg]
Cure All [Granule]

Cure All [Injection]

Cure All [Unknown]

Family
Ingredient
Product Hame
Trade Hame

Cure All - Family Cure All

Cure All (ING1} , Cure All (ING2} , Cure All (ING3) , Cure All (ING4) , Cure All (INGS)

select | |

Cancel
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5. Select the required product name and trade name, as appropriate. The selection is
highlighted in the Product Browser.

e | Argus Insight - Product Browser, -- Webpage Dialog

Product Browser

Cure All (ING2)
Cure All (ING3)
Cure All (ING4)
Cure All (INGS5)

[] Full Search
Ingredient Family Product Hame Trade Name
|[cure I |
Cure All (ING1) Cure All - Family Cure All Cure All [Capsule, 1000 mg] Cure All_INV

Cure All [Capsule, 250 mg]
Cure All [Capsule, 500 mg]
Cure All [Granule]

Cure All [Injection]

Cure All [Unknown]

Begin Cure Al_MKT Trade Name
Cure All_MKT Trade Name Cure
AILMKT_END

Cure Al MKT

Family
Ingredient
Product Hame
Trade Hame

Cure All - Family Cure All

Cure All (ING1) , Cure All (ING2} , Cure All (ING3) , Cure All (ING4) , Cure All (INGS)

Cure All [Capsule, 500 mg]

| select | | cancel |

6. Click Select. The Product Name, Product Generic Name, Company Drug Code,
Drug Formulation, Drug Concentration and Drug Product Concentration Units ID
fields in the QBE form are automatically populated with the details of the selected

product.

Using the WHO Drug Browser
Use the following procedure to select a WHO drug product by using the WHO Drug

Browser.

1. Click the Encode button associated with the Product Name field. The WHO Drug
Browser appears.
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a Argus Insight - WHO Drug Browser -- Wehbpage Dialog

Drug Coding (WHO-DRUG)

Product Type ATC Code (%) Drug Code () Medicinal Prod ID (%) Trade Name () Ingredient Formulation Country [| Full Search

[an vl | I I I I |

Trade Name

MAH

Drug Code

ATC Code

ATC Description
Medicinal Product 1D

Ingredients

| seect || cancel

Note: The WHO Drug Browser that appears will depend on the
configuration settings for your account by the administrator.

The browser categories (B or C) are not displayed in the browser
window.

The primary difference between the two browsers is the availability of
the following fields in WHO Drug Browser:

s Product Type: This is the product type.
= Medicinal Prod ID: This is the unique medicinal product id.
= MAH: This is the name of the manufacturer.

= Ingredients: This is the product substance name.

2. Select the Product Type as the drug search criteria. The default value is All.

3. Enter the first few letters of the ATC code, ATC description, Code, or Description
in the respective text box. Check the Ingredient checkbox to search for the drugs
(whose drug ingredients) match the ingredients in the List Maintenance. Click the
SOUNDEX checkbox to search for drugs, where the exact spelling of the drug is
unknown. Example: Enter antiviral in the ATC description field to view the list of
drugs starting with the phonetics closest to anti. This returns a list of drugs closest
to the phonetic representation (the way it sounds) of the word.

4. Select either the Drug Code or Medicinal Prod ID radio button as one of the drug
search criterion. The default selection is Drug Code.

5. Select either the Trade Name or Ingredient radio button as one of the drug search
criterion. The default selection is Trade Name. You can also select multiple trade
names in the same WHO Drug selection dialog. If multiple trade names are to be
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added, the Add & Close button is enabled. Click this button to add the selected
multiple trade names and ingredients into the Drug Detail section.

6. Enter the Formulation and Country details for the drug to be searched.

7. If you want the system to search for the specified string in the entire product
information, check the Full Search checkbox.

8. Click Search. The system searches the database for the specified search string. The
WHO Drug Browser displays the search result in a grid format.

2 | Argus Insight - WHO Drug Browser -- Webpage Dialog

Drug Coding (WHO-DRUG)
Number of Rows: 1000
Product Type ATC Code (%) Drug Code () Medicinal Prod ID (%) Trade Name () Ingredient Formulation Country [] Full Search
7 I— I | [urspecies] [usa |
| Farmulation | Strengtht | sales Country
ATRIPLA Unspecified / Unspecifisd Usa N 1)
ATRIPLA Unzpecified / Unspecified usa N =
Abreva Unzpecified / Unspecified usA N
Abreva Unzpecified / Unspecified usa N
Acetazol Unspecified / Unspecified usa N
Acetazol Unzpecified / Unspecified Usa N
Acidophiluz Unzpecified / Unspecified usa N
Acova Unspecified / Unspecified Usa N
Acova Unzpecified / Unzpecified usa N
Actimmune Unzpecified / Unspecified usA N
Actimmune Unzpecified / Unspecified Usa N
Actimmune Unspecified / Unspecified usa N
Actimmune Unspecified / Unspecifisd Usa N -
Trade Name
MAH
Drug Code
ATC Code
ATC Description
Medicinal Product ID
Ingredients
fadd Select | | Cancel

9. Select the required WHO drug. The selected item is highlighted.
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2 | Argus Insight - WHO Drug Browser -- Webpage Dialog

Drug Coding (WHO-DRUG)

Number of Rows: 1000
ProductType  ATC Code (3 Drug Code () Medicinal Prod ID (3) Trade Name () Ingredient Formulation Country [] Full Search
I I [unspecirea] [usa |
| Farmulation | Strengtht | sales Country | Generic?
ATRIPLA Unspecified / Unspecified Usa N ]
ATRIPLA Unspecified / Unspecified usa N =
Abreva Unspecified / Unspecified UsA N
Abreva Unzpecified / Unzpecified usa N
Acetazol Unspecified / Unspecified usa N
Acetazol Un=pecified / Unspecified Usa N
Acidophiluz Unzpecified / Unspecified usa N
Acova Unspecified / Unspecified Usa N
Acova Un=pecified / Unspecified usa N
Actimmune Unzpecified / Unspecified usA N
Actimmune Unzpecified / Unspecified Usa N
Actimmune Unspecified / Unspecified usa N
Actimmune Unspecified / Unspecified Usa N v
Trade Name Acetazol
MAH Barre drug. co., inc.
Drug Code 013018.01.001
ATC Code SO24A8
ATC Description \Auntiin fectives
Medicinal Product ID 46730
Propylene glycol diacetate
Ingredients
A seiect | | Cancel

10. Click Select. The Product Name, Product WHO Drug Code, Generic Name, ATC
Code and ATC Text fields in the QBE form are populated with the selected WHO
drug code.

Note: All the Ingredients for the WHO Drug browser are
concatenated and displayed in the Generic Name for the WHO Drug

nn

separated by a ",

Using the Study Drug Lookup
Use the following procedure to select a study drug:

1. Click the Select button associated with the Study Drug field. The Study Drug
dialog box appears.
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e | Argus Insight - Study Drugs Look up -- Webpage Dialog

Study Drugs
Study Drug

|| Search |

| Add&cise | | cancel |

2. Enter the first few letters of the study drug name in the Study Drug dialog box.

3. Click Search. The system searches the database for the specified search string. The
Study Drug dialog box displays the search result in a grid format.

e | Argus Insight - Study Drugs Look up -- Webpage Dialog

Study Drugs

Study Drug
| Cure

Cure All [Capsule , 1000 mg]
Cure All [Capsule , 250 mg]
Cure All [Capsule , 500 mg]
Cure All [Granule]

Cure All [Injection]

Cure All [Unknown]

| Add&cise | | cancel |

4. Select the required study drug from the search result list.

5. Click Add & Close. The system populates the Study Drug field with the selected
study drug.
Events Page

The Events page differs from what you might be used to seeing in Argus in that details

of only one event can be specified. You must scroll down the page to view all the
available fields.
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The following table describes the various fields in the Events page. The field values
you specify are used as the query criteria to retrieve matching cases.

Section

Field

Description

Event Information

Event Description as
Reported

Event Diagnosis Flag

Event Description to
be Coded

Event Past History

Event Onset Date
Event Onset from
Last Dose

Event Stop Date
Event Duration

Event Onset Latency

Time to Onset from
First Dose

In this text box, enter the reported event description that the
query should look for in cases.

Select the Yes, No, or Ignore option button, as appropriate, to
indicate whether the query should look for cases where event
diagnosis flag is set.

Tab out from this field to use the MedDRA Browser to specify
an event term as query criteria.

See theUsing the MedDRA Browsersection for details. The
MedDRA event terms for the selected term are displayed in
the Seriousness Criteria section. The query is restricted to the
terms displayed.

Select the Yes, No, Unknown, or Ignore option button, as
appropriate, to indicate whether the query should look for
cases where event past history is specified.

In this date field, enter the event onset date that the query
should look for in cases.

In this text box, enter the event onset duration from last dose
as the query criteria.

In this date field, enter the event stop date that the query
should look for in cases.

In this text box, enter the event duration that the query
should look for in cases.

In this text box, enter the event onset latency duration that
the query should look for in cases.

In this text box, enter the duration from first dose to the event
onset as the query criteria.
OR

Click the associated Calculate button to view theDuration
Calculatoras displayed in the Products Tab Dosage
Information.
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Section

Field

Description

Seriousness Criteria

Time to Onset from
Last Dose

Event Intensity
Event Frequency

Related to Study
Conduct (As
Reported)

Event Treatment
Received

Outcome of Event
Event Receipt Date

Event Reported
Serious

Event Lack of
Efficacy

Event Progression of
Disease

Event Withdrawal
Reaction

Seriousness Criteria
checkboxes

Event Term fields

In this text box, enter the duration from last dose to the event
onset as the query criteria.

OR

Click the associated Calculate button to view theDuration
Calculatoras displayed in the Products Tab Dosage
Information.

Select the event intensity option that the query should look
for in cases.

Select the event frequency option that the query should look
for in cases.

Use this list box to select the Yes, No, Unknown, or N/A
option, as appropriate, to indicate whether the query should
look for cases where the event is related to a study.

Select the Yes, No, Unknown, or Ignore option button, as
appropriate, to indicate whether the query should look for
cases where patient received treatment for the event.

Select the event outcome that the query should look for in
cases.

In this date field, enter the event receipt date that the query
should look for in cases.

Select the Yes, No, or Ignore option button, as appropriate, to
indicate whether the query should look for cases where case
seriousness status is specified.

Check this checkbox to retrieve cases where Event Lack of
Efficacy is selected.

Check this checkbox to retrieve cases where Event
Progression of Disease is selected.

Check this checkbox to retrieve cases where Event
Withdrawal Reaction is selected.

Check one or more associated checkboxes to specify the
seriousness criteria that the query should look for in cases.

Click the associated Encode button to use the MedDRA
Browser to specify event terms as query criteria.

See theUsing the MedDRA Browsersection for details.

Analysis Page
The Analysis page has two views: Case Analysis and AFSSaPS. Analysis information
about Regulatory Information (notification log), MedWatch Information, BIArM
Information, and EU devices is not available. For more sophisticated queries, use
Filters or Advanced Conditions.
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The following table describes all the fields in the Case Analysis view. The field values
you specify are used as the query criteria to retrieve matching cases.

Section Field Description
Narrative Narrative In this text box, enter the case narrative that the query should
look for in cases.
Case Comment In this text box, enter the case comment that the query should
look for in cases.
Local Evaluator In this text box, enter the local evaluator' comment that the
Comment query should look for in cases.
Abbreviated In this text box, enter the abbreviated case narrative that the
Narrative query should look for in cases.

Company Comment In this text box, enter the company's comment that the query
should look for in cases.

Evaluation in Light In this text box, enter the evaluation comment that takes in to
of Similar Events consideration similar events that have occurred in the past. The
query will look for the specified text in cases.
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Section Field

Description

Other Information Case Seriousness

Case Seriousness
Notes

Company Agent
Causality
Company Agent
Causality Notes

Case Listedness

Case Assessment
Listedness Notes

Case Outcome

Company
Diagnosis/Syndrome

Company
Diagnosis/Syndrome
Notes

Select the Yes, No, or Ignore option button, as appropriate, to
indicate whether the query should look for cases where case
seriousness status is specified.

In this text box, enter the case seriousness notes that the query
should look for in cases.

Select the Yes, No, Unknown, or Ignore option button, as
appropriate, to indicate whether the query should look for
cases where the company agent causality status is specified.

In this text box, enter the company agent causality notes that
the query should look for in cases.

Select the case listedness status that the query should look for
in cases.

In this text box, enter the case assessment listedness notes that
the query should look for in cases.

Select the case outcome that the query should look for in cases.

Click the associated Encode button to use the MedDRA Browser

to specify the company diagnosis as query criteria. See
theUsing the MedDRA Browsersection for details.

In this text box, enter the company diagnosis notes that the
query should look for in cases.

The following table describes all the fields in the AFSSaPS page. The field values you
specify are used as the query criteria to retrieve matching cases.
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Case Event Preferred Term Click the associated Select button to use the MedDRA
Imputability Details Browser to specify the Event Preferred Term as query
criteria.

See theUsing the MedDRA Browsersection for details.

Agent Select the suspect product that the query should look for in
cases.
Chronology Select the imputability chronology code that the query

should look for in cases.

Semiology Select the imputability semiology code that the query
should look for in cases.

Bibliography Select the imputability bibliography code that the query
should look for in cases.

Imputability ?elgct the imputability score that the query should look
or in cases.

Activities Page

The Activities page differs from what you might be used to seeing in Argus in the
following ways:
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= You can specify information only about one contact log
= You can specify information only about one action item
= Routing search is not applicable

The following table describes all the fields in the Activities page. The field values you
specify are used as the query criteria to retrieve matching cases.

Section Field Description
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Contact Log

Action Items

Case Lock/Archive

Contact Log Date In this date field, enter the contact log date that the query
should look for in cases.

Contact Log Code Select the contact log code that the query should look for in
cases.

Contact Log Group  Select the contact log group that the query should look for in
cases.

Contact Log In this text area, enter the contact log description that the

Description query should look for in cases.

Contact Log Select the user responsible for the contact log. The query will

Responsibility look for the user name you select.

Contact Log Date In this date field, enter the sent date for the contact.

Sent

Date Open In this date field, enter the action item opening date that the
query should look for in cases.

Action Type Select the action type that the query should look for in cases.

Group Select the responsible group that the query should look for in
cases.

Due Date In this date field, enter the action item due date that the query
should look for in cases.

Description In this text area, enter the action item description that the
query should look for in cases.

User Select the user responsible for the action item. The query will
look for the specified user name.

Completed In this date field, enter the action item completion date that
the query should look for in cases.

Locking Date In this date field, enter the case lock date that the query
should look for in cases.

Archive Date In this date field, enter the case archive date that the query
should look for in cases.

Closed By Select the user that closed the case.

Additional Info Page
This Additional Information page differs from what you might be used to seeing in
Argus in the following ways:
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= You can specify information only about one note
= No attachments are permitted
= You can specify information only about one reference

The following table describes all the fields in the Additional Information page. The
field values you specify are used as the query criteria to retrieve matching cases.

Section Field Description
References Reference ID # In this text box, enter the referenced case ID that the query
should look for in the cases.
Reference Type Select the reference type that the query should look for in
cases.
Reference Notes In this text area, enter the reference notes that the query

should look for in cases.

Working with the Last Modified or Executed QBE

This topic explains how to view the QBE you last modified or executed.

The system assigns the Active status to a QBE when you save modifications to it or
execute it. Unless you save the modifications to another QBE or execute another QBE,
the last QBE you modified or executed remains Active. This is helpful in situations
when you want to access a frequently used QBE.

Use the following procedure to view an Active QBE.
1. Select Create Query > Query by Example > Active.

2. The Active Query by Example page displays the QBE form for the last QBE you
executed.
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If the Active QBE was saved to the system before executing, the name of the QBE
appears next to the Active Query Name and Name label. However, if the Active QBE
was not saved to the system before executing, the text <Not Saved> is displayed next
to the Active Query Name label.

From the Active Query by Example page, you can perform the following tasks:

Task

Description

Modify the values in  If required, you can modify the field values in the QBE form. See theCreating a New

the QBE form

QBEtopic for information on entering values in the QBE form.

While entering values in a tab, if you wish to clear all the values you entered, click the
Clear Tab button. If you wish to all values you entered in all the tabs, click the Clear
All button.

Use the Save button to save the changed field values. This button is only available for
a saved Active QBE.

Save Active QBE Click Save As to save the Active QBE with a different name.

with another name

Convert QBE to

The QBEs that you save to the system are listed in the Query By Example - Library
page. TheWorking with Saved QBEstopic explains how to work with saved QBEs.

Click Convert to Advanced Condition to convert the QBE to an Advanced Condition.

Advanced Condition TheUsing QBEs with Advanced Conditionstopic explains how to do this.

Assign Permissions  Click Permissions to set the group-level access permissions on the QBE. See

theCreating a New QBEtopic for information on setting permissions.

The Permissions button is only available for saved Active QBEs.

Change the You can change the description of the Active QBE by modifying the text displayed in
Description of the the Description text box.
Active QBE

Click Save to store the changed description.

Execute the Active Click Execute to generate a Case Series by using the Active QBE.

QBE

Modifying the field values in the QBE form for an Active QBE or saving the Active
QBE with a different name changes the Active QBE to reflect the most recent changes.
The Active QBE also changes in case you modify the field values in the QBE form and
execute the QBE without saving the QBE form modifications.
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Working with Saved QBEs

The Query By Example - Library page lists all of the QBEs saved to the system. Use
the following procedure to access this page.

1. Select Create Query > Query by Example > Library. The system opens the Query
By Example Library page.
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The Query By Example - Library page displays a list of the saved QBEs in a grid
format. The descriptions of the grid columns follow.

Column

Name
Description
Last Modified
User Full Name
Category
Report Name

Description

Displays the name of the QBE you specified while saving
Displays the QBE description you entered while saving
Displays the date when the QBE was last modified

Displays the name of the user who created the QBE

Displays the category you assigned to the QBE while saving it

The icon indicates that a report is associated with the QBE

See theAssociating a QBE with a Reportsection below for more information

Searching for a Saved QBE
Use the following procedure to search for a saved QBE:

1. Specify the search criteria, as appropriate:
= To search for a QBE by its name, type the QBE name in the Name text box.

»  To search for a QBE by its description, type the first few words of the
description in the Description text box. The system searches for the specified
search string in all QBE descriptions.

» To search for a QBE by its date of modification, enter the modification date in
the first Last Modified date field. You can also specify a date range by typing
the start and end dates in the first and second date fields, respectively.

» To search for a QBE by its author, select the author name from the User Full
Name list box.
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s Tosearch for a QBE by its category, select the category from the Category list
box.

2. Click Search. Based on your search criteria, the system displays the search result in
a list.

3. You can sort the search result list by clicking the sort icon next to the column
headers in the list.

4. To clear the search result and display all the saved QBEs in the list, click the Clear
button.

Creating a New QBE
Instead of selecting Create Query > Query By Example > New, you can directly open
a new QBE form by clicking New in the Query By Example - Library page.

Modifying a Saved QBE
Use the following procedure to modify a saved QBE:
1. Select a QBE from the list of QBEs in the Query By Example - Library page.

2. Click Modify. The Query by Example page displays the QBE form for the selected
QBE. You can modify the field values in the QBE form and save the changes by
clicking Save. You can also save the selected query by another name by clicking
Save As in the QBE form.

Deleting a Saved QBE

Use the following procedure to delete a saved QBE.

1. Select a QBE from the list of QBEs in the Query By Example - Library page.
2. Click Delete. The Delete QBE dialog box appears.

be | Argus Insight - Delete QBE -- Webpage Dialog @

Delete QBE

Are you sure you want to delete
‘New QBE.It will remove the Report association
also'?

: Cancel

3. Click OK to delete the QBE. The system deletes the selected QBE; the Query By
Example - Library page appears.

Associating a QBE with a Report

Argus Insight lets you associate a QBE to a particular Standard Report and schedule a
time when the report needs to be generated and sent to another user through email.
This is helpful in situations when you need to generate the latest Case Series and run a
report on it each time the datamart is refreshed. Instead of manually executing the
QBE to generate the latest Case Series and running the report, you can use the report
association functionality of Argus Insight.
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Note: The user who is scheduling reports should have an enterprise
login configured in Cognos to schedule the report.

It is not possible to associate multiple reports with a query by a user. If
user associates multiple reports against the same query, the

scheduling information is overwritten by the latest schedule
mentioned by the user.

Use the following procedure to associate a QBE with a Standard Report:

1.

In the Query By Example - Library page, select the QBE that you wish to associate
with a Standard Report.
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Associate the QBE with a Standard Report.

Click Associate. The Scheduled Report Groups window appears. This window
displays the information of all the report groups that have been scheduled by the
logged-in user.

a Argus Insight -- Webpage Dialog

Scheduled Reports Group

Total Number Of Rows (1)

Displaying Rows Page size s
Name .. Last Run Time Created By Modified By
Description HNext Run Time Created Date Modified Date LI
New Reports NIA johns johns 1
Collection of New Reports MIA 10-JUL-2010 10-JUL-2010

Mew  |[ Modify || Delste [[ Execite || Close
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4. Click New. It enables you to either do Report Association Only or to perform
Report Scheduling.

% Argus Insight -- Webpage Dialog

Scheduled Reports Group

Total Number OF Rows (1) Displaying Rows Page Size ==
Name Last Run Time Created By Modified By
Description Next Run Time Created Date Modified Date
New Reports NIA johns. johns.

Collection of New Reports: NI& 10-JUL-2010 10-JUL-2010

{osity—_] | Deiete || Exseute | | ciose ]

5. Schedule the report.
6. Click the Scheduling tab. The Reports Scheduling page appears.
e | Argus Insight -- Webpage Dialog,

Reports Scheduling

Group Information Schedul Information E-Mail Information

Name: || ‘ Frequency: | V‘ Email | |
Address:
Description: | ‘
Subject: [ |
Body:
[[] send separate mail for each report
Available Reports (=]
Report Name Description Category Last Modified Author
Adverse Events Line Listing Report providing selected data from study cases Case Processing | 06-JUL-2010 QOracle Corporation %
" A summary tabulation that displays a count of even "
AE Count Tabulation ts and breaks them down by causaity. Pharmacovigiance 07-JUL-2010 Qracle Corporation
Age Group vs. Gender ';Bt::aryze relationships between two or mare afiri Pharmacovigiance | 10-JUL-2010 Qracle Corporation
N P To summarize the event counts by Diagnosis and b "
Aggregate Diagnosis Listing roken down by seriousness and lisledness. Pharmacovigiance 10-JUL-2010 Oracle Corporation
Case Activity History Graph to show the count of incoming and ol ¢ Management 07-JuL-2010 Qracle Corporation
azes and an aggregate total of cazes in process.
Case Count by Reporter Type Report to track the origin of all notifications. General 05-JUL-2010 Qracle Corporation
~
Selected Roporis o]
Report Report Pre-Filters.
fit Category Format Configured?
Mo records to display |
[.ook ][ cencel [ Clear

7. Enter the Name and Decription of the report.

8. Use the Frequency list box to specify how often you wish to have the system run
the selected QBE and generate the selected report. The options available are: Once,

Daily, Weekly, Monthly, Quarterly, and Yearly.
9. Specify the start time in the Time field.

10. Based on the option you selected in the step above, specify the instant when you

want the report generated as described in the table below.

Creating Queries 4-42



Creating Queries

Frequency Option
Selected

Additional Scheduling Information to Specify

Once

Daily

Weekly

Monthly

Quarterly

Yearly

In the Date text box that appears, enter the date when you want to have the
report generated.

In the Time text box that appears, enter the time when you want to have the
report generated. The time must be entered in the HH:MM AM/PM format.
Hours should be between 1 and 12.

From the Day of Week option button group that appears, select the day of week
on which you want to have the report generated. Also, specify the time in the
Time text box.

Use the Day list box to select the day of the month on which you want to have
the report generated. Also, specify the time in the Time text box.

Quarterly reports are generated on the first day of the quarter. In the Time text
box, enter the time when you want to have the report generated on the first day
of the quarter.

In the Date and Time text boxes, specify the date and time when you want to
have the yearly report generated.

11.

12.
13.

14.
15.
16.

17.

In the Start Date and End Date fields, enter the start and end dates for this
activity, respectively.

Specify the email recipients of the report you scheduled.

In the Email Address text box, type the email address of the report recipient. If
there are multiple recipients, use a semicolon to separate their email addresses.

Type the subject line in the Subject text box.
Type the email body text in the Body text box.

Select the report(s) from under Available Reports and click Add. The selected
reports are displayed under Selected Reports.

Click the selected report(s) under Selected Reports. The prompts are loaded in the
right pane.
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: | Argus Insight - Webpage Dialog,
Reports Scheduling

‘Group Information Scheduling Information E-Mail Information

Name: [Additional Reports | Frequency: [Weeky v| Email

Add [iohn com |
ress:
Description: [Contains added reports | Dayof [ionday
Week: Subject: [Newly Added Reports ]
Time: [11:00 an | Body: 4 collection of newly added reports.

Start Date: [10-JUL-2010 |

End Date:  [08-NOV-2010 |

[[] send separate mail for each report

Available: Reports =]

Report Hame . Description Category Last Modified Author
Adverse Events Line Listing Report providing selected data from study cases Case Processing  06-JUL-2010 Oracle Corporation %
AE Count Tabulation A summary tabulation that displays a count of even

s and breaks them down by causalty Pharmacovigilance 07-JUL-2010 QOracle Corporation

To analyze refationships between two or more attri

Age Group vs. Gender butes,

Pharmacovigilance 10-JUL-2010 Oracle Corporation

To summarize the event counts by Diagnosis and b

Aggregate Disgnosis Listing roken down by seriousness and listedness.

Pharmacovigilance 10-JUL-2010 Oracle Corporation

Graph to show the count of incoming and closed ©

Case Activity History and an aggregate total of n pro ) Management 07-JuL-2010 Oracle Corporation
Case Count by Reporter Type Report to track the origin of all notifications. General 06-JuL-2010 Oracle Corporation
v
Selocted Reports T
Report Report Pre-Filters Report Pre-Filters

ReciR e Category Format GrrrmeE 2R
Adverse Events Line Listing Case Processing || PDF % | ves E Sub Title
Case Activity History Management PDF | to | |

Grouping

[pay v

[0k | [otancel | [ Clear |

18. Enter the sub title for the report pre-filter and click OK.

19. Click OK in the Reports Scheduling window. In case of Association only, the
scheduling steps are not required.

20. Click OK. The system associates the QBE with the selected report and saves the
scheduling information; Query By Example - Library page appears. The icon
displayed in the Report column indicates that the QBE is associated with a report.
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Note: Refer to the Associated Library and Query Library sections in
the Library chapter, to view the steps on how to disassociate reports in
those libraries

Executing a Saved QBE
Use the following procedure to execute a saved QBE.

1. Select a QBE from the list of QBEs in the Query By Example - Library page.
2. Click Execute. The system executes the QBE; the Active Case Series page appears.
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3. If areportis associated with the saved QBE, click on Execute button. The Active
Case Series page and Pre Filter page of the associated report is displayed.

4. Enter the prompts value in the Pre Filter page.
5. Click on the Execute button to generate the report.

6. After generating the Case Series, you can manually modify it or save it. See
theCase Serieschapter for more information on working with Case Series.

Note: You can also export the Case Series results into an excel file.
For details see Exporting Case Series to Excel.

Executing a Saved QBE on the Active Case Series
Just as the system assigns the Active status to a QBE when you save modifications to it
or execute it, the last saved or generated Case Series becomes the Active Case Series.

Use the following procedure to narrow down the list of cases in the Active Case Series.
You may want to run an existing QBE on an Active Case Series instead of creating and
running a new QBE on the entire datamart and generating a new Case Series.

1. Generate the Case Series on which you wish to run another QBE:

»  If the Case Series on which you wish to run another QBE is not yet generated
/ active, you can either create aNew QBEand execute it or execute a saved
QBE as explained in the previous section. This Case Series automatically
becomes the Active Case Series and remains so until you execute another
query to generate a different Case Series.
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= Alternatively, if the Case Series on which you wish to run another QBE is
already saved in the system, select Query Results > Case Series > Library. In
the Case Series Library page that appears, select the Case Series title and click
Make Active.

2. Select Create Query > Query by Example > Library. The Query By Example -
Library page appears.

3. Select the query you want to run on the Active Case Series you generated in step 1.
4. Check the Limit Query to Active Case Series checkbox.

5. Click Execute. The system runs the selected QBE on the Active Case Series and
displays the Active Case Series page. Note that the Case Series you just generated
becomes the Active Case Series.

Using QBEs with Advanced Conditions

Advanced Conditions let you create complex queries that involve Boolean and Set
operations among various fields. In Argus Insight, Advanced Conditions are created
in the Advanced Conditions editor, which employs a spreadsheet-like approach for
adding query conditions (fields and their values) and conditional operators (Boolean or
Set).

In Argus Insight, QBE is integrated with Advanced Conditions to let you perform the
following tasks.

s Converting a QBE to an Advanced Condition

= Integrating a QBE with an Advanced Condition

Converting a QBE to an Advanced Condition

A QBE can be used to start an Advanced Condition that employs Set or Boolean
operations between QBE form fields that have specific values. When you convert a
QBE to an Advanced Condition, all the QBE form fields in which you entered values
are listed in the Active Advanced Conditions Editor page as Advanced Condition
attributes.

Use the following procedure to convert a QBE to Advanced Condition.

1. Open a QBE form by either starting a new QBE, opening the Active QBE, or
opening a saved QBE.

2. \Verify the field values you specified in the various tab pages in the QBE form.

3. Click the Convert to Advanced Condition button. The Active Advanced
Condition Editor page appears; all the fields in which you specified values in the
QBE form are listed as Advanced Condition attributes.
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In the Advanced Condition editor, you can build your query further by:

Adding additional attributes (fields) and specifying their values
Adding another Advanced Condition as an attribute

Placing runtime parameters in attributes

Placing parentheses to determine the query execution order
Specifying conditions for attributes values

Specifying Set and Boolean operators to join the various attributes

See the Advanced Conditionschapter for detailed information on building Advanced
Conditions by using the options in the Advanced Condition editor.

Integrating a QBE with an Advanced Condition

Argus Insight lets you integrate a new, active, or saved QBE with an existing
Advanced Condition through these Set operators: Intersect, Minus, or Union. If
required, you can integrate your QBE with multiple Advanced Conditions. The
multiple Advanced Conditions can have Set or Boolean operations between them.

Use the following procedure to integrate a QBE with existing Advanced Conditions:

1.

Open a QBE form bystarting a new QBE, opening the Active QBE, or opening a
saved QBE.

Verify the field values you specified in the various tab pages in the QBE form.

Click the Advanced Conditions tab in the QBE form. The Advanced Condition
tab page displays the Advanced Condition editor.
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4. Use the Operator list box to specify the Set operator you want to use to integrate
the QBE and the Advanced Condition. You can select one of these options:
Intersect, Minus, Union.

5. Select the Advance Condition you want to integrate with the QBE.

6. Click the icon on the left bar. A context menu appears. In the context menu, all the
Advanced Conditions which are stored in the system and are accessible to the user
are organized by categories.

General I Patient | Products I Events | Analysis I Activities | Additional Info W
o
( Attributes | Condition ‘ Value

55 [ AC LIBRARY ¥ [ General

AC3

(9] Ac_s333380

CASE_2002_AC

[#] Druge in Study  Includes Comparators )
Study Drug exists

BB & |if

7. In the context menu, browse to the appropriate category and select the required
Advanced Condition. The selected Advanced Condition appears as a row in the
Advanced Condition editor.
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10.

11.

12.

If required, add other Advanced Conditions. Click the icons on the left bar to
insert another Advanced Condition above or below the existing Advanced
Condition.

Tip: You can change the structure of thequery by changing order of

rows in the editor. Use the following procedure to To do this, select a
row and click the Up or Down buttons to move the row upwards or

downwards.

Type parentheses in the (and ) columns to determine the order of execution for the
selected Advanced Conditions.

Use the list box in the Operator column to specify the operators between the
selected Advanced Conditions. You can select from these options: AND, OR,
Intersect, Minus, and Union.

Note: See the Advanced Conditions chapter for detailed information
on creating Advanced Conditions by using the options in the
Advanced Condition editor.

Save the integrated query by clicking Save As.

Note: You can convert the integrated QBE and Advanced Condition
into a single Advanced Condition by clicking Convert to Advanced
Condition. See Converting a QBE to an Advanced Condition for
details.

Click Execute to run the integrated QBE and generate the Case Series. The Active
Case Series page appears; the Case Series is displayed. See the Case Series chapter
for more information on working with Case Series.
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Filters

WhileQBElets you create queries by specifying unique field values in the various tab
pages of the QBE form, Filters let you create queries by specifying multiple or a range
of values (in numeric or date fields) for each field in a set of fields displayed on a
single page. Therefore, you may choose Filters in situations when your querying
criteria is based on multiple values or a range of values in fields.

Argus Insight provides five predefined Filters. Each predefined Filter comprises of a
set of specific datamart fields called filter elements. The following table lists the five
predefined Filters and the elements associated with them.

Note:

configured in Argus.

The Filters field labels are displayed as per the field labels

Predefined Filter
Name

Associated Elements (Fields)

Compliance

Configuration

Management

Case Followup
Receipt Date

Country of Incidence

Owned by Site

Related to Study
Conduct? (As
Reported)

Report Submission
Date

Country of Incidence

Advanced
Conditions

Case Delayed/Open

Case Report Type
Country of Incidence
Product

Advanced
Conditions

Case Initial Receipt
Date

Event Listedness/Lic
Country

Product

Report Agency

Reporting Group

Product

Case Followup
Receipt Date

Case Seriousness
Has Followup
Reports Pending

Case Report Type
Family Name

Project/ Study /Center

Report Form

Advanced
Conditions

Project/Study/Cente
r

Case Initial Receipt
Date

Case Status
Owned by Site
Workflow Group
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Predefined Filter

Name Associated Elements (Fields)
Pharmacovigilance ATC Code BMI Case Abbreviated
Narrative
Case Comment Case Followup Case Initial Receipt
Receipt Date Date
Case Narrative Case Outcome Case Seriousness
Company Comment Country of Incidence Dosage Regimen
route of
Administration
Dose Drug Duration of Evaluation in Light
Administration of Similar Events
Event Diagnosis Flag Event Seriousness Event Term
Local Evaluator Onset Latency Outcome of Event
Comment (minutes)
Patient Age (In Years) Patient Age Group Patient Ethnicity
Patient Patient Relevant Tests Product
Gender/Pregnancy
Product Type Project/Study/Cente Rechallenge/Dechallen
r ge
Relevant History Reporter Type/HCP  Study Blinding Status
Condition
Time to Onset from Time to Onset from Advanced Condition
First Dose Last Dose
Workflow Case Delayed/Open  Case Followup Case Initial Receipt
Receipt Date Date
Case Report Type Case Seriousness Case Status
Event Listedness/Lic Event Term Family Name
Country
Has Followup Owned by Site Product
Project/Study Workflow Group Advanced
Conditions

Argus Insight also lets you define custom Filters by letting you select a set of elements
(datamart fields) and saving the selection as your own Filter.

To create a filter using queries, select a predefined or custom Filter and specify values
(multiple or range) in the desired filter elements associated with the Filter. You can
then execute this query (Value Set)to generate a Case Series.

The set of values you specify in the elements associated with a Filter is called a Value
Set. For example, a particular Filter may have this Value Set:

Filter Element Values Specified

Country of Incidence United States and Germany

Product Name

Coded Event
Description

CureAll Injection and CureAll Capsule

Injection site rash and Aggravated Nausea
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Filter Element

Values Specified

Seriousness Criteria ~ Hospitalized and Intervention Required

Patient Age

25 to 65 years Note that ranges can only be
specified for fields that have numeric values

Argus Insight lets you save Value Sets. Therefore, each Filter can have multiple Value
Sets. The advantage of saving Value Sets is that this enables you to execute a Value Set
later without having to select a Filter and then entering values in the associated
elements.

The topics that follow explain how to work with Filters.

= Using Predefined Filters

»  Creating Custom Filters

= Working with the Last Modified or Executed Value Set
= Working with Saved Filters and Value Sets

= Using Filters with Advanced Conditions

Using Predefined Filters
This topic explains how to:

= Select a predefined Filter

»  Create a Value Set for the predefined Filter by entering values in the associated
elements

= Generate a Case Series by executing the Value Set
Selecting a Predefined Filter
Use the following procedure to select a predefined filter.

1. Select Create Query > Filters > New Value Set. The Select Filter for New Value Set
dialog box appears.

e | Argus Insight - New Value Set -- Wehpage Dialog

Select Filter For New Value Set

Compliance Advanced Conditions, Country, Event Listedness/Lic Country, Family Name,
Follow-up Received, Initial Receipt Date, Owned by Site, Product,
Project/Study/Center, Related to Study Conduct?(A=s Reported), Report
Agency, Report Form, Report Submizzion Date, Report Type, Reporting
Group

Configuration Advanced Conditions, Country, Product, Project/Study/Center

Management Advanced Conditions, Caze Delayed/Open, Case Serious, Case Status,
Country, Follow-up Received, Haz Followup, Initial Receipt Date, Owned by
Site, Product, Report Type, Reports Pending, Workflow Group

Pharmacovigilance Abbreviated Narrative, Advanced Conditions, Age, Age Group, BMI, Blinding
Status, Case Comment, Case Outcome, Case Serious, Co-Drug Code w
Study, Coded PT, Company Comment, Country, Data Sheet, Diagnosis, Dose,
Drug Type, Duration of Adminiztration, Ethnicity, Evaluation in light of =imilar
events in the past, Event Onset Latency, Event Sericusness, Event Term,
Follow-up Received, Initial Receipt Date, Local Evaluator Comment, Medicinal
Prod ID, Narrative, Qutcome of Event, Patient Gender/Pregnancy, Patient
Relevant Tests, Patient Route of Administration, Preferred Term, Product,
Project/Study/Center, Rechallenge/Dechallenge, Reporter Type/HCP, Time to
Onszet from First Dose, Time to Onset from Last Dose, WHO DRUG ATC
CODE

Workflow Advanced Conditions, Caze Delayed/Open, Case Serious, Case Status,
Ewvent ListednessiLic Country, Event Term, Famity Name, Follow-up —
Received, Has Followup, Initial Receipt Date, Owned by Site, Product,
Project/Study/Center, Report Type, Workflow Group

I

Cancel
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Note: The Select Filter for New Value Set dialog box displays a list
of all the predefined as well ascustom Filters and their associated
elements. You need to scroll down the dialog box to view all the
Filters.

2. Select a predefined Filter (Compliance, Configuration, Management,
Pharmacovigilance, and Workflow) depending on your reporting needs. For
example, select Compliance. If there are any custom Filters saved to the system,
you can select one of those as well

3. Click OK. The Filter Value Set page appears.
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Note: In the Filter Value Set page, all the elements associated with
the Filter are organized in sections. You need to scroll down the page
to view all the sections. All the predefined Value Sets contain the
Advanced Condition section. You can use the options in this section
to select an existing Advanced Condition and integrate your Value Set
with it. See thelntegrating a Value Set with an Advanced Condition
topic for details. You can also convert the entire Value Set to an
Advance Condition. The Converting a Value Set to an Advanced
Condition topic explains how to do this.

Create a Value Set
Use the following procedure to create a value set.

1. Specify values for the Filter elements in the various sections. Depending on the
Filter you selected, the Filter Value Set page may contain these sections:

Sections in the New

Value Set Page Associated Elements (Fields)
Case Information Case Followup Case Initial Receipt ~ Case Report Type
Receipt Date Date
Country of Incidence Event Listedness/Lic Family Name
Country
Owned by Site Product Project/ Study
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Sections in the New
Value Set Page Associated Elements (Fields)

Patient Information ~ Patient Age Group Patient Age (In Years) BMI

Patient Patient Ethnicity
Gender/Pregnancy
Product Information =~ Regimen Daily Dose = Total Regimen Product
Dosage
Drug Primary Rechallenge/Dechallen  Total Drug Dosage
Indication Code ge
ATC Code
Event Information Event Seriousness Event Term Onset Latency

(minutes)

Outcome of Event Event Listedness/Lic Related to Study

Country Conduct? (As
Reported)
Workflow Workflow Group Has Followup Case Status
Information
Case Delayed/Open
Miscellaneous Lab Test/Assessment Lab Results
Information
Report Information ~ Reports Pending Report Agency Report Submission
Date
Reporting Group Report Form

Note: The MedDRA browser can be accessed from the Create Query
> Filters New Value Set > Pharmacovigilance | Workflow categories.
The MedDRA browser for Pharmacovigilance | Workflow filter
categories supports the following options specific to Filters: All
hierarchy radio-button Use this option to enable a query search based
on all/selected hierarchical terms in MedDRA. The search output
captured depends on the check-boxes selected in the MedDRA
browser window. Term only radio-button Use this option to select
multiple terms within a specific AE term. Click on the term(s) you
want to include in your search criteria. These terms are highlighted in
yellow. The output based on the term(s) selected in the MedDRA
browser, is populated in the relevant section of the Filter.

2. Examine the Value Set result.
3. Click Execute.

4. While the system searches for matching cases, the following dialog box is
displayed.
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2 Argus Insight - Case Series Building -- Webpage Dialog  [X]

Building Case Series.
Please wait...

Tip: You may cancel the query execution at this point and return to
the Filter Value Set page by clicking Cancel Query in the dialog box
above.

If the system finds cases that match the query criteria, a list of such cases is
displayed in the Active Case Series page.
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5. Examine the Case Series. If the Case Series is too large, you may want to modify
the Value Set to narrow down the Case Series. Alternatively, if you find the Case
Series to be appropriate, you can save the Value Set to the system.

6. To return to the Filter Value Set page, click View Query in the Active Case Series
page. The Filter Value Set page appears.
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Note: When you save the modifications to a Value Set or execute a
Value Set, the system assigns the Active status to the Value Set.
Therefore, when you return to the Value Set page, the Active Query
Name label displays the name of the Filter.

7. If required, modify the Value Set and examine the result again or proceed to save
the Value Set.

8. Save the Value Set to the system.

9. Type a description of the Value Set in the Description text box. For example, you
can describe the type of cases the Value Set retrieves.

10. Click Save Values. The Save Value Set dialog box appears.

e | Argus Insight - Save Value Set -- Webpage Dialog |X|

Save Value Set

% For Filter - Pharmacovigilance Hame:

[ ok ]| cancel |

11. Type the name of the Value Set in the Name text box.

12. Click OK. The system refreshes the Filter Value Set page. Note that the following
new elements appear on the page.

=  The Name label displays the name of the Value Set page you specified

= Two new buttons appear at the bottom of the page: Save Values As and
Permissions.

Note: All the Value Sets you save to the system are listed in the Filter
Library page. The topicWorking with Saved Filters and Value Sets
explains how to work with saved Value Sets.

Creating Queries 4-56



Creating Queries

Tip: If you make modifications to thefield values after you have
saved the Values Set to the system, use the Save Values button to save
the changed field values. To save the Value Set by another name, use
the Save Values As button. To clear all the field values in the Filter
Value Set page, click Clear.

13. Assign group-level permissions on the saved Value Set.

14. Click the Permissions button. The Permissions dialog box appears. A list in this
dialog box displays the names of all the groups (except the Administrator group)
that the system administrator has created.

Permiszions for OBE: New QBE
Legend
UnBlinded W = Write

D = Delete

P = Object
Permizsion

No Access

[ ok || cancel |

15. Use the list box next to a group name to assign permissions to the group members
on the Value Set you have created. You can select from these options:

Permission Description

No Access (Default)  No group members will be able to access the Value Set

R Group members will only be able to view the Value Set

R/W Group members will be able to view and modify the Value Set
R/W/D Group members will be able to view, modify, and delete the Value Set
R/W/D/P Group members will be able to view, modify, delete, and assign

permission on the Value Set

Note: The author of the Value Set always has the highest level of
permission (R/W/D/P) on it. For example, you belong to the Data
Entry group and you assign the No Access permission level to the
Data Entry group on a Value Set that you create. In this case, while
you will continue to have the highest level of permission on your
Value Set, other members in your group will not be able to access your
Value Set.
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16. Click OK. The system saves the permission settings.
Executing a Value Set

Use the following procedure to execute a Value Set.

1. Click Execute.

2. The system retrieves the list of cases that match the Value Set criteria and displays
it in the Active Case Series page.
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3. After generating the Case Series, you can manually modify it or save it. See the
Case Serieschapter for more information on working with Case Series.

Creating Custom Filters
This topic explains how to:

»  Create a custom Filter

»  Create a Value Set for the custom Filter

= Generate a Case Series by executing the custom Value Set
Creating a Custom Filter

Use the following procedure to create a custom filter.

1. Select Create Query > Filters > Library. The Filter Library page appears. This
page lists the predefined as well as custom Filters and their values sets in a control
tree format.
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2. Click the New Filter button. The Filter Elements page appears.
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3. From the Available Elements list, select an element you want to associate with the
custom Filter.

4. Click the > button to associate the selected element with the custom Filter. The
selected element appears in the Selected Elements list.
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Tip: To add all the elements in Available Elements list to the
Selected Elements list, click the >> button.

To remove an element from the Selected Elements list, click the >
button.

To remove all the elements from the Selected Elements list, click >>
the button.
5. Save the Filter.

6. Use the Category list box to assign a category to the custom Filter. A category
indicates the reporting aspect to which your Filter pertains: Compliance,
Configuration, General, Management, or Pharmacovigilance. Specifying the
category also helps you in searching the relevant Filters from a list of all the Filters
saved in the system.

7. Type a description of the custom Filter in the Description text box.

8. Click Save. The Save Filter dialog box appears.

e | Argus Insight - Save Filter -- Webpage Dialog,

Save Filter

Name:

[ ok ]| cancel |

9. Enter the custom Filter name in the Name text box.

10. Click OK. The system saves the custom Filter; the Filter Elements page refreshes.
Note that the following new elements appear on the page.

11. The Name label displays the name of the saved filter.

12. The Active Query Name label in the upper-right corner of the page now displays
the name of the Filter you specified.

13. Two new buttons appear at the bottom of the page: Save As and Permissions.
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Note: If you make modifications to the Filter elements after you have
saved the Filter to the system, use the Save button to save the changes.
To save the Filter by another name, use the Save As button.

14. Assign group-level permissions on the Filter.

15. Click the Permissions button. The Permissions dialog box appears. A list in this
dialog box displays the names of all the groups (except the Administrator group)

that the system administrator has created.

Permiszions for OBE: New QBE

Legend
R =Read

W ="Write
D = Delete

P = Object
Permizsion

No Access

[ ok

|| Cancel |

16. Use the list box next to a group name to assign permissions to the group members

on the Filter you created. You can select from these options:

Permission Description

No Access (Default)  No group members will be able to access the Filter

R Group members will be able to only view the Filter

R/W Group members will be able to view and modify the Filter

R/W/D Group members will be able to view, modify, and delete the Filter
R/W/D/P Group members will be able to view, modify, delete, and assign permission

on the Filter

Note: The author of the Filter always has the highest level of
permission (R/W/D/P) on the Filter. For example, you belong to the
Data Entry group and you assign the No Access permission level to
the Data Entry group on a Filter that you create. In this case, while
you will continue to have the highest level of permission on your
Filter, other members in your group will not be able to access the

Filter.

17. Click OK. The system saves the permission settings.
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Creating a Value Set for a Custom Filter
Use the following procedure to create a value set for a custom filter.

1. Click Continue in the Filter Elements page. The Filter Value Set page appears.
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Note: In the Filter Value Set page, all the elements associated with
the Filter are organized in sections. You need to scroll down the page
to view all the sections. If you included the Advanced Condition
element while creating your Filter in step 2, the Filter Value Set page
displays an additional section Advanced Condition. You can use the
options in this section to create an Advanced Condition and integrate
your Value Set with it. See thelntegrating a Value Set with an
Advanced Condition topic for details. You can also convert the entire
Value Set to an Advance Condition. The Converting a Value Set to an
Advanced Condition topic explains how to do this.

2. Specify values for the Filter elements. See step 2 in the Using Predefined Filters
topic for details.

3. Examine the Value Set result.

4. Click Execute. While the system searches for matching cases, the following dialog
box is displayed.

2 Argus Insight - Case Series Building -- Webpage Dialog g|

Building Case Series.
Please wait...
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Note: You may cancel the query execution at this point and return to
the Filter Value Set page by clicking Cancel Query in the dialog box
above.

5. If the system does not find any cases that match the querying criteria, the
following dialog box is displayed. Click OK in this dialog box to return to the
Value Set form, modify the criteria, and execute the Value Set again.
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6. If the system finds cases that match the query criteria, a list of such cases is
displayed in the Active Case Series page.
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7. Examine the Case Series. If the Case Series is too large, you may want to add
additional elements to the Filter or modify the Value Set. Alternatively, if you find
the Case Series to be appropriate, you can save the Value Set to the system.

8. To return to the Filter Value Set page, click View Query in the Active Case Series
page. The Filter Value Set page appears.

Creating Queries 4-63



Creating Queries

ORACLE |ARGUS 5510 e, Ly o 18 2410 e e TN
= 2

e e e —
e Gy« Pl
FRLTER VALUE SET

Sarien: -

9. If required, modify the Value Set and examine the result again or proceed to save
the Value Set.

10. Save the Value Set to the system.

11. Type a description of the Value Set in the Description text box. For example, you
can describe the type of cases the Value Set retrieves.

12. Click Save Values. The Save Value Set dialog box appears.

e | Argus Insight - Save Value Set -- Webpage Dialog |X|

Save Value Set

% For Filter - Pharmacovigilance Name:

[ ok ]| cancel |

13. Type the name of the Value Set in the Name text box.

Note: The name cannot contain any of the following: % "' A ~,; | #

14. Click OK. The system refreshes the Filter Value Set page. Two new buttons
appear at the bottom of the page: Save Values As and Permissions.
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Note: The Filter Library page displays the custom as well as
predefined Filters and their Values Sets in a control tree format. From
this page you can select a Value Set and directly execute it. See
theWorking with Saved Filters and Value Sets topic for more
information on the Filter Library page. The saved Filters also appear
in the Select Filter for New Value Set dialog box from where you can
select the desired filter, enter values in the New Value Set page and
execute. See the Using Predefined Filters topic for more information.

Tip: If you make modifications to the field values after you have
saved the Values Set to the system, use the Save Values button to save
the changed field values. To save the Value Set by another name, use

the Save Values As button.To clear all the field values in the Filter
Value Set page, click Clear.

15. Assign group-level permissions on the saved Value Set.

16. Click the Permissions button. The Permissions dialog box appears. A list in this

dialog box displays the names of all the groups (except the Administrator group)
that the system administrator has created.
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Permiszions for OBE: New QBE
Legend
UnBlinded W = Write

D = Delete

P = Object
Permizsion

No Access

[ ok || cancel |

17. Use the list box next to a group name to assign permissions to the group members
on the Value Set you have created. You can select from these options:

Permission Description

No Access (Default)  No group members will be able to access the Value Set

R Group members will be able to only view the Value Set

R/W Group members will be able to view and modify the Value Set
R/W/D Group members will be able to view, modify, and delete the Value Set
R/W/D/P Group members will be able to view, modify, delete, and assign

permission on the Value Set

Note: The author of the Value Set always has the highest level of
permission (R/W/D/P) on it.

18. Click OK. The system saves the permission settings.

19. Click Execute. The system retrieves the list of cases that match the Value Set
criteria and displays it in the Active Case Series page. After generating the Case
Series, you can manually modify it or save it. See theCase Serieschapter for more
information on working with Case Series.

Working with the Last Modified or Executed Value Set

This topic explains how to view the Value Set you last modified or executed.

The system assigns the Active status to a Value Set when you save modifications to it
or execute it. Unless you save the modifications to another Value Set or execute it, the
last Value Set you modified or executed remains Active. This is helpful in situations
when you want to access a frequently used Value Set.

Use the following procedure to view an Active Value Set,
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1. Select Create Query > Filters > Active. The Filter Value Set page displays the
Value Set you executed or modified last.
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2. If the Value Set was saved to the system before executing, the name of the Value
Set appears next to Name label. In addition, the name of the Filter appears next to
the Active Query Name label.

3. However, if the Value Set was not saved to the system before executing, the text
<Not Saved> is displayed next to the Name label.

4. From the Active Filter Value Set page, you can perform the following tasks:

Task Description
Modify the Active If required, you can modify the Value Set by changing the field values.
Value Set

Save the Active
Values Set by another
name

Convert Active Value
Set to Advanced
Condition

Assign Permissions
on the Active Value
Set

Change the
Description of the
Active Value Set

Execute the Active
Value Set

While entering field values, if you wish to clear all the values you entered, click
the Clear button.

Use the Save Values button to save the changed field values. This button is only
available for a saved Value Set.

Click Save Values As to save the Active Value Set by a different name.

The Value Sets you save to the system are listed in the Filters Library page.
TheWorking with Saved Value Setstopic explains how to work with saved Value
Sets.

Click Convert to Advanced Condition to convert the Active Values Set to an
Advanced Condition. TheConverting a Value Set to an Advanced Conditiontopic
explains how to do this.

Click Permissions to set the group-level access permissions.

The Permissions button is only available for saved Value Sets.

You can change the description of the Active Value Set by modifying the text
displayed in the Description text box.

Click Save Values to store the changed description.

Click Execute to generate a Case Series by using the Active Value Set.
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Note: When the field values for an Active Values Set are modified or
the Active Value Set is saved by a different name, the changes in the
Active Value Set reflect the most recent changes. The Active Value Set
also changes in case you modify the field values and execute the Value
Set without saving the modifications.

Working with Saved Filters and Value Sets

The Filter Library page lists all the predefined as well as saved custom Filters and
their Value Sets in a control tree format. To access this page, select Create Query >
Filters > Library.
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To view the Values Sets associated with a Filter, expand the control tree for a Filter. The
saved Value Sets are displayed below each Filter.

The descriptions of the columns in the Filter Library page follow.

Column Description

Name Displays the name of the Filters and Value Sets

Description Displays the description of the Filters and Value Sets

Last Modified Displays the date when the Filters/Value Set was last modified
User Full Name Displays the name of the user who created the Filter/Value Set
Category Displays the Filter category

Value Set Displays the number of Value Sets created for a Filter

Report The report icon indicates that a report is associated with a Value Set

See theAssociating a Value Set with a Reportsection below for more
information

Searching Saved Filters and Value Sets
Use the following procedure to search for a saved Filter or Value Set.

1. Specify the search criteria, as appropriate:

»  To search for a Filter/Value Set by its name, type the Filter/Value Set name in
the Name text box.
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s  To search for a Filter/Value Set by its description, type the first few words of
the description in the Description text box. The system searches for the
specified search string in all Filter/Value Set descriptions.

s To search for a Filter/Value Set by its date of modification, enter the
modification date in the first Last Modified date field. You can also specify a
date range by typing the start and end dates in the first and second date fields,
respectively.

s To search a Filter/Value Set by its author, select the author name from the User
Full Name list box.

s To search for a Filter by its category, select the category from the Category list
box.

2. Click Search. Based on your search criteria, the system displays the search result in
a list.

3. You can sort the search result list by clicking the sort icon next to the column
headers in the list.

Creating a New Filter
Click the New Filter button in the Filter Library page. See theCreating Custom
Filterstopic for details.

Creating a New Value Set

Instead of selecting Create Query > Filters > New Values Set to create a new Value
Set, you can click the New Value Set button in the Filter Library page. You can create
Value Sets for predefined as well as custom Filters by using this method. See theUsing
Predefined Filterstopic for details.

Modifying a Filter or Value Set
Use the following procedure to modify a Filter or Value Set.
1. Select the Value Set or the Filter from the list in the Filter Library page.

2. Click Modify. If you selected a Filter, the Filter Elements page appears. If you
selected a Value Set, the Filter Value Set page appears.
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3. Make your modifications to the Filter or Value Set, as appropriate.
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4. Click Save to save the modifications you made in the Filter Elements page. If you

modified a Value Set, click Save Values in the Filter Value Set page to save the
changes.

Deleting a Filter or Value Set

You can delete the Value Sets for predefined as well as custom Filters. You can also
delete custom Filters. However, you cannot delete the predefined Filters. When you
delete a Filter, all its associated Value Sets are also deleted.

Use the following procedure to delete a Value Set or a custom Filter.
1. Select the Value Set or the custom Filter from the list in the Filter Library page.
2. Click Delete. The delete confirmation dialog box appears.

3. Click OK. The system deletes the selected Filter/Value Set; the Filter Library page
appears.

Associating a Value Set with a Report

Argus Insight lets you associate a Value Set to a particular Standard Report and
schedule a time when the report needs to be generated and sent to another user
through email. This is helpful in situations when you need to generate the latest Case
Series and run a report on it each time the datamart is refreshed. Instead of manually
executing the Value Set to generate the latest Case Series and running the report, you
can use the report association functionality of Argus Insight.

Note: The user who is scheduling reports should have an enterprise
login configured in Cognos to schedule the report.

Use the following procedure to associate a Value Set with a Standard Report:

1. In the Filter Library page, select the Value Set that you wish to associate with a
Standard Report.

Associate the Value Set with a Standard Report.

2. Click Associate. The Scheduled Reports Group dialog box appears. This page
displays a list of all groups of reports which were scheduled or associated with the
query.

£

Total Humber Of Rows (0) Displaying Rows [T | Page Size " | - |'[Ssearch] [Clear]
Hame Last Run Tim Created Modified
mm:'l':linn N:ut Run Tin: c:md :yaa Modified ::Is Humber of Reports
No records to display )—il
=
News Modify || Delete Execute Close
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3. Click New and a context menu appears. Select Scheduling.

Argus Insight -- Webpage Dialog

Scheduled Reports Group

Total Humber Of Rows (1) Displaying Rows
Name .. Last Run Time Created By Modified By
Description HNext Run Time Created Date Modified Date
New Reports Ni& jehns jehns
Collection of New Reports NIA 10-JUL-2010 10-JUL-2010
only
Medify || Delete || Execute ][ Close

4. The Reports Scheduling window appears.

2 Argus Insight -- Webpage Dialog X
Reports Scheduling =]
Name: | Frequency: w| Email I ]
oo [ ] Address:
Subject: [ ]

Body: ‘

[ send separate mail for each report

Availale Reparts. (=]
Report Name Description Category Last Modified Author
Adverse Events Line Listing Report providing selected data from study cases  Case Processing  06-JUL-2010 Oracle Corporation ;

A summary tabulation that displays a count of even

CRETACETE ts and breaks them down by causalty.

Pharmacovigiance 07-JUL-2010  Oracle Corporation

To analyze relationships between two or more attri

Age Group vs. Gender e

Pharmacovigiance 10-JUL-2010 | Oracle Corporation

To summarize the event counts by Diagnosis and b

SIS roken down by seribusness and listedness.

Pharmacovigiance 10-JUL-2010  Oracle Corporation

Graph to show the count of incoming and closed ¢

Case Activity History ases and an aggregate total of cases in process.

Management 07-JUL-2010 | Oracie Corporation

Case Count by Reporter Type Report to track the origin of all notifications. General 05-JUL-2010  Oracte Corporation

I

Selected Reports

Report Report Pre-Filters
TS Category Format Configured?

No records to display ‘

[ ok ] cercal [ Clem |

o

On this window, you can schedule multiple reports at once.

o

Schedule the report.

N

This window has 3 main sections:
= Scheduling Information - The Schedule timing and E-Mail information.

= Available Reports - All the available reports in the system that can be
scheduled.

= Selected Reports - These reports are scheduled.

]

Provide a Name for your reports group along with description.

©

Use the Frequency list box to specify how often you wish to have the system run
the selected QBE and generate the selected report. The options available are: Once,
Daily, Weekly, Monthly, Quarterly, and Yearly.
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10.
11.

Specify the schedule time in the Time field.

Based on the option you selected in the step above, specify the instant when you
want the report generated as described in the table below.

Frequency Option

Selected Additional Scheduling Information to Specify

Once In the Date text box that appears, enter the date when you want to have the report
generated.

Daily In the Time text box that appears, enter the time when you want to have the report
generated. The time must be entered in the HH:MM AM/PM format. Hours should
be between 1 and 12.

Weekly From the Day of Week option button group that appears, select the day of week on
which you want to have the report generated. Also, specify the time in the Time
text box.

Monthly Use the Day list box to select the day of the month on which you want to have the
report generated. Also, specify the time in the Time text box.

Quarterly Quarterly reports are generated on the first day of the quarter. In the Time text box,
enter the time when you want to have the report generated on the first day of the
quarter.

Yearly In the Date and Time text boxes, specify the date and time when you want to have

the yearly report generated.

12.
13.

14.
15.
16.

17.

18.

19.

20.
21.

Specify the email recipients of the report you scheduled.

In the Email Address text box, type the email address of the report recipient. If
there are multiple recipients, use a semicolon to separate their email addresses.

Type the subject line in the Subject text box.
Type the email body text in the Body text box.

If you want all the reports in a single mail, leave the Send separate mail for each
report checkbox unchecked. If you check this checkbox, each report is delivered in
a separate mail to the user.

From the Available reports grid, select a report and click Add button. The report
will be selected and will appear in the Selected Reports section.

To remove a report from Selected Reports, click the X button against the report.
When you click the selected report(s) in this section, its corresponding prompts are
loaded in the right pane.

Enter the sub-title for the report pre-filter in the right pane and click OK.
Click OK in the Reports Scheduling window.

Click OK. The system associates the Value Set with the selected report and saves
the scheduling information; the FilterLibrary page appears. The icon displayed in
the Associated Report column indicates that the Value Set is associated with a
report.
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Note: Refer to the Associated Library and Query Library sections in
the Library chapter, to view the steps on how to disassociate reports in
those libraries.

Executing a Value Set
Use the following procedure to execute a Value Set.

1. Select a Value Set from the list in the Filter Library page.

2. Click Execute. The system executes the Value Set; the Active Case Series page
appears.
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3. Ifareport is associated with the saved QBE, click Execute. The Active Case Series
page and Pre Filter page of the associated report is displayed.

4. Enter the prompts value in the Pre Filter page.
5. Click on the Execute button to generate the report.

After generating the Case Series, you can manually modify it or save it. See the
Case Series chapter for more information on working with Case Series.
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Executing a Saved Value Set on the Active Case Series

Just as the system assigns the Active status to a Value Set when you save modifications
to it or execute it, the last saved or generated Case Series becomes the Active Case
Series.

Use the following procedure to narrow down the list of cases in the Active Case Series,
you may want to run a Value Set on an Active Case Series.

1. Generate the Case Series on which you wish to run another Value Set:

= You can generate the Case Series by Using Predefined Filters or Creating
Custom Filters and executing a Value Set. This Case Series automatically
becomes the Active Case Series and remains so until you execute another
query to generate a different Case Series.

= Alternatively, if the Case Series on which you wish to run another Value Set is
already saved in the system, select Query Results > Case Series > Case Series
Library. In the Case Series Library page that appears, select the Case Series
title and click Make Active.

2. Select Create Query > Filters > Library. The Filter Library page appears.

3. Select the Value Set you want to run on the Active Case Series you generated in
step 1.

4. Check the Limit Query to Active Case Series checkbox.

5. Click Execute. The system runs the selected Value Set on the Active Case Series
and displays the Active Case Series page. Note that the Case Series you just
generated becomes the Active Case Series.

Using Filters with Advanced Conditions

Advanced Conditions let you create complex queries that involve Boolean and Set
operations among various fields. In Argus Insight, Advanced Conditions are created
in the Advanced Conditions editor, which employs a spreadsheet-like approach for

adding query conditions (fields and their values) and conditional operators (Boolean or
Set).

In Argus Insight, Filters are integrated with Advanced Conditions to let you perform
the following tasks.

= Converting a Value Set to an Advanced Condition

= Integrating a Value Set with an Advanced Condition

Converting a Value Set to an Advanced Condition

A Filter Value Set can be used to start an Advanced Condition that employs Set or
Boolean operations between elements that have multiple values. When you convert a

Value Set to an Advanced Condition, al its fields are listed in the Active Advanced
Conditions Editor page as Advanced Condition attributes.

Use the following procedure to convert a Value Set to an Advanced Condition

1. Create a new Value Set by either Using Predefined Filters or Creating Custom
Filters. Alternatively, open a saved Value Set from the Filters Library page
(seeWorking with Saved Value Sets).

2. Verify the field values you specified in the various fields in the Value Set.

3. (Click the Convert to Advanced Condition button. The Active Advanced
Condition Editor page appears; all the fields in which you specified values in the
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QBE form are listed as Advanced Condition attributes. The fields in which you
selected multiple values are repeated.
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In the Advanced Condition editor, you can build your query further by:
» Adding additional attributes (fields) and specifying their values

= Adding another Advanced Condition as an attribute

s Placing runtime parameters in attributes

s Placing parentheses to determine the query execution order

= Specifying conditions for attributes values

»  Specifying Set and Boolean operators to join the various attributes

See theAdvanced Conditionssection for detailed information on building
Advanced Conditions by using the options in the Advanced Condition editor.

Integrating a Value Set with an Advanced Condition

Argus Insight lets you integrate a Value Set with an existing Advanced Condition
through these Set operators: Intersect, Minus, or Union. If required, you can integrate a
Value Set with multiple Advanced Conditions. The multiple Advanced Conditions can
have Set or Boolean operations between them.

Note: Only those Value Sets that have the Advanced Condition
element can be integrated with Advanced Conditions. All Value Sets
that you create for predefined Filters contain the Advanced Condition
element. If you wish to convert a customFilter Value Set to an
Advanced Condition, make sure you select the Advanced Condition
element while creating the custom Filter.

Use the following procedure to integrate a Value Set with existing Advanced
Conditions.

1.

Create a new Value Set by eitherUsing Predefined FiltersorCreating Custom
Filters. Alternatively, open a saved Value Set from the Filters Library page
(seeWorking with Saved Value Sets). If you create a custom Value Set, make sure
you include the Advance Condition element.
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2. In the Filter Value Set page, verify the field values you specified you specified for
the Value Set.

3. Scroll down to the Advanced Condition section in the Filter Value Set page.

R I i P ey

= s | [eeeen | e
e Saary - Pleew
s

A oy e e
Aies i bt it

4. Use the Operator list box to specify the Set operator you want to use to integrate
the Values Set and the Advanced Condition. You can select one of these options:
Intersect, Minus, Union.

a

Select the Advance Condition you want to integrate with the QBE.

o

Click the context menu icon. A context menu appears. In the context menu, all the
Advanced Conditions stored in the system are organized by categories.

Advanced Condition

operatr
( Attributes  Condition Value
:
E [ ACLBRARY » | CaGeneral Y [@)act
= [@]acz
[@]ac3
E] [@]Ac_s333380
[@] case_2002_ac
E @ Drugs in Study ( Includes Comparators )
@ @ Study Drug exists

7. In the context menu, browse to the appropriate category and select the required
Advanced Condition. The selected Advanced Condition appears as a row in the
Advanced Condition editor.

8. If required, add other Advanced Conditions. Click the icon to insert another
Advanced Condition above the existing Advanced Condition. Click the icon to
insert another Advanced Condition below the existing Advanced Condition.

Tip: You can change the structure of thequery by changing order of

rows in the editor. To do this, select a row and click the arrow button
to move the row up or down.

9. Type parentheses in the (and ) columns to determine the order of execution for the
selected Advanced Conditions.
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10. Use the list box in the Operator column to specify the operators between the
selected Advanced Conditions. You can select from these options: AND, OR,
Intersect, Minus, and Union.

Note: See theAdvanced Conditions chapter for detailed information
on creating Advanced Conditions by using the options in the
Advanced Condition editor.

11. Save the integrated query by clicking Save As.

Note: You can convert the integrated Value Set and Advanced
Condition into a single Advanced Condition by clicking Convert to
AdvancedCondition. SeeConverting a Value Set to an Advanced
Condition for details.

12. Click Execute to run the integrated Value Set and generate the Case Series. The
Active Case Series page appears; the Case Series is displayed. See theCase
Serieschapter for more information on working with Case Series.

Advanced Conditions

The Advanced Conditions querying tool is designed to allow the greatest flexibility in
designing the most advanced queries. Argus Insight users can use Advanced
Conditions to create complex queries that involve Boolean and Set operations using
Structured Query Language (SQL).

Note: The Advanced Conditions field labels are displayed as per the
field labels configured in Argus.

In Argus Insight, Advanced Conditions are created in the Advanced Conditions editor,
which employs a spreadsheet-like approach for adding query conditions (fields and
their values) and conditional operators (Boolean or Set).

Refer to the following topics for more information on working with Advanced
Conditions.

»  Creating a New Advanced Condition
= Working with the Last Modified or Saved Advanced Condition
= Working with Saved Advanced Conditions

Creating a New Advanced Condition
This topic explains how to:

= Start a new Advanced Condition
s Use the Advanced Condition Editor options to build your Advanced Condition
= Generate a Case Series by executing the Advanced Condition

Starting a New Advanced Condition
Use the following procedure to start a new advanced condition.
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1.

Start the new Advanced Condition. Select Create Query > Advanced Conditions >
New. The Advanced Conditions Editor page appears.
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2.
3.

Note: You can also start an Advanced Condition by converting a
Advanced Condition or a Filter Value Set to Advanced Condition. See
these topics for details: Converting a Advanced Condition to an
Advanced Condition and Converting a Value Set to an Advanced
Condition.

Enter the Advanced Condition attributes (fields and values)

Click the context menu icon. A context menu appears. In the context menu, the
first seven categories (Activities, Additional Info, Analysis, Events, General,
Patients, and Products) represent the Argus case form tabs. In these categories, the
various datamart fields that pertain to case information are organized in this
hierarchy: Argus case form tab > sections within the tab page > Fields within the
section. You can browse through the appropriate hierarchy and select the required
field as an Advanced Condition attribute.

The eighth category Reports contains attributes that pertain to the reporting
information of a case. You can browse through the Reports category and select the
required Advanced Condition attribute.

The ninth category AC Library lists all the Advanced Conditions stored in the
system. You can browse through the AC Library category and select a stored
Advanced Condition as an attribute for the new Advanced Condition.

Creating Queries 4-78



Creating Queries

ORACLE' |ARGUS INSIGHT™
I Home I Create Query I Query Results I Case Series Reports I Datamart Reports I
Create Query > Advanced Conditions

ACTIVE ADVANCED CONDITIONS EDITOR

Name : Category Description
< Not Saved = | General v| |
Advanced Condition
{ Attributes Condition Value
ID ACTIVITES b (Advanced Condition)
(3 ADDL INFO ¥ ts (Advanced Condition)
[T ANALYSIS »
[C3] CASE SERES »
[CI EVENTS »
[C3] GENERAL »
[C3 PATIENT »
[Z3 PRODUCTS »
[Z3 REPORT »
[T AC LIBRARY ¥ | Caceneral ¥ [@act
[@]acz
[@]ac3
[@]ac_s333380
[@] case_2002_ac
@ Drugs in Study ( Includes Comparators )
@ Study Drug exists

4. Browse through the appropriate category hierarchy and select the required
attribute. The selected attribute appears as a row in the editor.

ADVANCED CONMMTIONS EDITOR Active Query Name:  New Advanced Cendin

Active Case Series; « Nt Saved »
1 Category Description
Crugs i Sty [ Incldes Comparatrs | General * | |Drugs in Study { ncludes Comparators |
1 Afributes Condion Ve ) Operstor

Drugs in Study [ Includes.

= = S =
Comparstors } equalts 1R0TER

SRR

[ save || savess | | vewsil || emesccs | | bucute |

Note: The user defined fields in Argus which have been converted as
a look up are also available as attributes for the advanced condition
search.

5. In the Value field, enter the value for the selected attribute. Depending on the type
of attribute you selected, the system lets you populate the Value field by using a:

= List box to select from a set of predefined values
s Textbox to enter text strings or numerals
»  Date field to enter dates

= Browser to select MedDRA dictionary terms, company products, WHO drugs,
clinical study IDs, Drugs in Study (incl. Comparators) and Investigational
Drugs.
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s Use the following procedure to use a Browser to populate the Value field, click
the ellipsis button next to the Value field; in the context menu that appears,
select the option corresponding to the browser name to launch the browser.

Note: The MedDRA browser for Create Query > Advanced
Conditions tab, can be called for search criteria based on specific
terms. The search criteria can be based on the specific term codes or
descriptions depending on your requirement. Refer to the
followingexample for more information.

1. Select the Attribute from the Advanced Condition form.

2. The Attribute chosen in the sample example is Product > Product
Drug > Product Indication PT.The PT description of the Product
Indication is returned to the Advanced Condition Page.

ORACLE |ARGUS INSIGHT

| Home | creseauery | QueryResuits | Case Series Reports | Datamart Reports
Creote Query > Advenced Condtons

ACTIVE ADVANCED CONDITIONS EDITOR

Hame : Category Descnpbion
it General v
Condition Vilue
» {Advanced Condton)
= .—I;UDL e ¥t {Advanced Condion)
S L) anaLYsS »
| L) CASE SERES »
LJEVENTS »
fl () GENERAL »
\—g CapaTEnT »
| CyprRODUCTS ¥ | L 00sage Regmen 5
| ) REPORT * | ) product Device v
| C3AC LBRARY * | CyProcuct g " o
C)Product DrugVacene  + | 9] Abuse = ||
(L) Product ingication s | @] Acton Taken
(Z Product » ,ﬂc
(E3 Product Vaccne » | 9] Date.
(23 Qualty Cantrol + | 9] Dechabenge Resuts
(L) Vaccne Hatolry + | [9] Drug Cumulative Dose Unk
(L Vaceine Prior AE » | 9] Drug Cumulatve Dose Unt ©
() WHO DRUG ATC Cede  # | 9] Drug Dechatenge Date Range

|9] Drug First Diose Date Rangs
(8] Drug info Severty
| @] Drug Last Dese Date Range
|@] Drug Primary indication Code
@] Drug Prmary Indication HLGT Code
|9] Orug Primary Indication HLT Code
9] Drug Primary indication LLT Cade
| ] Drug Primary indication SOC Code
[#] Drug Rechalange Start Date Range
@] Drug Rechalenge Stop Date Range
ﬂcurlmn of Agministration
| @] First Dose
| 9] indication SUQ (Broad)
@] indieation SUQ (Narrow)

||9] nteraction?

3. Select the Condition, Value and Operator depending on your
search-criteria.

4. Click Execute to run the Advanced Condition query.

6. Specify the condition for the attribute value. Use the Conditions list box to specify
a condition as explained below:

equal to - select this option if you want to  not equal to - select this option if you want to retrieve
retrieve cases where the selected attribute's cases where the selected attribute's value is not equal to
value is equal to what the Value field what the Value field specifies

specifies
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greater than - select this option if you want
to retrieve cases where the selected
attribute's value is greater than what the
Value field specifies

less than - select this option if you want to
retrieve cases where the selected attribute's
value is less than what the Value field
specifies

missing - select this option if you want to
retrieve cases where the selected attribute's
value has not been specified

begins with - select this option if you want
to retrieve cases where the selected
attribute's value begins with what the
Value field specifies

does not contain - select this option if you
want to retrieve cases where the selected
attribute's value does not contain what the
Value field specifies

not in - select this option if you want to
retrieve cases where the selected attribute's
value does not exist in what the Value field
specifies

Add more attributes. Follow steps 2
through 4 to add more attributes to your
Advanced Condition. Click the icons on the
left bar to insert another attribute above or
below the existing attribute.

greater than or equal to - select this option if you want to
retrieve cases where the selected attribute's value is greater
than or equal to what the Value field specifies

ess than or equal to - select this option if you want to
retrieve cases where the selected attribute's value is less
than or equal to the Value that the field specifies

exists - select this option if you want to retrieve cases
where the selected attribute has any value

contains - select this option if you want to retrieve cases
where the selected attribute's value contains what the
Value field specifies

in - select this option if you want to retrieve cases where
the selected attribute's value exists in what the Value field
specifies

Specify the operator. Use the Operator list box to specify
the Boolean or Set operator through which you want to
join the attribute with another attribute.

Tip: You can change the structure of the Advanced Condition query
by changing the order of attribute rows in the editor. Use the
following procedure to do this, select a row and click the Up or Down
arrow buttons to move the row up or down. To delete a row from the
editor, select the row and click the Delete icon.

7. Specify runtime parameters, as appropriate.

Note:

Argus Insight lets you create Advanced Conditions which

when executed, ask for user-specified values for certain attributes to
generate the Case Series. For example, you may create an Advanced
Condition in which the Case Number or the Product name may be
specified only at the time of execution. In this case, the Advanced
Condition would only retrieve those cases where the Case

Number /Product Name is as specified at the time of execution.

Creating an Advanced Condition using same field name multiple
times requires to change the Parameter name so that while executing
the advanced condition different parameters values can be entered.

8. Identify the attribute row where you want to specify runtime parameters.

9. Click the ellipsis button next to the Value field. A context menu appears.

10. Select the Parameters option.
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11

Advanced Condition

( | Attributes Condition
S o ErD 9 | =L e
g [ ] type | equalto v || [AffRef.+ Rep Auth. v|| [3] Parameters v

. Click Parameter. The following dialog box appears.

e | Argus Insight - Create Parameter -- Webpage Di... |X

Parameter

New Parameter Name:

|T‘,r|:|e |
or Select from Existing Parameter Names:

| vl

Multi Select

12,

13.

14.

15.
16.

0K Cancel

Check the Multi Select checkbox if you want to pass multiple runtime values for a
single attribute. For example, you might want to pass more than one case number
or product name as runtime parameters.

Click OK. The field you configured as a runtime parameter is displayed in the
Value text box enclosed within % symbol. For example, %Product Type% If you
configured the field to accept multiple runtime parameters, the field name appears
in the Value text box enclosed within %% symbol. For example, %%Product
Type%%.

Type parentheses in the (and ) columns to determine the order of execution for the
selected Advanced Conditions, as appropriate.

Note: Refer the Advanced Condition Creation Process section for
further details on creating an Advanced Condition.

Examine the Advanced Condition result.

Click Execute. While the system searches for matching cases, the following dialog
box is displayed.

2 Argus Insight - Case Series Building -- Webpage Dialog g|

Building Case Series.
Please wait...

Creating Queries  4-82



Creating Queries

Tip: You may cancel the query execution at this point and return to
the Advanced Condition Editor by clicking Cancel Query in the
dialog box above.

s If you configured any runtime parameters, the Parameters dialog box appears.
Specify the parameter values by using the options in the dialog box. Next,
click Execute; the system retrieves the matching cases from the datamart and
displays them in the Active Case Series page.

Tip: If you select one run-time parameter and execute the search,
you must enter a field.

If you select multiple run-time parameters and execute the search, you
have the option to ignore the run-time parameters.

»  If the system does not find any cases that match the querying criteria, the
following screen is displayed. Click View Query in this screen to return to the
Advanced Condition Editor, modify the criteria and execute again.
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»  If the system finds cases that match the query criteria, a list of such cases is
displayed in the Active Case Series page.
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17. Examine the Case Series. If the Case Series is too large, you may want to modify
the Advanced Condition by specifying additional attributes or changing values.
Alternatively, if you find the Case Series to be appropriate, you can save the
Advanced Condition to the system.

The system retrieves the matching cases from the datamart and displays them in
the Active Case Series page.
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Returning the to Advanced Condition Editor
Use the following procedure to return to the Advanced Condition Editor.

1. Click View Query in the Active Case Series page. The Active Advanced
Condition Editor page appears.
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Note: When you save the modifications to an Advanced Condition
or execute it, the system assigns the Active status to the Advanced
Condition. Therefore, when you return to the editor after executing
the Advanced Condition, the page title changes to ActiveAdvanced
Condition Editor. The field values you specified in the editor before
executing are retained. See theWorking with the Last Modified or
Saved Advanced Condition topic for details on Active Advanced
Conditions.

2. If required, modify the Advanced Condition and examine the result again or
proceed to save the Advanced Condition.

3. Save the Advanced Condition.

Assigning a Category to an Advanced Condition

Use the Category list box to assign a category to the Advanced Condition. A category
indicates the reporting aspect to which your Advanced Condition pertains:
Compliance, Configuration, General, Management, or Pharmacovigilance.
Specifying the category also helps you in searching the relevant Advanced Conditions
from a list of all the Advanced Conditions saved in the system.

1. Type a description of the Advanced Condition in the Description text box. For
example, you can describe the type of cases the Advanced Condition retrieves.

2. Click Save in the Active Advanced Condition Editor page. The Save Advanced
Condition dialog box appears.
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e | Argus Insight - Advanced Condition - Save -- We... [E|

Advanced Condition - Save

Name:

I 0];4 | Cancel

3. Type the name of the Advanced Condition in the Name text box.

4. Click OK. The system refreshes the Active Advanced Condition Editor page. Note
that the following new elements appear on the page.

5. The Active Query Name field in the upper-right corner of the page now displays
the name of the Advanced Condition you specified while saving the Advanced
Condition.

6. Three new buttons appear at the bottom of the page: Save As, View SQL and
Permissions.

Note: All the Advanced Conditions that you save to the system are
listed in the Advanced Condition Library page. TheWorking with
Saved Advanced Conditions topic explains how to work with saved
Advanced Conditions

Tip: If you modify the field values after saving the Advanced
Condition to the system, use the Save button to save the changed field
values.

7. Click View SQL to view the underlying SQL query for the Advanced Condition.

View SQL helps you to view and edit the underlying SQL for the Advanced
Condition created.
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e | Argus Insight - Advanced Conditions SQL -- Webpage ... E|

Advanced Conditions SQL

Note: SAQL must be "SELECT DISTINCT WV_RPT_CASE.case_id From
V_RPT_CASE'

SELECT DISTINCT V_RPT_CASE.case_id FROM V_RPT_CASE,
RPT_REFERENCE, DTL_CASE WHERE (WV_RPT_CASE.case id =
RPT_REFERENCE.case_jd{+) AND V_RPT_CASE.case_id =
DTL_CASE.case id(+} AND {{(UPPER(RFT_REFERENCE.REF_MNO)
<=UPPER('234) OR RPT_REFERENCE.REF_NO IS NULL ) AND
(DTL_CASE.DIAGNOSIS_HLGT IS NOT NULL) OR
{RPT_REFERENCE.REF_TYPE_ID=%%Type%%))))

| savesal | [ close |

»  Click Save SQL after editing the query.

Note: When using this Save SQL functionality the Advanced

Condition can be executed only from the Advanced Conditions library
and the Query Library page.

The View SQL textbox can have a maximum of 4000 characters.

Tip: Revert to Original helps you to revert back to the original
advanced condition.

s Click Close.

Assign group-level permissions on the saved Advanced Condition.

Click the Permissions button. The Permissions dialog box appears. A list in this

dialog box displays the names of all the groups (except the Administrator group)
that the system administrator has created.
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Blinded

UnBlinded

Permizsions for Advanced Condition: NHew Advanced Condition

Legend

v R = Read
D = Delete

P = Object
Permizsion

No Access

[ ok || cancel |

10. Use the list box next to a group name to assign permissions to the group members
on the Advanced Condition you have created. You can select from these options:

Permission

Description

No Access (Default)  No group members will be able to access the Advanced Condition

R
R/W
R/W/D

R/W/D/P

Group members will be able to only view the Advanced Condition
Group members will be able to view and modify the Advanced Condition

Group members will be able to view, modify, and delete the Advanced
Condition

Group members will be able to view, modify, delete, and assign permission
on the Advanced Condition

Note: The author of the query always has the highest level of
permission (R/W/D/P) on the query. For example, you belong to the
Data Entry group and you assign the No Access permission level to
the Data Entry group on a Advanced Condition that you create. In this
case, while you will continue to have the highest level of permission
on your Advanced Condition, other members in your group will not
be able to access your Advanced Condition.

11. Click OK. The system saves the permission settings.

12. Click Execute to generate the Case Series.

The system retrieves the matching cases from the datamart and displays them
in the Active Case Series page.

If you configured any runtime parameters, the Parameters dialog box appears.
Specify the parameter values by using the options in the dialog box. Next,
click Execute; the system retrieves the matching cases from the datamart and
displays them in the Active Case Series page. See the Case Series chapter for
more information on working with Case Series.
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Creating an Advanced Condition

Use the following Order of precedence for the various operators selected when

creating an Advance Condition.

Order

Operator
And

Or

Intersect

Minus

Union

Use

Use with all fields available in Advanced
Condition.

Use with all fields available in Advanced
Condition.

Use between various queries (AC Library
Attributes)

Use between various queries (AC Library
Attributes)

Use between various queries (AC Library
Attributes)

Using an Intersect, Minus or Union operator results in the creation of two separate
select clauses. Therefore, use these operators between different queries.

PL/SQL syntax should be kept in mind while creating an Advanced Condition.

PL/SQL syntax:

SELECT
tablel.common_column

FROM

Tablel, table2, table3

WHERE

Tablel.column2 = table2.column2
AND

Table2.column3 = table3.column3
INTERSECT

SELECT
Table4.common_column

FROM

Table4, table5, table6

WHERE

Table4.column2 = table5.column2
AND

Table5.column3 = table6.column3

Now suppose you want to create an Advanced Condition as follows:

Where country = "Australia” AND Co-Drug Code w Study = "LAS+TAB" OR Co-Drug
Code w Study = "LAS+" AND Overdose = "Yes" AND Interaction? = "Yes"

And wants to intersect the results of this Advanced Condition with the existing

Advanced Condition
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Where country = "United States” or country = ”Australia”
Then you should create the Advanced Condition as shown in the screen shot below.

The user needs not to take care of parenthesis if the PL/SQL syntax and the order and
precedence of operators are taken care off.

The following SQL will get generated in this case.
SELECT DISTINCTv_rpt_case.case_id

FROM v_rpt_case, rpt_product

WHERE v_rpt_case.case_id = rpt_product.case_id

AND ( (v_rpt_case.country_id = 13)

AND ( UPPER (rpt_product.co_drug_code) = 'LAS+TAB'
OR (pat_exposure IN (

SELECT product_id

FROM Im_product

WHERE UPPER (Im_product.drug_code) ='LAS+TAB")))
OR(UPPER (rpt_product.co_drug_code) = 'LAS+'

OR (pat_exposure IN (SELECT product_id FROM Im_product
WHERE UPPER (Im_product.drug_code) ='LAS+')))
AND (rpt_product.is_overdose = 1)

AND (rpt_product.interaction = 1))

INTERSECT

SELECT DISTINCTv_rpt_case.case_id

FROM v_rpt_case

WHERE v_rpt_case.case_id IN (

SELECT DISTINCT v_rpt_case.case_id

FROM v_rpt_case

WHERE (v_rpt_case.country_id = 13)

OR (v_rpt_case.country_id = 223))

Working with the Last Modified or Saved Advanced Condition

The system assigns an Active status to a Advanced Condition when you modify and
save it or when you execute it. Unless you save the modifications to another Advanced
Condition or execute another Advanced Condition, the last Advanced Condition you
modified or executed remains Active. This is helpful in situations when you want to
access a frequently used Advanced Condition.

Use the following procedure to view an active Advanced Condition,

1. Select Create Query > Advanced Condition > Active. The Active Advanced
Conditions Editor page displays the Advanced Condition you executed or
modified last.
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2. If the Active Advanced Condition was saved to the system before executing, the
name of the Advanced Condition appears next to the Active Query Name and
Name label. However, if the Active Advanced Condition was not saved to the
system before executing, the text <Not Saved> is displayed next to the Active
Query Name label.

From the Active Advanced Condition page, you can perform the following tasks:

Task

Description

Modify the attributes
in the Advanced
Condition editor

Save Active
Advanced Condition
with another name

View the Advanced
Condition in SQL

Assign Permissions

Change the
Description of the
Active Advanced
Condition

Execute the Active
Advanced Condition

If required, you can modify the attributes (fields and values) in the Advanced
Condition editor. See theCreating a New Advanced Conditiontopic for
information on working with the Advanced Condition editor.

Use the Save button to save the changed field values. This button is only
available for a saved Active Advanced Condition.
Click Save As to save the Active Advanced Condition by a different name.

The Advanced Conditions that you save to the system are listed in the
Advanced Condition Library page. TheWorking with Saved Advanced
Conditionstopic explains how to work with saved Advanced Conditions.

Click View SQL to view the underlying SQL query for the Advanced
Condition.

In this SQL, manually replace the V_RPT_CASE with RPT_CASE. This is
required to execute the query in the Oracle database.

Click Permissions to set the group-level access permissions on the Advanced
Condition. See theCreating a New Advanced Conditiontopic for information
on setting permissions.

The Permissions button is only available for saved Active Advanced
Conditions.

You can change the description of the Active Advanced Condition by
modifying the text displayed in the Description text box.

Click Save to store the changed description.

Click Execute to generate a Case Series by using the Active Advanced
Condition.

Note that modifying the field values in the Advanced Condition editor for an Active
Advanced Condition or saving the Active Advanced Condition by a different name
changes the Active Advanced Condition to reflect the most recent changes. The Active
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Advanced Condition also changes in case you modify the field values in the Advanced
Condition editor and execute the Advanced Condition without saving the
modifications.

Working with Saved Advanced Conditions

The Advanced ConditionsLibrary page lists all of the Advanced Conditions saved to
the system. To access this page, select Create Query > Advanced Conditions >
Library.

ORACLE |ARGUS INSIGHT Johers, Sundey Juy 11, 2010 (A6157360) L
ooy oy | co s s
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The Advanced Condition Library page displays a list of the saved Advanced
Conditions in a grid format. The descriptions of the grid columns follow.

Column Description

Name Displays the name of the Advanced Condition

Description Displays the Advanced Condition description

Last Modified Displays the date when the Advanced Condition was last modified
User Full Name Displays the name of the user who created the Advanced Condition
Category Displays the category assigned to the Advanced Condition
Parameters Displays the name of fields for which a runtime parameters need to be

specified while executing the Advanced Condition

Report The icon indicates that a report is associated with the Advanced Condition

See theAssociating an Advanced Condition with a Reportsection below for
more information.

Searching Saved Advanced Conditions
Use the following procedure to search for a saved Advanced Condition:

1. Specify the search criteria, as appropriate:

= To search for an Advanced Condition by its name, type the Advanced
Condition name in the Name text box.

s To search for an Advanced Condition by its description, type the first few
words of the description in the Description text box. The system searches for
the specified search string in all Advanced Condition descriptions.

s To search for an Advanced Condition by its date of modification, enter the
modification date in the first Last Modified date field. You can also specify a
date range by typing the start and end dates in the first and second date fields,
respectively.
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s To search for an Advanced Condition by its author, select the author name
from the User Full Name list box.

»  To search for an Advanced Condition by its category, select the category from
the Category list box.

Click Search.
Based on your search criteria, the system displays the search result in a list.

You can sort the search result list by clicking the sort icon next to the column
headers in the list.

To clear the search result and display all the Advanced Conditions in the list, click
the Clear button.

Creating a New Advanced Condition
Use the following procedure to create a new Advanced Condition.

1.

Click the New button in the Advanced Condition Library page.

See theCreating a New Advanced Condition topic for details.

Modifying an Advanced Condition
Use the following procedure to modify an Advanced Condition:

1.

Select the Advanced Condition from the list in the Advanced Condition Library
page.
Click Modify. The Advanced Condition editor appears

Make your modifications to the Advanced Condition, as appropriate.

Click Save to save the modifications you made. Alternatively, click Save As to
save the modified Advanced Condition by another name.

Modifying the SQL of an Advanced Condition
Use the following procedure to modify the SQL of an Advanced Condition:

1.
2.

30 T i A e

3.

Drigs in Study { helides Comparaton Gener

Go to the Advanced Conditions Library page.

Select a particular Advanced Condition and click Modify. The Active Advanced
Conditions Editor screen appears.

ADVANCED CONDITIONS ENTOR

1 Anributes. Candtion Value ¥ Opermor
Brugs in Study { Inchides
Comparators |

Click View SQL. The Advanced Conditions SQL dialog appears.
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Advanced Conditions SQL
Note: SQL must be 'SELECT DISTINCT V_RPT_CASE.case_id From
V_RPT_CASE'

SELECT DISTINCT V_RPT_CASE case_id FROM V_RPT_CASE WHERE
((V_RPT_CASE.STUDY_KEY = 10006537 OR V_RPT_CASE STUDY_KEY
= 10006538 OR V_RPT_CASE STUDY_KEY = 10006538 OR
V_RPT_CASE STUDY_KEY = 10006540 OR V_RPT_CASE STUDY_KEY =
10006541 OR V_RPT_CASE STUDY_KEY = 10008542 OR

V_RPT_CASE STUDY_KEY = 10006546) )

| savesaL | [ close

4. Modify the SQL as per your requirement and click Save SQL. The SQL is saved
and the Advanced Conditions SQL dialog appears.

5. Click Close. The Advanced Conditions Library page appears.

6. Select the modified Advanced Condition and click Execute. You will get the results
as per modified SQL.

Note: You can not modify an Advanced Condition once you have
added user defined SQL in that, you can modify SQL but can not add
new items in Advanced Condition.

If you want to add new items, you have to revert the SQL to original
by clicking on the Revert to Original button.

Deleting an Advanced Condition
Use the following procedure to delete an Advanced Condition

1. Select the Advanced Condition from the list in the Advanced Condition Library
page.

2. Click Delete. The delete confirmation dialog box appears.

3. Click OK. The system deletes the selected Advanced Condition; the Advanced
Condition Library page appears.

Associating an Advanced Condition with a Report

Argus Insight lets you associate an Advanced Condition to a particular Standard
Report and schedule a time when the report needs to be generated and sent to another
user through email. This is helpful in situations when you need generate the latest
Case Series and run a report on it each time the datamart is refreshed. Instead of
manually executing the Advanced Condition to generate the latest Case Series and
running the report, you can use the report association functionality of Argus Insight.

Note: The user who is scheduling reports should have an enterprise
login configured in Cognos to schedule the report.
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Use the following procedure to associate an Advanced Condition with a Standard
Report:

1. On the Advanced Condition Library page, select the Advanced Condition that
you wish to associate with a Standard Report.

n

Associate the Advanced Condition with a Standard Report.

L d

Click Associate. The Scheduled Reports Group dialog box appears. This page
displays a list of all groups of reports which were scheduled or associated with the
query.

1 Argus Insight -- Webpage Dialog el

Scheduled Reports Grou
Total Humber Of Bows (3) Displaying Rows TN | Page Size 1 [oseach] [Ciear]
Deeron WeAmTime  Crodedive  Modedide  Momosrorieports
N records ta display =
4. Click New and a context menu will appear. Select Scheduling option.
5. The Reports Scheduling window will appear.
6. On this window, you can schedule multiple reports at once.
7. Schedule the report.

This window has 3 main sections:

= Scheduling Information - The Schedule timing and E-Mail information

= Available Reports - All the available reports in the system that can be
scheduled.

= Selected Reports - These reports will be scheduled.
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Grouping
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ok ][ Cancel [ Clear. |

8. Provide a Name for your reports group along with description.

9. Use the Frequency list box to specify how often you wish to have the system run
the selected QBE and generate the selected report. The options available are: Once,
Daily, Weekly, Monthly, Quarterly, and Yearly.

10. Specify the schedule time in the Time field.

11. Based on the option you selected in the step above, specify the instant when you
want the report generated as described in the table below.

Frequency Option
Selected Additional Scheduling Information to Specify

Once In the Date text box that appears, enter the date when you want to
have the report generated.

Daily In the Time text box that appears, enter the time when you want to
have the report generated. The time must be entered in the HH:MM
AM/PM format. Hours should be between 1 and 12.

Weekly From the Day of Week option button group that appears, select the
day of week on which you want to have the report generated. Also,
specify the time in the Time text box.
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Frequency Option

Selected Additional Scheduling Information to Specify

Monthly Use the Day list box to select the day of the month on which you
want to have the report generated. Also, specify the time in the
Time text box.

Quarterly Quarterly reports are generated on the first day of the quarter. In the
Time text box, enter the time when you want to have the report
generated on the first day of the quarter.

Yearly In the Date and Time text boxes, specify the date and time when
you want to have the yearly report generated.

12. Specify the email recipients of the report you scheduled.

13.

14.

15.

16.

17.

18.

19.

20.

In the Email Address text box, type the email address of the report recipient. If
there are multiple recipients, use a semicolon to separate their email addresses.

Type the subject line in the Subject text box.
Type the email body text in the Body text box.

If you want all the reports in a single mail, leave the Send separate mail for each
report checkbox unchecked. If you check this checkbox, each report will be
delivered in a separate mail to the user.

From the Available reports grid, select a report and click Add button. The report
will be selected and will appear in the Selected Reports section.

To remove a report from Selected Reports, click the X button against the report.

For each selected report, you must fill the Pre-filters associated with each report.
To do this, click on any report in the Selected Reports grid and the pre-filters will
appear beside it. Fill them and click the OK button of Report Pre-Filters section.

Click OK. The system associates the Advanced Condition with the selected report
and saves the scheduling information; the Advanced Condition Library page
appears. The icon displayed in the Report column indicates that the Value Set is
associated with a report.

P L

Refer to the Associated Library and Query Library sections in the Library chapter, to
view the steps on how to disassociate reports in those libraries.

Executing an Advanced Condition
Use the following procedure to execute an Advanced Condition:
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1. Select an Advanced Condition from the list in the Advanced Condition Library
page.

2. Click Execute. The system executes the Advanced Condition; the Active Case
Series page appears.
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3. If areportis associated with the saved Advanced Condition, click on Execute
button. The Active Case Series page and Pre Filter page of the associated report is
displayed.

4. Enter the prompts value in the Pre Filter page.
5. Click on the Execute button to generate the report.

After generating the Case Series, you can manually modify it or save it. See the Case
Series chapter for more information on working with Case Series.

Executing a Saved Advanced Condition on the Active Case Series

Just as the system assigns the Active status to an Advanced Condition when you save
modifications to it or execute it, the last saved or generated Case Series becomes the
Active Case Series.

Use the following procedure to narrow down the list of cases in the Active Case Series,
you may want to run an Advanced Condition on an Active Case Series.

1. Generate the Case Series on which you wish to run another Value Set:

= You can generate the Case Series by either using QBE, Filters, or Advanced
Conditions. This Case Series automatically becomes the Active Case Series and
remains so until you execute another query to generate a different Case Series.

= Alternatively, if the Case Series on which you wish to run another Value Set is
already saved in the system, select Query Results > Case Series > Case Series
Library. In the Case Series Library page that appears, select the Case Series
title and click Make Active.

2. Select Create Query > Advanced Conditions > Library. The Advanced Condition
Library page appears.

3. Select the Advanced Condition you want to run on the Active Case Series you
generated in step 1.

4. Check the Limit Query to Active Case Series checkbox.
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Library

5. Click Execute. The system runs the selected Advanced Condition on the Active
Case Series and displays the Active Case Series page. Note that the Case Series
you just generated becomes the Active Case Series.

Argus Insight provides a library that serves as a repository for all queries. This library
comprises all the query searches performed for QBE, Filters, and Advanced
Conditions. In addition, the Associated Library feature enables you to search for those
queries, which have a report associated with them.

Go to Create Query>Library to view the components of the Library menu.

ORACLE' |ARGUS INSIGHT™

I Home Create Query I Query Results I Case Series Reports
Create Query = Library | Clusry by Example

ASSOCIATED REPOR Fite™s
Advanced Conditions

Library Azsociated Reports Library
Choose Report Query Library

This chapter discusses the following components that comprise the Library menu in
Argus Insight:

= Associated Reports Library
s Query Library

Note: To use LDAP configuration in Argus Insight, your Cognos
administrator must configure LDAP on the Cognos Server.

Associated Reports Library

The Associated Library feature enables you to view all the reports associated with a
query.

1. Open Create Query>Library>Associated Reports Library to view a list of all the
reports that are associated with a query.

The following screen is displayed:
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The following table describes the columns in this page:

Column Description

Name Displays the name of the query that is associated with the
report.

Description Displays the description of the query associated with the
report.

Last Modified Displays the date when the query was last modified.

Query Type Displays the type of query associated with the report.

User Full Name Displays the name of the author of the query.

Category Displays the category where the query is saved.

Report Name Displays the name of the report associated with the query.

Limit Query to Enables you to limit the query to the active case series.

Active Case Series

Modifying a Query in the Associated Reports Library
Use the following procedure to modify a query in the associated library:

1. Select the query from the list in the Associated Reports Library page.
2. Click Modify.
This displays the Scheduled Reports Group page.

Drapiaying rows (170 =

Total Number Of Rows (2)

Fage sre

Name .. Last Run Time

Created By Modified By
Description Next Run Time Created Date Modified Date ~T e =
Additional Reports N/A jehns johns 3
Contains added reports 12-JUL-2010 10-JUL-2010 10-JUL-20110
New Reports N/A jehns johns 1
Collection of New Reports NIA 10-JUL-2010 10-JUL-2010
| tiew| [togify| [belete || |[cCiese

3. Select any report group and click Modify button.

4. Make the necessary modifications and click OK.

5. Click Execute to execute a report. The Execute button is available only if a group
has just one report in it.

Deleting a Query in the Associated Reports Library

Use the following procedure to delete a query from the associated library.

1. Select the query from the list in the Associated Reports Library page.

2. C(lick Delete.
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3. The Delete Confirmation dialog appears.

4. Click OK.

Disassociating a Report in the Associated Reports Library

Use the following procedure to disassociate a report from the associated report library:
1. Select the report from the list in the Associated Reports Library page.

2. Click Disassociate.

3. The Disassociate Report dialog appears.

4. Click OK.

Query Library

The Query Library feature enables you to view all the queries. Select Create
Query>Library>Query Library to view a list of all the queries.

The following screen is displayed:

ORACLE |A NFIL [PEPTPSSTESITIY e e |
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The following table lists the descriptions of the columns in this page:

Column Description

Name Displays the name of the query.

Description Displays the description of the query.

Last Modified Displays the date when the query was last modified.
Query Type Displays the type of query.

User Full Name Displays the name of the author of the query.

Category Displays the category where the query is saved.

Report Name Displays the name of the report associated with the query.
Limit Query to Enables you to limit the query to the active case series.

Active Case Series

Associating a Query in the Query Library
Use the following procedure to modify a query in the query library:

1. Select the query from the list in the Query Library page.
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2. Click Associate.

This displays the Scheduled Reports Group page.

Total Number 01 Rows (2 s Page size =]

Last Run Time Created By Modified By
Next Run Time: Created Date Modified Date ~DE IS

HiA johns johns >
12-JUL-2010 10-JuL-2010 10-JUL-2010
New Reports A Johns 7
Collection of New Reports NiA 10-JUL-2010 10-JUL-2010
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3. Select any report group and click Modify.

4. Make the necessary modifications and click OK.

5. Click Execute to execute a report. The Execute button will be available only if a
group has just 1 report in it.

Deleting a Query in the Query Library

Use the following procedure to delete a query from the query library:

1. Select the query from the list in the Query Library page.

2. Click Delete.

3. The Delete Confirmation dialog appears.

4. Click OK.

Disassociating a Report in the Query Library

Use the following procedure to disassociate a report from the query library:

1. Select the report from the list in the Query Library page.

2. Click Disassociate.

3. The Disassociate Report dialog appears.

4. Click OK.
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Working with Case Series

Working with Case Series

When you execute a QBE, Filter, or an Advanced Condition, Argus Insight generates a
list of cases that match the querying criteria. This list of cases is called a Case Series.
The Case Series output is displayed in a listing format in the Active Case Series page.

The Case Series is the communication foundation between all modules of Argus
Insight. All the predefined reports you generate in Argus Insight are run on the Case
Series. This means that the report output contains information from only those cases
that are part of the Case Series.

In addition to letting you generate a Case Series by using a query, Argus Insight
enables you to:

= Save the Case Series with a name and description for future reference.

»  Search the saved Case Series by their name, description, category, source, date of
modification, and author.

= Assign group level access permissions on the Case Series.
= Combine two Case Series through Union, Intersect, or Minus set operators.
= Import a Case Series from external sources such as TXT, XLS, or CSV files.

»  Manually modify the Case Series after it has been generated.
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Note: The Case Series might become obsolete each time the datamart
is refreshed by running an ETL. This is because new cases with similar
attributes might get added to the datamart.

General Usage Information

Before working with Case Series, you should be aware of information about the
following:

»  Case Series Hyperlink to Medical Review

s Freezing Case Series Data

Case Series Hyperlink to Medical Review
Be aware of the following;:

= The case series dialog enables the user to open the Medical Review dialog in Read
Only mode from the Active case Series dialog.

= All of the reports that can be executed from Medical Review are available to the
user.

= Even if a Single Sign On user has no protection in Argus Safety and Blinded
Protection is applied in Argus Insight, the user can still view the Medical Review
screen. The Medical Review screen can display all the products of the Blinded
security-enabled case.

»  If the user does not have access to the case from an Argus Safety perspective, the
system presents the following message:

" <user> does not have access to the case in Argus Safety”.

»  If the case the user is trying to access has been deleted since the last ETL, the
system presents the following message:

"This case has been deleted in Argus Safety since the last ETL”.

»  If the user has logged into Insight without logging through Argus, the system
presents the following message:

"<user> is not logged into Argus.”

Freezing Case Series Data

Business Context
Once the alerts are configured, customers are interested in analyzing the case series
that is generated by the alert. The system does the following as part of the analysis:

»  Freezes the Case Series data that needs to be analyzed

= Displays case details using either the standard reports or the CIOMS II line listing
(available in Insight) after the regular queries, case series, and their subsets are
completed.

Feature Details
Be aware of the following:

s The system allows the use to freeze a case series as follows:
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— The user can freeze a custom case series when editing the case series from the
Case Series Library page.

— The user can freeze any system-generated case series (active or inactive) (e.g.,
Using Insight queries, filters and advanced conditions) by clicking the "Freeze
and Save" button.

The system freezes the case series and presents the user with the standard
Case Series Save dialog. The user must enter the name of the saved case series.
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»  If the user has not yet saved the case series from the active case series screen and
clicks the Freeze and Save button, the system saves only one copy of the frozen
case in the library. The frozen case series should then be the active case series.

= In the Case Series Library the User can view a frozen case series by clicking the
icon next to the case number.

Hovering over this icon shows the Date the user froze the case series.

»  The system enables the user to freeze existing cases in the case series by clicking
the "Freeze Case Series button."

—  When the user clicks this button, the system prompts the user to provide and
additional name for the frozen case series.

—  The Frozen Case Series has icon beside case number to identify it as frozen.

= When the user clicks "Un-freeze Case Series," the system removes the icon beside
the case number and fetches the latest information for the cases.
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-  The user must provide a justification when unfreezing a case series.
—  The user adds the justification to the Case Series Criteria.

*  The user types a new justification when the case series is unfrozen or can
user a pre-configured justification.

Un-freeze Case Series

@ Are you sure you want to un-freeze this case series?

User Name : johns

Date: 11-JUL-2010

Justification: |Unfreszing Required |ﬂ

|| cancel |

* A list maintenance item, "Case Series Un-freezing Justification," enables
the user to configure justifications for use when unfreezing a case series.

*  The Add, Modify and Delete functionality is the same as that of the Case
Series Modification Justification UL

— The administrator can configure the freeze case series function so that it
reflects Insight security settings

—  The user has the option of freezing and unfreezing case series by clicking the
appropriate check boxes on the Access Right tab.

— The user cannot insert cases into a frozen case series.
— The user can delete cases from the frozen case series.

—  When an Advanced Condition or query is run against a frozen case series,
frozen data is used.

— By default, the Report Writer displays all the versions (both frozen and
current) for a case.

*  Use the "Display Latest Data" filter if the report needs to contain only the
current case version.
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*  If user selects the Active Case Series filter, then report contains only the
Frozen case data if active case series is frozen otherwise the report
contains the current case version if the active case series is a normal case
series.

— The frozen case series data is available after reinitializing the ETL.

— Reports run on frozen case series data, show the following next to the case
series name:

"The data in this report was frozen as of <particular date and time>".
Time is the database system time with the GMT offset.

= Reports run on normal case series data, show the follow message next to the case
series name: should

m "The case series was last modified on <Case series modification date and time>".

= List Maintenance items are not frozen. Therefore, some reports will have a
mismatch of LM Items and the frozen case series data.

s The derivation rules operate against current case data if the LM Rules are being
modified. The frozen case series are shown if there is a change in the case data
resulting from the derivation rules.

s If suppress condition is checked in the derivation rule, then LM records related to
the derivation rule will not be deleted in cases used in the frozen case data table.

s The hyperlink for the medical review access, links to the latest data for the case.
»n  Frozen case series are not available to Perceptive.
= Frozen case series cannot be shared with Argus Safety.

s The following portions of the Argus Insight application do not all case data to be
frozen:

- Dashboard

— Copy Configuration Utility

- BOand CO standard cubes

- Standard Cubes Drill Through reports
- Report scheduling

— Derivation Rules

Working with the Last Generated Case Series

This section provides information for working with the last generate case series and
includes discussions of the following:

= Saving a Case Series

= Viewing Case Series Generation Criteria within the Query Interface
= Modifying the Case Series

s Deleting a Case from a Case Series

The system assigns the Active status to a Case Series that you generated last by
executing a query. Only one Case Series can remain active at a time. Unless you
generate another Case Series or save modifications to one, the last Case Series you
generated remains active.
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Note: You can also make a Case Series active by manually assigning
it the Active status. This option works only for Case Series you have
saved to the system. See theMaking a Case Series Active topic for
details.

To view an Active Case Series, select Query Results > Case Series > Active. The
Active Case Series page displays the Case Series you executed, modified, or manually
made active last.
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In the Active Case Series page, the Active Query Name label displays the name of the
saved query (QBE, Filter, or Advanced Condition) that generated the Case Series. If the
query was not saved, the label displays the text <Not Saved>.

The Active Case Series label displays the text <Not Saved> until you save the Case
Series by a name. Similarly, the Name label displays the text <Not Saved> until you
save the Case Series by a name.

If the active Case Series has more than 50 cases, they are displayed in multiple pages.
Use the arrows in the button group to navigate the Case Series pages.

The column headers in the Case Series grid can also be sorted, as shown by the circled
icons in the following image.
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You can sort the column data by clicking on the arrows displayed in the image. The
sorted grid retains its sorting and filtering order even after being exported to Excel. To
filter for any column, such as the Seriousness Criteria column, enter the filtering
criteria in the textbox under the column header. The grid also supports context menus.

Working with Case Series 5-6



Working with Case Series

Saving the Case Series

If you have not saved the active Case Series to the system yet, click either the Save or
SaveAs buttons to save the Case Series to the system by assigning a name to it. You
need to enter the Case Series description in the Description text box before saving the
Case Series.

If you are modifying a Case Series that is already saved, click the Save button to save
the modification or click Save As to save the Case Series by another name.

Viewing Case Series Generation Criteria within the Query Interface

Click the View Query button to the see the querying criteria in the query tool interface
(QBE form, Values Set page, or Advanced Condition Editor) that was used to generate
the Case Series.

This button is only available for an Active Case Series that is not saved to the system.

If you have saved your Active Case Series, then refer to the section onViewing the
Case Series Generation Criteria in a Single Page

Setting Access Permissions

You can set group-level access permissions for the Case Series. This determines which
user groups will be able to view, modify, or delete a Case Series.

Note: You can set permissions only on Case Series you have saved to
the system.

Use the following procedure to set Case Series permissions.

1. Inthe Active Case Series page, click the Permissions button. The Permissions
dialog box appears. A list in this dialog box displays the names of all the groups
(except the Administrator group) that the system administrator has created.

Permiszions for OBE: New QBE
Legend
Blinded No Access ¥ R = Read
UnBlinded No Access hd W= "Write
D = Delete
P = Object
Permizsion
No Access
[ ok || cancel |

2. You can set permissions only on Case Series you have saved to the system.

Use the list box next to a group name to assign permissions to the group members
on the Case Series you have generated. You can select from these options:
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Permission Description

No Access (Default)  No group members will be able to access the Case Series

R Group members will only be able to view the Case Series

R/W Group members will be able to view and modify the Case Series

R/W/D Group members will be able to view, modify, and delete the Case Series
R/W/D/P Group members will be able to view, modify, delete, and assign permission on

the Case Series

Note: The author of the Case Series always has the highest level of
permission (R/W/D/P). For example, you belong to the Data Entry
group and you assign the No Access permission level to the Data
Entry group on a Case Series that you generate. In this case, while you
will continue to have the highest level of permission on your Case
Series, other members in your group will not be able to access your
Case Series.

3. Click OK. The system saves the permission settings.

Viewing the Case Series Generation Criteria in a Single Page
Use the following procedure to view the case series generation criteria.

1. Click the View Query Criteria button to view the Case Series Generation criteria
in a statement format within a dialog box.

e | Argus Insight - Query Criteria -- Webpage Dialog, @

Query Criteria

Drugs in Study ( Includes Comparators ) is in ("10007538")

| Close |

Modifying the Case Series

If required, you can modify the Case series by deleting or adding cases manually. Use
the following procedure to add a case to the Case Series:

1. Click the icon on the left bar in the Active Case Series page. The Add Case to Case
Series dialog box appears.
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& Add Case to Case Series -- Webpage Dialog,

2.

Add Case to Case Series

Case Humber:
(i1 |
' Justification:

[ L]

[ ok || cancel |

In the Case Number text box, type the case number you want to add to the Case
Series.

Use the Justification list box to specify a justification for modifying the Case
Series.

Note: You can also type your own justification text for modifying the
case series.

Click OK. If the Case number you specified exists in the datamart, the system adds
the case to the Case Series and save the changes. If the Case number you specified
does not exist in the datamart, a message appears. Click OK to continue.

Insert Case Number

E CaseNumber: 124464
Case Number Does Not Exist

Click Save As to save the modified Case Series by another name. Note that if you
have not yet saved the Case Series to the system, clicking either the Save or Save
As buttons will prompt you to save the Case Series to the system by assigning a
name to it.

Deleting a Case from a Case Series
Use the following procedure to delete a case from the Case Series.

1.
2

In the Active Case Series page, select the case you want to delete.

Click the icon on the left bar in the Active Case Series page. The Delete Case
Number dialog box appears.

Working with Case Series 5-9



Working with Case Series

e | Argus Insight - Delete - Case Number, -- Webpage Dialog |z|

Delete - Case Humber

Are you sure you want to remove this case from the Case
Series:

Case NHumber : USER4_BC_000004
User Name : johns
Date: 11-JUL-2010

Justification: |ﬁ

| Cancel |

3. Use the Justification list box to specify a justification for deleting the case.

4. Click OK. The system deletes the case from the Case Series and save the changes.

Working with Saved Case Series

The Case Series Library page lists all of the Case Series saved to the system. Select
Query Results > Case Series > Library to access the Case Series Library page.
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The Case Series Library page displays a list of the saved Case Series in a grid format.
The descriptions of the grid columns follow.

Column Description

Name Displays the name of the Case Series

Description Displays the Case Series description

Last Modified Displays the date when the Case Series was last modified
User Full Name Displays the name of the user who generated the Case Series
Category Displays the category assigned to the Case Series

Source Displays the source of the Case Series as:

= Internal - generated by using Argus Insight querying tools are called
Internal

= External - imported into Argus Insight from sources, such as TXT, CSV,
or XLS files
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Column Description

Cases Displays the number of cases in the Case Series

Searching for a Saved Case Series
Use the following procedure to search for a saved Case Series.

1. Specify the search criteria, as appropriate:

»  To search for a Case Series by its name, type the Case Series name in the Name
text box.

» To search for a Case Series by its description, type the first few words of the
description in the Description text box. The system searches for the specified
search string in all Case Series descriptions.

»  To search for a Case Series by its date of modification, enter the modification
date in the first Last Modified date field. You can also specify a date range by
typing the start and end dates in the first and second date fields, respectively.

= To search for a Case Series by its author, select the author name from the User
Full Name list box.

» To search for a Case Series by its category, select the category from the
Category list box.

2. Click Search. Based on your search criteria, the system displays the search result in
a list.

3. You can sort the search result list by clicking the sort icon next to the column
headers in the list.

4. To clear the search result and display all the saved Case Series in the list, click the
Clear button.

Making a Case Series Active
Use the following procedure to make a case series active.

1. In the Case Series Library page, select the Case Series you want to make Active.

2. Click Make Active. The Active Case Series label in the upper-right corner of the
Case Series Library page displays the name of the Case Series you made Active.

Modifying a Case Series

You may want to modify an existing Case Series by adding cases to it or deleting
existing cases. You can also change the group-level access permissions on the Case
Series.

Use the following procedure to modify a Case Series.
1. In the Case Series Library page, select the Case Series you want to modify.

2. Click Modify. The Case Series is displayed in the Active Case Series page. See the
Working with the Last Generated Case Series for detailed information about
making modifications to the Case Series and setting permission.
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Merging Case Series

Argus Insight allows creating a new Case Series by merging two Case Series through a
Set operator. The Set operator you select works on the Case numbers. The case
numbers included in the merged Case Series depend on the type of Set operator you
use:

s Union - creates a new Case Series that consists of all the cases in both Case Series;
common case numbers are included, and are listed only once

= Intersect - creates a new Case Series that consists of only those case numbers that
exist in both Case Series

= Minus - creates a new Case Series that contains only those case numbers that are
present in the first Case Series, but are not present in the second Case Series.

Use the following procedure to generate a merged Case Series:

1. In the Case Series Library page, click Merge. The Case Series Merge page appears.
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2. Select the two Case Series you wish to merge.
3. Select the first Case Series from the Case Series # 1 list.

4. Select the second Case Series from the Case Series # 2 list.
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5. From the Action list, select the Set operator you wish to use to merge the two
selected Case Series you selected. The two Case Series and the operator are
selected.
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6. Click Merge. The system merges the selected Case Series and displays the
resultant Case Series in the Active Case Series page.
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Importing a Case Series from an External Source

Use the following procedure to import a Case Series from anexternal sources, such as
TXT or CSV, into Argus Insight.

1. In the Case Series Library page, click Import. The Select File for Import dialog
box appears.
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Select File For Import

Query Criteria:
| i | |Imported from File:

File:
| || Browse...

D First row contains column header(s)?

QK Cancel

2. Click Browse to locate the external Case Series source file. Alternatively, type the
file name with complete system path. Each case number in the file must be on a
new line.

3. If the first row in your TXT or CSV is the column-header row, check the First row
contains column header(s) checkbox.

4. Click OK.
5. The Import Case Series dialog box displays the status of the import operation.

Note: You can view the import operation log by clicking the View
Log button.

6. Click OK to view the imported Case Series in the Active Case Series page.

Deleting a Case Series
Use the following procedure to delete an existing Case Series.

1. Inthe Case Series Library page, select the Case Series you wish to delete.

2. Click Delete. A confirmation dialog box appears.

b | Argus Insight - Delete - Case Series -- Webpage ... rz|

Delete - Case Series

Are you sure you want to delete:
New Series

3. Click OK. The system deletes the selected Case Series; the Case Series Library
page appears.

Viewing the Details of the Query that Generated the Case Series

Use the following procedure to view the details of the query that generated a Case
Series:.
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1. Inthe Case Series Library page, select a Case Series.

2. Click Query Criteria. The Query Criteria dialog box displays the criteria.

e | Argus Insight - Query Criteria -- Webpage Dialog,

Query Criteria

Drugs in Study ( Includes Comparators ) is in ("10007538")

Close

Note: For a saved Case Series, the system displays the query details
only in an SQL-statement format within the Query Criteria dialog
box. However, for an Active Case Series that is not yet saved to the
system, you can view the query details within the query tool interface
(QBEform, Values Set page, or Advanced Condition Editor) as well as
in the SQL-statement format.

Sharing Case Series with Argus Safety Web

The system enables you to share cases between Argus Safety Web and Argus Insight
using Query Results > Make Active from Argus.
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Use the following procedure to share cases between Argus Insight and Argus Safety
Web.
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1. Login to Argus Insight with your user id and password.

Note: You need a common user id and password for Argus Safety
Web and Argus Insight to enable case sharing between the two
applications.

An error message stating "Your user id is not present in Argus"
appears if you do not have a valid user id in Argus Safety Web

2. Select Query Results > Case Series > Make Active From Argus to view the Active
Cases in the Argus Safety Web application. The Active Case Series of Argus
appear on the screen. The Active Case Series present in Argus are now the active
case series in Argus Insight.

Note: If there are no cases present in the active series of Argus, an
error message appears indicating the same.

3. Save the case series using the Save or Save As feature.

Exporting Case Series to Excel

Use the following procedure to export a case series to an Excel file.

1. Create a new query from Query By Example, Filter or an Advanced Condition, or
open a saved query from the Library of Query By Example, Filter or an Advanced
Condition.

2. Click Execute to open the Case Series page with the list of cases.
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3. Now, click Export to Excel at the lower right end of the web page.

A dialog box displays for saving or opening an excel file.
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File Download X

Do you want to open or save this file?

@ Mame: 1506,39.xls
HL

Type: Microsoft Excel Worksheet, 5,50 KB
From: aiwebbo

Open I[ Save ][ Cancel ]

Always azk before opening this type of file

harm your computer. [f you do not trust the source, do not open or

@ Wwhile files from the Internet can be ugeful, some files can patentially
zave this file. ‘What's the risk?

4. Click Open to open the excel file and view the Case Series results in excel. Click
Save to save the excel file in your system for future reference.

In the excel file you can see the case Series results in Case Series tab and Case
Series details, i.e., Name, Case Count, Description and Criteria in Case Series

Details tab.
A [ ] © D E F G Al
1 |Case Number [IReport Type |Primary Company Product [Primary Event |Serti Criteria | [Outcome
2 |[2003DEDODO03  |SPT Cure All_MKT Insormnia Non-Serious Unknown
3 |(2002DEO000DS  [SPT Cure All_MKT Insomnia Non-Serious Unknown
4 |1998DEO0DO37 |STR Wonder Drug_MKT Arthralgia IR
5 |1998DEOD0020 |RAT Wonder Drug_MKT Arthralgia IR
B
7|
| 8 |
IER
| 10 |
|11 |
112]
113 |
|14 |
115 |
|16 |
17 |
|18 |
ﬁ‘ ___
120
L=l v
i« 4 v w)\Case Series { Case Series Detals / < =]
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Generating Standard Reports

General Report Usage Information

Argus Insight provides built-in Standard Reports which can be run on Active Case
Series to analyze your company's safety, workflow, and product data.

Although Standard Reports are predefined reports, you can define pre-filters before
generating a Standard Report to have the report output display information only about
specific type of cases. Pre-filters let you narrow down the Case Series further so that
the system runs the report only on those cases that confirm to the pre-filter criteria. For
example, your Case Series might consist of cases that were reported in all the countries
for a particular product.

However, you may only wish to see information about those cases in your report that
were reported in the United States. In this case, you can specify a pre-filter to have the
system display only those cases in the report output that were reported in the United
States.

Note: Since a Case Series might become obsolete each time the
datamart is refreshed by running an ETL, you may need to generate
the Case Series again before generating a Standard Report.

Alternatively, you can directly associate aquery (QBE, Filter, or
Advanced Condition) to a Standard Report to avoid manual
generation of Case Series. See the Associating a QBE with a Report,
Associating a Value Set with a Report, and Associating an Advanced
Condition with a Report topics for details.

Before using Argus Insight to generate the Standard Reports, configure the browser as
defined in the Argus Insight Installation Guide.

Using Reports

Before generating reports, you should be aware of information regarding the
following:

= Event Level Reporting
= Report Scheduling
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Executing Reports

Use the following procedure to access the Reports page for any category. For instance,
if you select Compliance Reports, execute the following steps:

1. Select the Case Series Reports > Standard Reports >Compliance. The Standard
Reports page displays a list of all the standard Compliance reports. The
description of a report is displayed next to its name.

2. Select the report that you want to generate.

3. Select the Limit to Active Case Series checkbox to generate the report on the
Active Case Series.

Note: Select the Limit to Active Case Series checkbox before
generating the report. This prevents the report from querying the
entire datamart and slowing down the report output generation. Use
the following procedure to view the Active Case Series, select Query
Results > Case Series > Active in Argus Insight. If you want to make
another Case Series active, select Query Results > Case Series >
Library in Argus Insight. In the Case Series Library page that
appears, check the Case Series you want to make active and click
Make Active.

4. Click Execute to generate the report. A new browser window displays the
pre-filter options in the Report Filter page. The following pre-filter elements may
be available depending on the type of information the report displays.
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List box - this element lets you filter the report output by specifying a single
value from the list; for example, the country of incidence, a regulatory
authority, or a pre-defined date range. List boxes may also contain options for
grouping the report output; for example, grouping by age group or product
name

Multiple selection lists - this element lets you filter the report output by
multiple values you select from the list; for example, license countries or
report types.

Note: If Allis selected along with other entities for a category, then
all the items under that category are searched.

Text boxes - this element lets you filter the report output by specifying a
numerical value for timelines or dates for date ranges. All the report pre-filter
pages contain a text box for specifying a sub-title for the report

The Pre-filter page can display values in Prompts. By default, prompts on the
Pre-filter page display values from LM tables.

By default, a checkbox called Limit Prompts Values to Active Case Series is
displayed on the Pre-filter page. You can check this checkbox to generate
pre-filter prompts and view values limited to the cases in the case series. This
impacts only those prompts which are populated from case tables and
corresponding LM tables exist for that prompt.

Custom prompts created by the user for ad-hoc reporting do not have the
option of displaying values in prompts from LM tables. Custom prompts
always display data as per the conditions (SQL) that were defined during the
creation of the prompts.

Specify the pre-filter options, as appropriate.

Select the PDF or Excel option button to specify the report output format.

Click Execute in the Report Filter page. The system generates the report output
and displays it in the selected format. You can print this report or save it to the
system drive, if required.

Close the new browser window to return to the Standard Reports page.
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Event-Level Reporting

Currently, Insight Reports are focused on cases. This permits event level report in
Insight Report output.

Feature Details

Extended reporting in the standard reports enables the user to produce event-level
reports. To produce an event-level report, the user must click the "Limit to events
within Query Criteria" checkbox shown in the following illustration.
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»  The event group information is populated from the Event Groups configured in
the Perceptive application.

s The user can select multiple Event Groups.

»  If the user selects the Event groups, the system limits the output to only the Events
selected in the Event Group definition.

»  If the user clicks "Limit to Events within the Query Criteria," the system limits
report output to the Events chosen in the report output query criteria.

— This applies to all queries executed from QBE, Filters, or Advanced Conditions

— This applies for Event Terms for the entire hierarchy (i.e., SOC, HLGT, HLT,
PT, LLT for the MedDRA Coded events only).

—  This cannot be executed with hard-coded SQL queries.
—  This feature cannot be used with a case series from Safety.
—  This feature cannot be used with an imported case series.

»  If the user uses a power query to generate a case series, the following terms are
respected as the event query in the reports:

— From QBE - Events tab - Event Coding
*  System Organ Class (SOC)
*  High Level Group Term
*  High Level Term
*  Preferred Term

*  Lower Level Term
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—  From Filters - Event Information
*  Event Term -
i. SOC
ii. HLGT
iii. HLT
iv. PT
v. LLT
*  Preferred Term
— From Advanced Conditions -
*  EVENTS:Event Information Event Body System Code
*  EVENTS:Event Information System Organ Class (SOC)
*  EVENTS:Event Information Event High Level Group Term Code
*  EVENTS:Event Information High Level Group Term
*  EVENTS:Event Information Event High Level Term Code
*  EVENTS:Event Information High Level Term
*  EVENTS:Event Information Preferred Term
*  EVENTS:Event Information Preferred Term Code
*  EVENTS:Event Information Event Low Level Term
*  EVENTS:Event Information Lower Level Term
*  EVENTS:Event Information Event Included Term Code
*  EVENTS:Event Information Event SMQ (Broad)
*  EVENTS:Event Information Event SMQ (Narrow)
*  EVENTS:Primary Event Event SMQ (Broad)
*  EVENTS:Primary Event Event SMQ (Broad)
—  This feature is available in the following reports:
*  Event term frequency listing by HLGT
*  Event term frequency listing by HLT
*  Event term frequency listing by PT
*  Event term frequency listing by SOC

*  AE count tabulation (case causality)

Report Scheduling

Report Scheduling comprises the following;:
s Scheduling Multiple Reports Against a Single Query
= Scheduling a Report without a Query

Scheduling Multiple Reports Against a Single Query
The system enables users to schedule multiple reports in a single query. A set of
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reports run on a weekly or periodic basis can be scheduled with the same report and
run as a package.

On clicking the Associate button from the query library, only one report is selected. If a
different report is chosen for the query, the system prompts the user is to change. The
system permits the user to associate many reports with a single query.

s The user can select any query from any library (QBE/Filters/AC) and click
Associate.

s The user can use the Query Library and the Associated Query Library to schedule
an association.

= Since multiple reports can be associated with a single query on these Query pages,
the Execute button does not open any pre-filters page after generating the case
series.
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When you select a query and click Associate, the Scheduled Report Groups window is
displayed.
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This window includes the following features:

s This window displays information about all the report groups scheduled by the
logged-in user.

= Sorting and Search functionality is available for all columns.
= Pagination is also available.

= Each group can contain one or more reports. "Group" means that all the reports are
scheduled at the same time.
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s This window has the following buttons:

- New: Redirects the user to the Report Scheduling page with blank values. The
system presents the context menu to enable the user to choose Report
Association Only or for Scheduling.

— Modify: Redirects the user to the Report Scheduling page and enables the user
to modify an existing scheduled report group.

— Delete: Deletes a selected scheduled report group.

- Execute: Closes the window and executes the query in parent window to
show case series and launch pre-filter for the selected report on this page. This
button is enabled on if the scheduled report group has a single report.

- Close: Closes the window without any other action.

»  The system opens the Schedule Information page when the user selects
Association Only from the drop-down list.

A Argus Insight -- Webpage Dialog, ]
Reports Scheduling -]
Meme: [ ]

Description: ||
Available Reports (=]
Report Name Description Category Last Modified  Author
Adverse Events Line Listing Report providing selected data from study cases | Case Processing  06-JUL-2010 | Oracle Corporation ]

A summary tabulation that displays & count of even
AE Count Tabulation et Pharmacovigiance 07-JUL-2010  Oracke Corporation
Age Group vs. Gender ;:t::“'*'za relationships betwssn two or more altri |p o iokance | 10-JUL-2010 | Oracle Corporation

L To summarize the event counts by Diagnosis and b -

Aggregate Diagnosis Listing e e Pharmacovigiance 10-JUL-2010  Oracle Corporation
Case Activity History Graph to show the count of incoming and closed & | ooy 10-JUL2010 | Oracle Corporation

ases and an aggregate total of cases in process.
Case Count by Reporter Type Aeport to track the origin o all notifications. General 06JUL-2010  Orace Corporation

<
Selected Reports [ Ada |
Report
rt Hame Delete
P Category
No records to display
[=3 Canoel

s  This the main scheduling page in Insight. On this page, user can select any
number of reports for scheduling.

»  The Reports Scheduling page has four (4) sections as follows:
- Group Information: The user provides the group name and description.
- Schedule Information: The user provides the scheduling frequency.
— Email Information: The user provides e-mail information for the receivers.

— Available Reports: The user selects the reports to schedule. Select any report
and click Add to add the report to Selected reports. The user can select
multiple reports and add them at the same time.
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— Selected Reports: Reports associate with the query (as per the selection by the
user from Available Reports section) are listed in this field.

*  User can remove a selected report by clicking the X button against report's
row in the grid from the Selected Reports section.

*  Sorting and Search functionality is available for all the columns in the
Available Reports Section.

*  Pagination is also available on the Available Reports Section.

— The system does not permit the user to save a schedule without entering the
pre-filter information for each report. The system uses the value in the
Pre-Filters Configured? Column in the Selected Reports section to detect
whether the pre-filter configuration is complete.

- The user can enter pre-filter information by selecting any report in the Selected
Reports section. When the user selects the report, the system loads the
pre-filter information for the report in the sidebar and enables the user to enter
the information.

— Side bar has OK and Cancel buttons

*  OK: Save the pre-filter information for the selected report.

*  Clear: Reset the pre-filter page to blank values after confirming with user.
- The Schedule Information page has the following buttons:

*  OK: Saves the scheduling information to the database and returns to the
Scheduled Report Groups page.

*  Cancel: Returns to the Scheduled Report Groups page without making any
changes.

*  Clear: Resets the Schedule Information page to blank values after
confirming with user
Scheduling a Report without a Query =
Reports can be scheduled without a query from the Associated Library Page.
— This page has a button named "Associate to <All Cases>."
s The user can configure Text All Cases can from the List Maintenance items.

— The system appends configured text to "Associate to <LM Text>". For
example, if we configure All System Cases in the LM item, the text of this
button would be "Associate to All System Cases".

s The default value is All Cases.
s The name of the LM Item is "All Cases Query Name".

= When the user clicks this button, the system opens the Scheduled Report Groups
window and behaves exactly the same way as described in the section, "Multiple
Reports on a Single Query".

s The Associated Reports Library page includes the following features:
- This page is the main status page for all scheduled reports.

— The user can see all reports in different/same groups at the same time. For
example, if a user has two (2) report groups with three (3) reports in each
group, the library has six (6) rows, one for each report association.

—  The Status column displays the current status of the reports association.

Generating Standard Reports  6-8



Standard Reports

- This page has the following buttons:

*  Modify: Enables the user to modify a selected association. This opens the
Scheduled Report Groups page to query of the selected association. The
system highlights the current group of the selected association.

Execute: Executes the selected query to get the case series and opens the
Pre-Filter page for the associated report.

Standard Reports

The Standard Reports page displays a list of all the Standard Reports built into Argus
Insight. Select Case Series Reports > Standard Reports > All to display the Standard
Reports page. This page displays a list of the saved Standard Reports in a grid format.
You can search for specific types of reports by specifying values for any of the columns
as the search criteria and clicking Search.

The descriptions of the grid columns follow.

Column Description

Name Displays the name of the Standard Report

Description Displays the Standard Report description

Last Modified Displays the date when the Standard Report was last modified
Author Displays the name of the Standard Report author

Category Displays the Standard Report Category

Standard Reports are grouped into six categories and can be accessed from the Argus
Insight folder in the Installation CD. The following topics explain the various standard
reports.

= Compliance Reports

= Configuration Reports
= General Reports

=  Management Reports

»  Pharmacovigilance Reports
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Reports - Cover Page

The following image displays the Cover page of the report when it is generated in PDF
format.

Compliance

20-JUL-2010 17:04 GMT+5:20

Destination Report Submission Listing

Start Time of Last ETL Rum:

13-JUL-2010 14:21:46 GMT-8

Case Series Count:
Total No. of Cases in Hitlist 40

Case Series Name:

US 2000 Dose > 1 (The case series was last modified on : 13-JUL-2010 11:43 GMT-07:00)
Case Series Criteria:

Dose is greater than 1" AND

Case Number contains "US' AND
Case Number doss not contain '1885'

Amit Aggarwal Confidential Page 10f 34

The following table describes each component of the cover page shown in the above
image.

Cover Page Component Description

Company logo Placeholder for a configurable logo. The image of the logo can be

(upper-left box) configured in the whitespace.

Report Category The name of the category to which the selected report belongs.

(upper-right box)

Report Execution Report Execution Time (in GMT).

Date (under 'Report

Category’)

Report Title (under  Title of the selected report, such as Serious Adverse Events Report.

the Heading of the

Report)

Report Sub-Title Configurable Sub-title of the selected report. You can enter a

(under "Report Title’) sub-title to further define the report. Example: 01-JAN-1900 to
31-DEC-2007.

Report Filter A selected value from the Report Prompt.

MedDRA Version The MedDRA Version for the selected report.

Start Time of Last Start time of the last successful ETL run (in GMT).
ETL Run
Case Series Count A count of the total number of unique cases in the case series.
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Case Series Name

The name of the saved case series on which the report has been
executed.

Reports that are run on frozen case series data indicate on the report
next to the case series name that "The data in this report was frozen
as of <particular date and time>". Time is the database system time
with the GMT offset.

Reports that are run on normal case series data indicate on the
report next to the case series name that "The case series was last
modified on <Case series modification date and time>".

Case Series Criteria ~ Query criteria to get case series on which the report has been

User Name
(bottom-left)

Confidential
(bottom-centre)

Page x of y
(bottom-right)

Footer logo

executed.

The name of the user who executed the report.
Configurable Confidential text.
Page Number (in Current Page number of Total Pages in the Report

format).

Placeholder for a configurable logo. The image of the logo can be

(bottom-right box) configured in the whitespace. This component may not appear in

every report.

Compliance Reports

The following table describes each Compliance Report.

Report Title

Description

Destination Report
Submission Listing

Global Audit Listing

KPI List Report
Country Group 1

KPI List Report
Country Group 2

KPI Overview Report
Group 1

KPI Overview Report
Group 2

Labeling Detail
Listing by Case
Number

Use this report to view the submission details based on an on-line country.

Use this report to view case information relating to adverse event.

This report is a listing of case information relating to adverse event, listedness,
seriousness, and submission record information for suspect products, used to
support external audit.

Listing of case submission information for submissions in Group 1 countries
(countries with clock starting from first receipt globally) grouped by Agency
(submission destination) to support compliance KPI generation.

Listing of case submission information for submissions in Group 2 countries
(countries with clock starting from receipt in that country, i.e aware date for
domestic cases and generated date for foreign cases) grouped by
Agency(submission destination) to support compliance KPI generation.

Table of submission count, late submission count and overall compliance figures
for submissions in Group 1 countries (countries with clock starting from receipt
globally) grouped by Agency(submission destination) to support compliance
KPI generation.

Table of submission count, late submission count and overall compliance figures
for submissions in Group 2 countries (countries with clock starting from receipt
in that country, i.e aware date for domestic cases and generated date for foreign
cases y) grouped by Agency(submission destination) to support compliance KPI
generation.

Use this report to check for consistency between Labeling and Seriousness
Criteria. The report is a listing of cases with events and their labeledness for the
licenses of selected countries. Only the first company suspect product is
included in the report; however, all events are listed. This report is grouped by
case numbers.
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Report Title Description

Labeling Detail Use this report to check for consistency between Labeling and Seriousness
Listing by Preferred  Criteria. This report is a listing of cases with events and their labeledness for the
Term licenses of the selected countries selected. Only the first company suspect

product is included in the report; however, all events are listed This report is
grouped by Preferred Term.

Labeling Summary  Use this report to verify the consistency of labeling assessment. This report is a
summary tabulation of labeling for events based on the countries selected.

Outstanding Use this report to view a listing of cases for which expedited reports are
Expedited Reportsby outstanding. The listing is grouped by the responsible group.
Responsible Group

Outstanding Report ~ Use this report to view a detailed listing of cases for which report submissions
Submission by are coming up.
Responsible Group

Listing - Detail The listing is grouped by responsible group and again sub-grouped by agency.

The listing is sorted in descending order of due-date.

Outstanding Report  Use this report to view the outstanding report count for each reporting
Submission by destination. Against each destination, the outstanding reported count is further
Responsible Group  broken up in these groups:

Listing - Summary Due in greater than seven days
s  Duein 3-7 Days

= Duein 0-2 days

= DPast the due date
Outstanding Report  Use this report to obtain a detailed listing of upcoming report submissions based

Submissions by on report destinations.
Destination Listing -

Detail

Outstanding Report ~ Use this report to obtain a summary listing of upcoming report submissions
Submissions by based on report destinations (Summary).

Destination Listing -

Summary

Reporting Use this report to obtain a graphical overview of reporting compliance.
Compliance by

Destination (Count)

Reporting Use this report to obtain a graphical overview of compliance expressed in
Compliance by percentages.

Destination

(Percentage)

Reporting Use this report to obtain a graphical overview of compliance grouped by
Compliance by reporting destination.

Grouped Destination

(Count)

Reporting Use this report to obtain a graphical overview of compliance grouped by
Compliance by reporting destination expressed in percentages.

Grouped Destination

(Percentage)

Reporting Use this report to obtain a graphical overview of compliance for a given
compliance by reporting group. This report shows how many reports were assigned to a

Responsible Group  particular reporting group, that were submitted before the due date/ on the due
date/ after the due date.

Reporting Use this report to view a detailed listing of submitted as well as outstanding
Compliance Listing - reports for the selected cases and reporting destinations. The listing is grouped
Detail by destination; subtotals and compliance % are provided for each destination

along with an overall total and total compliance %.
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Report Title

Description

Reporting
Compliance Listing -
Summary

Reports Out of
Compliance Listing -
Detail

Reports Out of
Compliance Listing -
Summary

Reports Out of
Compliance with

Use this report to view a summary listing of submitted as well as outstanding
reports for the selected cases and reporting destinations. The listing is grouped
by destination; subtotals are provided for each destination along with
compliance percentage.

Use this report to view a detailed listing of all reports that were past the due
date for the selected cases and reporting destinations. The listing is grouped by
reporting destination; subtotals are provided for each destination apart from the
overall total.

Use this report to view a summary listing of all reports that were past the due
date for specific destinations. The listing is grouped by reporting destination;
subtotals are provided for each destination apart from the overall total.

Use this report to view a listing of late reports along with the details of the
workflow states where they exceeded the maximum allotted time.

Delayed Workflow
Detail

Configuration Reports

The following table describes each Configuration Report.

Report Title

ETL Log Argus to Staging
Incremental

ETL Log Staging to Mart
Incremental

ETL Log Summary

Listing of Licenses by Family and
Product

Listing of Product by Family and
Licenses

StudyConfiguration
Workflow Configuration by State

Workflow Configuration by
Transition

Reporting Rules Configuration

Description

Displays the ETL Log for the latest Argus to Staging ETL Incremental
Process.

Displays the ETL Log for the latest Staging to Data Mart ETL Incremental
Process.

Displays the ETL Summary for all the ETL Processes.

Obtain an overview of defined licenses grouped by families.
Obtain an overview of defined products grouped by families.

Obtain a listing of configured Studies.

Obtain a listing grouping the workflow states listing the incoming and
outgoing states.

Obtain a listing of the configured transitions sorted by From and Use the
following procedure to states.

Obtain a listing of configured Reporting Rules.

General Reports

The following table describes each General Report.

Report Title Description

Audit Review Listing This report provides a listing of case information in tabular format relating to
adverse event, listedness, seriousness for Novartis suspect products, used to
support internal audit.

Case Count By This is a report for tracking the origin of all notifications.

Reporter Type

Case Narrative
Listing -English

This report is a narrative overview list of all cases per drug per report type with
international and local narratives
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Report Title Description

Case Narrative This report is a narrative overview list of all the cases per drug per report type with
Listing -Multilingual international and local narratives

Case Origin Listing This report is a listing to track the origin of all case notifications.

CIOMS II Line This report prints the standard CIOMS II Listing report for all cases of the case
Listing series.

CIOMS Report This report prints the standard CIOMS I report for all cases of the case series.
Clinical Medical This report provides a listing of serious clinical trial events grouped by study ID.

Review List

Detailed Line Listing This report is a listing of case details (suspect drugs, concom drugs, events,

by Case Number outcome, indication, narrative, demographics, relevant history) grouped by study
number, center number, patient number and sorted by case number. Used to
support data reconciliation process.

Detailed Line Listing This report is a listing of case details (suspect drugs, concom drugs, events,

by SOC outcome, indication, narrative, demographics, relevant history) grouped by SOC
and sorted by SOC to support medical review, analysis and documentation. This
listing is used widely and often provided to internal and external customers.

Downgraded Reports This report obtains a listing of downgraded reports.
Listing

Literature Listing This report provides an overview including case number with literature reference
and case details.

Lot Number Listing - Use the following procedure to investigate a correlation of events for a certain lot
Detail number (Listing).

Lot Number Listing - Use the following procedure to investigate a correlation of events for a certain lot
Summary number (Summary).

MSE Review List For This report lists the basic case information(events, suspect drugs) - grouped by
Non Serious SR MSE (based on MSE-Drug responsibility configuration) to assist MSE in weekly
review of non-serious SR and unrelated CT cases

MSE Review List for  This report lists the basic case information(events, suspect drugs) - grouped by
Unrelated CT MSE (based on MSE-Drug responsibility configuration) to assist MSE in weekly
review of non-serious SR and unrelated CT cases

Relevant Medical This report is a listing of all relevant histories for the selected cases.

History listing

SAE Clinical Trial This report is a listing of case concomitant medication details - sorted by case
Co-Medication number. Used to assist medical investigation.

SAE Clinical Trial This report is a listing of case details(events, demographics, study details, treatment
Detail Listing details) - sorted by case number. Used to assist medical investigation.

SAE Clinical Trial This report is a listing of case laboratory tests - sorted by case number. Used to
Laboratory Test assist medical investigation

SAE Clinical Trial This report is a listing of case current conditions, family history, past medical

Medical Conditions  history - sorted by case number. Used to assist medical investigation.

SAE Clinical Trial This report is a listing of case narratives and study details - grouped by protocol

Narratives number and sorted by case number. Used to assist medical investigation.

SAE Clinical Trial This report is in tabular data of number of distinct cases and receipt date range,

Project Overview create date range flags - grouped by protocol number, study number, report type.

Simple Line Listing  This report is a listing of key case information - grouped and sorted by case number

by Case Number to provide high level overview and quick review.

Simple Line Listing This report is a listing of key case information - grouped and sorted by SOC of

by SOC primary event, drug, and case number to provide high level overview and quick
review.
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Report Title Description

Study Reconciliation ~ This report provides a data-set to enable reconciliation between Argus and the
Report company clinical database.

US FDA MedWatch  Prints the standard US FDA MedWatch 3500A report for all cases of the case series.
3500A

Management Reports

The following table describes each Management Report.

Report Title Description

Case Load History by Listing of the number of pending cases for given workflow states by Day
Day

Case Load History by Listing of the number of pending cases for given workflow states by Month
Month

Case Load History by Listing of the number of pending cases for given workflow states by
Quarter Quarter

Case Load History by Listing of the number of pending cases for given workflow states by Week

Week

Case Load History By Listing of the number of pending cases for given workflow states by year
Year

Case Processing Obtain a listing of processing time per case and workflow state including
Times Listing the time to lock and closure of case.

Case Routing History Detailed listing of all states a case has been routed to.

Case Seriousness Obtain a listing of cases by seriousness grouped by country of origin.
Distribution

Case Seriousness Obtain a graphical representation of cases by seriousness grouped by
Distribution country of origin.

Graphical Summary

Case Versions Obtain a summary tabulation of follow-ups processed.

Processed

Case Volume by Listing to show the volume of cases that were received over a certain time
Reporter Type period. Used to pick out trends in reporting sources.

Case Volume History Use the following procedure to obtain an overview of case volume by

- Initial and specified time period and broken down by initial vs. follow-up reports.
Significant

Follow-ups

Case Volume History Use the following procedure to obtain an overview of case volume by

- Product - All specified time period and broken down by key indicators (Product - All
Company Suspect Company Products)

Products

Case Volume History Use the following procedure to obtain an overview of case volume by
- Product - Primary  specified time period and broken down by key indicators (Product -
Suspect Products Primary Suspect Only).

Only

Case Volume History Use the following procedure to obtain an overview of case volume by
(Reporter Type) specified time period and broken down by key indicators (Report Type).

Case Volume History Use the following procedure to obtain an overview of case volume by
(Seriousness) specified time period and broken down by key indicators (Seriousness).
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Report Title

Description

Case Volume History
split by Initial and
Follow-up

Case-Load

Case-Load Listing

Cases by Reporter
Type Tabulation

Delayed Workflow
Listing by Case

Delayed Workflow
Listing by Workflow
State

First and Last
Reporter Contact

Follow-up Status
Listing

Listing of Cases due
for Lock

Listing of Cases Late
for Lock

Open Action Items
Listing
Product Tabulation

by Site and Case
Source

Receipt Latency of
Cases by Site - Initial
and All Follow-ups

Receipt Latency of
Cases by Site - Initial
and Significant
Follow-ups

Receipt Latency of
Cases by Site and
Country of Origin

Received AE Reports
by Protocol

Report Volume
History

Reports By Causality

Reports by Country

Reports by Month

Use the following procedure to obtain an overview of case volume by
specified time period and broken down by initial vs. follow-up reports.

Obtain a graphical representation of cases in each workflow state.

Obtain a listing of the number of cases received and processed per
workflow state for a given time period.

Use the following procedure to compare the number of cases from each
reporter type.

Obtain a list of cases where the max time has been exceeded.

Obtain a list of cases where the max time has been exceeded.

Obtain a listing of case details including first and last contact from the
reporter (Initial receipt and most recent follow-up date) for each case.

Obtain a listing of cases requiring follow-up and the status of those cases.
Obtain a listing of cases that due for lock

Obtain a listing that displays case work state milestones and lead times for
workflow as well as minimal case information.

Obtain a list of cases with open action items by responsible group.

Obtain a summary that lists the number of cases by site and product
(Ingredient) by Report Type with totals.

Obtain a listing of latency from initial receipt date to central received date
for initial and follow-up reports.

Obtain a listing of latency from initial receipt date to central received date
for initial and follow-up reports.

Obtain a listing of latency from initial receipt date to central received date
for initial and follow-ups, broken down by country of origin.

Obtain a line Listing of all cases received grouped by Protocol Number
(Study ID).

Listing to show the volume of reports that were submitted over a certain
time period broken down by reporting destination.

Graph of number of reports processed grouped by case causality to verify
workload, productivity. The counts show the number of case locks (initial or
follow-up) with initial or follow-up information during the report period.

Graph of number of reports processed - grouped by country of incidence
and sorted by descending counts to verify workload, productivity. The
counts show the number of case locks (initial or follow-up) for cases
originating from that country during the report period.

Graph of number of reports processed - grouped by month and sorted by
numeric month to verify workload, productivity. The counts show the
number of case locks (initial or follow up) in that month.
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Report Title Description

Reports By Product ~ Graph of number of reports processed - grouped and sorted by descending

Family counts to verify workload, productivity. The counts show the number of
case locks (initial or follow up) where the primary suspect is in that Drug
Family during the report period.

Reports by Report Graph of number of reports processed - grouped by report type; such as

Type Spontaneous Report, Clinical Trial(non-PMS), PMS, or Literature. The
counts show the number of case locks (initial or follow-up) during the
report period.

Reports by Graph of number of reports processed - grouped by case seriousness to

Seriousness verify workload, productivity. The counts show the number of case locks
(initial or follow-up) during the report period.

Reports by Year Graph of number of reports processed - grouped by year and sorted
chronologically. The counts show the number of case locks (initial or
follow-up) in that year.

Total Case WorkLoad Obtain a listing of total number of cases in the system.

by Site

Total Case Workload = Obtain a listing of total number of cases in the system grouped by site and

by Site and COI - Init.
and Sig. Follow-ups

Total Case Workload
by Site and COI -
Initial and All
Follow-ups

Total Case Workload
by Site Graphical
Summary

Workflow
Monitoring Report

Workflow Report - 3
months

Workflow Report - 4
quarters

country of origin.

Obtain a listing of total number of cases in the system grouped by site and
country of origin.

Obtain a graphical overview of the total number of cases in the system
broken down by seriousness.

Obtain a listing that displays case workflow milestones and lead times for
workflow as well as minimal case information.

Counts based on Groups over 3 month periods, based on a selected date
range.

Counts based on Groups over 4 quarters, based on a selected date range.

Pharmacovigilance Reports

The following table describes each Pharmacovigilance Report.

Report Title

Description

AE Count Tabulation
Age Group Vs.

Gender

Aggregate Diagnosis
Listing

Annual Product
Review

Case Listing

Case Listing with all

This report is a summary tabulation that displays a count of events and breaks
them down by causality.

This report is an analysis of relationships between two or more attributes.

This report is a summary of the event counts by Diagnosis and broken down
by seriousness and listedness.

This report is a listing of all cases for a drug family grouped by primary
suspect drug, SOC and sorted by drug, SOC to review cases potentially
associated with quality compliant or lack of efficacy.

This report is a case listing of cases with key Pharmacovigilance data elements
for spontaneous cases.

This report is a case listing of cases with all regimens and events for

Regimens and Events spontaneous cases.
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Report Title Description

Clinical Case Listing  This report is a case listing for clinical cases

Clinical Trial This report captures the Table of event count grouped by selected MedDRA

Causality levels (SOC,HLGT,HLT,PT), administered drug, event causality to support
medical investigation. Case counts for selected MedDRA levels and
administered drug is also included

Clinical Trial This report is required to tabulate the causality assessments for each occurring

Causality Tabulation PT.

Count of Serious This report provides an overview of serious related cases over a given time

Related Cases by period.

Product

Data Quality This report provides a graphical summary of case data quality for the

Indicator following key data elements

(Alphabetically by

Quality Indicator)

Data Quality This report provides a list that contains the cases that contributed to the data

Indicator Listing value as the graphical report

Data Quality This report provides a graphical summary of case data quality for the

Indicator (Ascending following key data elements.

Order of Count)

Death Cases This report provides the listing of cases with death details, event details where
the patient has had a fatal outcome - grouped by SOC.

Dechallenge and This report provides the Line Listing for Dechallenge and rechallenge

Rechallenge Listing  information

Dosage Frequency This report captures the frequency of dosing for a particular product to see if

Tabulation there is an increase in frequency of various AEs.

Dose Formulation This report captures the relationship between dosage formulation and events

Product Relationship for a given suspect drug.

Duration of This report captures the table of event counts categorized by time to onset -
Treatment until Event grouped and sorted by event.

(Time to onset) per

Event

Event (PT) Vs Age This report is required to analyze relationships between two or more attributes.
Group

Event (PT) Vs Daily  This report is required to analyze relationships between two or more attributes.
Dose

Event (PT) Vs This report is required to analyze relationships between two or more attributes.
Duration of

Treatment Until

Event

Event (PT) Vs Gender This report is required to analyze relationships between two or more attributes.

Event (PT) Vs Report This report is required to analyze relationships between two or more attributes.
Type

Event Term This report is required o identify the frequency of events in descending order,
Frequency Listing by grouped by SOC, HLGT, HLT, or PT.

HLGT

Event Term This report is required to identify the frequency of events in descending order,
Frequency Listing by grouped by SOC, HLGT, HLT, or PT.

HLT
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Report Title Description

Event Term This report is required to identify the frequency of events in descending order,
Frequency Listing by grouped by SOC, HLGT, HLT, or PT.
PT

Event Term This report is required to identify the frequency of events in descending order,
Frequency Listing by grouped by SOC, HLGT, HLT, or PT.
SOC

Event Vs Daily Dose  This report is required to analyze relationships between two or more attributes.
Event Vs Report Type This report is required to analyze relationships between two or more attributes.
Event Vs. Age Group This report is required to analyze relationships between two or more attributes.

Event Vs. Duration of This report is required to analyze relationships between two or more attributes.
Treatment Until

Event
Event Vs. Gender This report is required to analyze relationships between two or more attributes.
Fatal Case Listing This report is required to obtain a listing of cases with fatal seriousness criteria.

Fatal/Life-Threatenin This report is required to obtain a listing of cases with fatal or life-threatening
g Cases Listing seriousness criteria.

Frequency Listing of  This report is a table of event counts - sorted by descending event count
Events frequency to help support labeling or package insert review.

Gender Group by This report is required to capture the Gender Group by Age Group
Age Group

MedDRA SOC-PT This report is required to capture the Table of event, case count categorized by

group report type, report type, event seriousness, causality - grouped and sorted by preferred
event seriousness, term to support medical analysis.
causality

MedDRA SOC-PT This report is required to capture the Table of event, case count categorized by
Group by Age Group chronological Age group - grouped by preferred term to support medical
analysis.

MedDRA SOC-PT This report is required to capture the Table of event, case count categorized by
Group by Daily Dose Daily Dose bands - grouped and sorted by preferred term to support medical
analysis

MedDRA SOC-PT This report is required to capture the Table of event, case count categorized by
Group by Gender gender - grouped and sorted by preferred term to support medical analysis.

Product and Disease  This report captures the concomitant medications and underlying disease
Listing

Product Interaction This report is a summary tabulation that displays a count of the incidence of

Tabulation other products involved in cases.

Quick Signal This report captures the event-reporting rates that might suggest a possible
change in the safety profile of a product.

Seriousness Case This report provides a listing of cases by grouped by seriousness criteria.

Listing

SOC/PT Tabulation  This report compares events based on report type.

(Event Count)

Temporal This report captures a graphical overview of the temporal relationships of the

Relationships dates recorded in the case.

Top 10 Substances This report captures a listing of the top 10 frequent substances occurring in

cases for the specified time period.
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Creating Custom Reports

In addition to the preformatted Standard Reports, Argus Insight provides Report
Writer, Cubes, and Dashboard Indicators tools that let you create custom reports for ad
hoc/special reporting requirements.

Report Writer is used to create a custom report by directly selecting datamart fields
and applying filters on them. The report output can be displayed in various layouts
and can be saved in file formats, such as PDF, XLS, or CSV.

A Cube is a data model that contains multiple dimensions (key reporting elements).
You can observe and analyze the interactions between reporting elements by
performing operations such as nesting, drill, sort, count, and total. Argus Insight
provides five built-in Cubes, pertaining to varied reporting aspects.

Dashboard Indicator reports are configured by the administrator and made available
to users based on their profile. These reports pull the latest data from the datamart and
provide information on key product performance and workflow efficiency parameters.

The topics that follow explain how to use the custom report tools.
= General Report Writer Information

s Creating a New Report

= Editing Reports

s Changing the Report Layout

= Saving and Accessing Saved Reports

General Report Writer Information

In this version of Argus Insight, Report Writer utilizes the features of Cognos® 8 Query
Studio to let you create custom reports by directly selecting datamart fields and
viewing the result (report output) on the fly. The Report Writer interface provides a list
of database fields organized in a tree structure. Use the following procedure to create a
report, expand the trees corresponding to the required database fields and select the
fields to be displayed as columns in your report.

Once you have created your report, you can edit the report, change the report layout,
run the report in specific formats, and save the report.
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Creating a New Report

This topic explains how to start Report Writer and create a new report. Use the
following procedure to create a new report.

1. In Argus Insight, select Case Series Reports > Report Writer > New. Query
Analysis starts. In the left frame, the Insert Data menu option is selected.

1BH Cognos 8 B fjuery Staudio - Hew awitng Lm0 | A7 -
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2. Select the Active Case Series Filter.

Note: Select the Active Case Series Filter before selecting datamart
fields for your report. This prevents Report Writer from querying the
entire datamart and slowing down the report output generation.

Use the following procedure to view the Active Case Series, select
Query Results > Case Series > Active in Argus Insight. If you want to
make another Case Series active, select Query Results > Case Series >
Library in Argus Insight. In the Case Series Library page that appears,
check the Case Series you want to make active and click Make Active.

3. In the left frame, expand the Report Writer control tree. The various datamart
views are displayed.
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(@ reportwriter A
= [B]Reportwriter

@ Jl§ Activities - Action Items

@ fiil Activities - Case Closure

@ {iii Activities - Contact Log

@ [ Activities - Routing Log

@ {iil Add Info - Notes and Attachments

® i Additional Information - References

@ fiii Analysis - Case Assessment

@ fiiil Analysis - Comments and Narratives

© i Analysis - Regulatory Reports

@ Jji Case Series

@ i Events - Death Information

i Events - Diagnosis Event

@ fiii Events - Event Assessment

® il Events - Event Information

@ {fii Events - Hospitalization Info

@ [ Events - Imputability

@ fiii Events - Primary Event

@ {ii General - Case Classifications

# [ijg General - Case Follow-up

@ [ General - General Information

@ {iiij General - Literature Information

@ {J§ General - Reporter Information

# {iii General - Study Countries

@ fiii General - Study Information

# {iii MedDRA Dictionary - All SOC

@ {jij MedDRA Dictionary - Primary SOC

@ [iii MedDRA Dictionary — SMQ

@ {il MedDRA Dictionary - SSC ,,

|
Insert =p

4. Scroll down the list of views so that the Filters folder is visible.

|~

5. Expand the Filters folder. The built in Active Case Series Filter is displayed.
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I+

i Patient - Pregnancy Intormation
Ji Products - Device

I+

Jii Products - Device Product Delivery

I+

ﬁ Products - Dosage Regimens
g Products - Drug
g Products - EU Device

]
g Products - Primary Suspect Product

I+

I+
| =]
[ =]

I+
=
=

Products - Ingredients

I+
=
=

[+
=]

Ji Products - Product Information
Jii Products - QC CID

Ji Products - QC Information

Ji Products - Suspect Products

e e e o

f0@ Products - Vaccne History

I+

Ji Products - Vaccine Prior AE
Jii Products - Who Drug ATC Code
[ Filters
Bl Active Case Series Filter
" Case Series Filter

[T+

? Display Latest Data v
< | @
| A

6. Select the Active Case Series Filter.

7. Click Insert. The selected filter appears in the right frame.
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8. Select the datamart fields to include in your report.

9. In the left frame, expand the Report Writer control tree. The various datamart
views are displayed.

10. Expand the datamart view tree, as appropriate. The datamart fields corresponding
to the tree are displayed.
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11. Select the datamart fields, as appropriate.

Tip: If your report consists of fields from the Event and Product
tables, it will only display data for those cases where event assessment
has been done. This is because event assessment is the only way of
defining relationship between an event and a product.

12. Click the Insert button. The Report Writer queries the datamart, automatically
executes the query for every field you selected, and displays the data for the
selected fields in the report output area within the right frame. The fields you
selected are displayed as columns in the report output.

Incert =

Eun Report 7 -
W Gatire Cage Series Fiker
Hanags Fie
= ~ | | Cosethamber | Case | Company | Compay | Country | Famdy | tniemal | Intemal | Generic | Marsfacturer | Wotes | Product | Produst | Produst | Produst
TR Patiect - Pregnancy Information Primary | Drug | Produt Name | CaselD |Sequence | Name a5 Genec | Name | Type
# il Products - Device Suspect | Code [ Repestsd | hama
& Tl Products - Devies Praduct Delivery L
19580€000028  Yes REIDAGZ  ‘Wonder WORLD  Wonder 10025101 1 Waonder ionder Wonder Wonder Suspect
+ [l Products - Dosage Regimens o WORLD | Drug- Drug Drug T Drsg  Drug
+ [l Froducts - g Famiy
. 'F\loﬁxks EU Device 19580€000028  Yes REIDAGZ Wonder WORLD  Wonder 10025101 1 ‘Wonder ‘Woonder Wonder Wonder Suspect
4 [ Products - Inge . Dy WORLD {_\:‘y Drusy Drug MET Dy Drg
3 8 Products - Primary Suspect Prodct 19606000028 Yes  REIDAGZ Wonder  WORLD  Wonder 10025101 1 Wonder Wonder  Wonder Wonder | Suspect
= T Products - Product Information Drug WORLD may Dr Drug MT Dy Dng
T case Number
19900€000028  Yes RELDAGE Wonder WORLD  Wonder 10025101 1 ‘Wonder ‘Wonder ‘Wonder ‘Wonder  Suspedt
U case Primary Suspect Produst onug WORLD | Drug - Drug Drug MET Dy Drug
N company Drug Code Famiy
T Company Product 19E0E000008 Yes  RELOAGZ Wonder  WORLD  Wender 10025101 1 Wonder Wonder  Wonder Wonder Suspect
Drug WORLD  Drug - Drugy Drug MKT  Drug Drug
W courary [
IF Name 19580€000028 Yes RELDAGE Wonder WORLD  Wonder 10025101 1 ‘Wonder ‘wionder ‘Wonder ‘Wonder Suspect
Il-'i.rf Case 1D Drug WoRLD 'l?:ﬂ; Drugy Drug MKT D Drug
) terul S e sk 199906000028 Yos  RELDRGZ Wonder WORLD | Wonder 10025101 1 Wonder Wonder  Wonder Wonder  Suspect
H| Geneic name g WORLD | Drug - Drug Drug MKT Drg Dy
T Manufocturer Faniy
IW!S o 19960€000028  Yes REIDAGE Wonder  WORLD  Wonder 10025101 1 ‘Wonder ‘Woonder ‘Wonder Wonder  Suspedt
Doy ‘WORLD  Drug- Drug Drug MKT  Drug Drug
€ ¥ Farmiy

8| - 2 ¥ pagedown T Batton

Tip: Select multiple fields as follows:
= Hold down the CTRL key and select the fields.

= Insert an entire datamart view in your report by selecting the
datamart view entity in the left frame and clicking Insert.

= Drag the field entities to the report output area.

13. Repeat the steps listed above to insert additional fields into the report.

Tip: If you wish to delete a column from the report output, select the
column and click the Delete button on the toolbar.

You can revert or repeat any actions you perform in Query Studio by
using the Undoor Redotoolbar button, respectively.

14. Enter the report title.

15. Click Title above the report output. The Edit Title section appears below the
report output in the right frame.
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Changs Lavok
BunBeport
Hanaoe Fie

+ [l Patiert - Fregnancy Information
% [l Products - Devies
4 Products - Device Product Debvery
4 [l Products - Dosage Regmens
+ [l Products - brug
4 [l Products - EL Device
% [l Products - Ingredents
% Jll Products - Primary Suspect Product
= {8 Products - Product Information
W Cose twumber
0 Cose Primary Suspact Prodhuct
W Company Drug Code
W Company Froduct
U Country
U Famidy tame
0 imtermal Case 1D
0 1rternal Sequence thumber
W Geraric Name.
N Manusfacturer
i totes v

Insert =

T & ¥ paedoen * Eolton

Title
¥ faties Case Saries Fiter @
| Cosemumber | case |Company | Company | Courtry | Famdy | Intemal | Intemsl | Generic | Manifacturer | Notes | Product | Product | Product | Product
Primary | Drug | Product Name | CaselD | Sequence  Name as Gareric | Name | Type
Suspect | Code [ Reported | Name
Product |
19960E000028 Yes | RELORGZ Wonder WORLD Wonder 10025101 1 Wondar Wonder  Wonder Wonder Suspect
Drug WORLD  Drug Drug Crug_MET  Drug Drug
Fardy
19960E000028 Yes  RELDRGZ Wonder WORLD Wonder 10025101 1 wondar Wonder  Wonder Wonder | Suspect
Drug WORLD  Drug - brug Drug MT Orag Oy
Faniy

Subtitle:

[#] Show fiters
[ show sorts

OK Cancel

Specity what il appesr st the bop of the repcet and on the firet page of printed copies

16. Enter the report title and subtitle in the respective text boxes.

17. Click OK. The page refreshes; the titles you entered appear above the report

output.

Using Case Series Criteria and Case Series Name in new Report.

Use the following procedure to generate a report for displaying all the Case Series
Criteria and Case Series Name.

1. Select the Case Series Criteria and Case Series Name objects from the Case Series

class.

2. The Report Writer queries the datamart, to get all the Case Series Criteria and
Case Series Name.

@ { Activities - Case Closure
- {0 Activities - Contact Log
+ {0 Activities - Routing Log
+ {ill Add Info - Nokes and At
@ {ill Additional Information -
] m Analysis - Case Assessr
+ [ Analysts - Cornments am
+ [l Analysis - Regulatory Re
= iﬁ Case Series

Wl Case series Criveria

l Case Series Name

0 series 1D

(Report Type is equal to “Spontaneous’)

hando Lavout Title
[Fun Report
n2ge Fi Case Series Criteria Case Series Name
[ reportwriter (Country is equal to UNITED KINGDOM) | LIK Cases Cases Series
=) Repthnter Country is equal to "UNITED STATES' US Cases Case Series
+§ll Activities - Action Items ALL Cases

Spontaneous Case Series

Note: Temporary Case Series Criteria and Case Series names will not
be displayed.

Using Case Series Criteria and Name with Other Objects
Use the following procedure to use the Case Series Criteria and Case Series Name with

other objects.

1. In the left frame, expand the class folders under Report Writer.
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6
7.
8.
9

The dimensions for the class category are displayed.

Scroll down the list of views so that the Filters folder is visible.
Expand the Filters folder.

The built in Active Case Series Filter is displayed.

L emmimuia]
AiCEER s@x o p TRER-HIBAAR-Ba=a™@ §F &k CHEDE ISR B N . k-]
Title
’ E——
-
it i B viraiuhe it el
Select the Filter.
Click Insert.

The selected filter appears in the right frame.

In the left frame, expand the Report Writer control tree.

10. The various datamart views are displayed.
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Menu m
Insert Data |
Edit Data
Change Lavout
Run Report
Manage File

ReportWriter
= ReportWriter
Activities - Action Items
Activities - Case Closure
Activities - Contact Log
Activities - Routing Log
Add Info - Notes and Attachments
Additional Information - References

[ >

e

@ Ji§ Analysis - Case Assessment

* EI-I Analysis - Comments and Narratives
* EI-I Analysis - Regulatory Reports

# i Case Series

# fji Events - Death Information

* EI-I Events - Diagnosis Event

* EI-I Events - Event Assessment

Events - Event Information

®

Events - Hospitalization Info
Events - Imputability
Events - Primary Event

B & ®

General - Case Classifications

® ®

General - Case Follow-up

®

General - General Information
General - Literature Information

®

General - Reporter Information

=

General - Study Countries

=

] General - Study Information

& fijil MedDRA Dictionary - All SOC

# il MedDRA Dictionary - Primary SOC
# Jjil MedDRA Dictionary —SMQ

& §ji MedDRA Dictionary - S5C

v

<

11. Expand the datamart view tree, as appropriate.

12. Select the datamart fields, as appropriate along with Case Series Criteria and Case
Series Name from Case Series class.

Tip: If your report consists of fields from the Event and Product
tables, it will only display data for those cases where event assessment
has been done. This is because event assessment is the only way of
defining relationship between an event and a product.

13. Click the Insert button.
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14. The Report Writer queries the datamart, automatically executes the query for
every field you selected, and displays the data for the selected fields in the report
output area within the right frame. The fields you selected are displayed as
columns in the report output along with Case Series Criteria and Case Series

Name.

S Title

Bun Report )

Manage Fis T fictive Case Series Fiter
[ patiert - Lab Dot A | | casetumber | country | Country of Incidence Case Series Criteria | case Series hame |
ci- Rl Pationt - Neonates 2002US000005 UNITED STATES UNITEDSTATES  Country is equal to UNITED STATES' U Cases Case Series
5 R Patient - Other Relevant Htory 2002US000020 UNITED STATES UNITEDSTATES  Country is equal to UNITED STATES'  US Cases Case Series
& [l Patient - Parent Information 200205000029 UNITED STATES UNITEDSTATES  Courkry is equal to UNITED STATES'  US Cases Case Series

2002US000032  UNITED STATES UMNITED STATES Country is equal to UNITED STATES' LIS Cases Case Series
200305000002  UNITED STATES UMITED STATES Country is equal to 'UNITED STATES' US Cases Case Series
2001US000011  UNITED STATES UMNITED STATES Country is equal to UNITED STATES' LS Cases Case Series
200905000002 UNITED STATES UNITED STATES Country is equal to 'UNITED STATES' US Cases Case Series
& ' Products - Dosage Regimens 199905000000 UNITED STATES UNITED STATES Country is equal to 'UNITED STATES' | US Cases Case Series
B - Products - Drug 200205000009 UNITED STATES UNITED STATES Country is equal to UNITED STATES' US Cases Case Series
& ' Products - ELU Device 2002Us000012 | UNITED STATES UNITED STATES Country is equal to 'UNITED STATES' | US Cases Case Series
B . Products - I Sorts 2002US000015 UNITED STATES UNITED STATES Country is equal to UNITED STATES' LS Cases Case Series
& B Products - Primary Suspect Product 200205000017  UNITED STATES UNITED STATES Country i equal to 'UNITED STATES' | US Cases Case Series

# {ill Patient - Patient Information

@ [l Patient - Pregnancy Information
+ fill Products - Device

@ [l Products - Device Product Delivery

& [ Products - Product Information 2002US000023 UNITED STATES UNITED STATES Country is equal ko 'UNITED STATES' | LIS Cases Case Series
[ Products - C CID 2001US000004  UNITED STATES UWITED STATES Country i5 equal to UNITED STATES' LIS Cases Case Series
5 {5 Products - QC Information 2001US000006  UNITED STATES UNITED STATES Country is equal ko 'UNITED STATES' | LIS Cases Case Series
- JB8 Products - Suspect Products 2001US000007  UNITED STATES UNITED STATES Country i equal to ‘UNITED STATES' | US Cases Case Series
5 {58 Products - Vaccine History 1995US000001  UNITED STATES = UNITED STATES Country is equal ko 'UNITED STATES' | LIS Cases Case Series
# [l Products - Vaccine Prior AE 200205000019 UNITED STATES UWITED STATES Country is equal to ‘UNITED STATES'  US Cases Case Series
5 {58 Products - Who Drug Act Code 2002US000021 UNITED STATES UNITED STATES Country is equal ko 'UNITED STATES' | LIS Cases Case Series
= 3 Fiers 2001US000000 UNITED STATES UNITED STATES Country is equal to 'UNITED STATES' | LIS Cases Case Series

T active Case Series Fiter

T Case Series Fiker v

[Insert =, Ape 1, 2009 -1-

Tip: Use the following procedure to select multiple fields, hold down
the CTRL key and select the fields. You can also insert an entire
datamart view in your report by selecting the datamart view entity in
the left frame and clicking Insert.

You can also drag the field entities to the report output area.

15. Select Case Series Criteria and click Create Sections icon.

Change Lavout Title
Run Report
V' Active Case Series Fiter
Manage Fie
(@ reportiniter # | [ casetwmber | Country | Country of Incdence | Case Series Criteria | Case Series ame

= B reportwriter 2002US000005  UNITED STATES  UNITED STATES Couritry i equal to 'UNITED STATES'  US Cases Case Series
&l Activities - fiction Ttems 2002US000020  UNITED STATES UNITED STATES Courtry &5 equal to UNITED STATES' | S Cases Case Series
+ 0 Activities - Case Closure 2002US000029  UNITED STATES  UNITED STATES Couritry i equal to 'UNITED STATES' | US Cases Case Series
# Wl Activities - Contact Log 2002US000032  UNITED STATES  UNITED STATES Country is equal to UNITED STATES' | US Cases Case Series
+ 0 Activities - Routing Log 2003US000002  UNITED STATES UNITED STATES Country ks equal to UNITED STATES'  US Cases Case Series
= Bl Add Info - Notes and Attachments 2001US000011  UNITED STATES  UNITED STATES Counktry is equal to UNITED STATES' | US Cases Case Series
# il Addtional Information - References 200905000002 UNITED STATES UNITED STATES Courtry is equal to UNITED STATES'  US Cases Case Series
# Bl Analysis - Case Assessment 19990000000 UNITED STATES UNITED STATES Courktry is equal to 'UNITED STATES' | US Cases Case Series
+ il Analysis - Comments and Narrstives 2002US000009  UNITED STATES UNITED STATES Courtry &5 equal to UNITED STATES' | US Cases Case Serles
# [l Analysis - Reguistory Reparts 2002US000012 | UNITED STATES  UNITED STATES Couritry is equal to UNITED STATES' | US Cases Case Series
+ fill Case Senes 2002US000015 UNITED STATES UNITED STATES Courtry &5 equal to UNITED STATES' | US Cases Case Series
+ 0 Events - Death Information 2002US000017  UNITED STATES UNITED STATES Couritry i equal to UNITED STATES' | US Cases Case Series
# {ill Events - Diagnosis Event 2002US000023  UNITED STATES  UNITED STATES Country is equal to UNITED STATES' | US Cases Case Series
% il Everits - Evert Assessment 2001US000004 | UNITED STATES  UNITED STATES Couritry i equal to 'UNITED STATES'  US Cases Case Series
% Bl Events - Event Information 2001US000005  UNITED STATES  UNITED STATES Country is equal to UNITED STATES' | US Cases Case Series
+ il Events - Hospitalization Info 2001US000007  UNITED STATES UNITED STATES Couritry & equal to UNITED STATES' | US Cases Case Series
# il Events - Imputabiity 199905000001  UNITED STATES UNITED STATES Couritry is equal to 'UNITED STATES' | US Cases Case Series
+ il Events - Primary Event 200205000019  UNITED STATES UNITED STATES Courtry &5 equal to UNITED STATES' | US Cases Case Serles
%l General - Case Classifications 2002US000021  UNITED STATES  UNITED STATES Couritry is equal to UNITED STATES' | US Cases Case Series
+ fill General - Case Folow-up 2001US000000  UNITED STATES UNITED STATES Courtry &5 equal to UNITED STATES' | US Cases Case Series
+ J General - General Information
# {ill General - Literature Information v

Insert =p Apr 1, 2009 -1-
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16. The Case Series Criteria displays as header.

Case Series Criteria: Country is equal to "UNITED STATES'

Case Number Country Country of Incidence | Case Series Name
1999DEOOOOOD  UNITED STATES UNITED STATES US Cases Case Series
1999US000000 UNITED STATES UNITED STATES US Cases Case Series
199905000001  UNITED STATES UNITED STATES US Cases Case Series
2001Us000000 UMITED STATES UNITED STATES US Cases Case Series
2001US000001 UMITED STATES UNITED STATES US Cases Case Series
2001Us000002  UNITED STATES UNITED STATES US Cases Case Series
200115000003  UNITED STATES UNITED STATES US Cases Case Series
2001US000004  UNITED STATES UNITED STATES US Cases Case Series
200115000005 UNITED STATES UNITED STATES US Cases Case Series
200105000006 UNITED STATES UNITED STATES US Cases Case Series
200115000007  UNITED STATES UNITED STATES US Cases Case Series
2001US000008  UNITED STATES UNITED STATES US Cases Case Series
20015000009  UNITED STATES UNITED STATES US Cases Case Series
20015000010  UNITED STATES UNITED STATES US Cases Case Series
2001US000011 UMITED STATES UNITED STATES US Cases Case Series
20021JS000000  UNITED STATES UNITED STATES US Cases Case Series
20025000002  UNITED STATES UNITED STATES US Cases Case Series
20021US000003 UNITED STATES UNITED STATES US Cases Case Series
200205000005 UMNITED STATES UNITED STATES US Cases Case Series
200205000006 UMITED STATES UNITED STATES US Cases Case Series

17. Display the Case Series Name as header.
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W Active Case Series Filter

Case Series Criteria: Country is equal to 'UNITED STATES®

=
=
®

Case Series Name: US Cases Case Series

Case Mumber

Country

Country of Incidence

1999DEOOODDO
199515000000
19991J5000001
200105000000
200105000001
200105000002
200103000003
200105000004
200103000005
200105000006
200103000007
200105000008
200105000009
200105000010
200105000011
200205000000
200205000002
200203000003
200205000005
200203000006

UMITED STATES
UNITED STATES
UNITED STATES
UMITED STATES
UNITED STATES
UNITED STATES
UNITED STATES
UMITED STATES
UNITED STATES
UMITED STATES
UNITED STATES
UMNITED STATES
UNITED STATES
UNITED STATES
UNITED STATES
UNITED STATES
UMITED STATES
UNITED STATES
UMITED STATES
UNITED STATES

UNITED STATES
UNITED STATES
UNITED STATES
UNITED STATES
UNITED STATES
UNITED STATES
UNITED STATES
UNITED STATES
UNITED STATES
UNITED STATES
UNITED STATES
UNITED STATES
UNITED STATES
UNITED STATES
UMITED STATES
UNITED STATES
UNITED STATES
UNITED STATES
UNITED STATES
UNITED STATES

Note: Always use Active Case Series Filter while using Case Series
Criteria and Case Series Name with other objects. As, it may leads to
undesirable results.

Use the following procedure to view the Active Case Series, select
Query Results > Case Series > Active in Argus Insight. If you want to
make another Case Series active, select Query Results > Case Series >
Library in Argus Insight. In the Case Series Library page that appears,
check the Case Series you want to make active and click Make Active.

After you have selected the required datamart fields and generated the output, you
can use the various Query Studio options toedit the report, change the report layout,
run the report in specific formats, and save the report.

Editing Reports

You can access Query Studio's report editing options by selecting the Edit Data menu
option. The report editing options let you control what data appears in your report as
well as how it is formatted, calculated, and sorted. None of the edit operations you
perform are stored in the database.
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This topic only explains the basic report editing operations in Query Studio. For
detailed information, refer to the documentation supplied with the Cognos8 products.

Filtering Data

You can use the filtering option to reduce data in your report. Use the following
procedure to filter your report.

In the report output area, click within the header of the column you want to use to

1.
filter the report output. The selected column is highlighted.
Firsk First Fist Gereric | Inkernal | Internal
Suspect | Suspect | Suspect Marie Case ID | Sequence
Product | Produck | Product Murmber
Group Marne TMarie
Marne withaut
study
all Diabpen  Diabpen  Insight 10029152 1
Products SE -
Eligible
for UE
all Diabpen  Diabpen  Insight 10029152 1
Products SE -
Eligible
for UE
all Diabpen  Diabpen  Insight 10029106 1
Products Sh
Test CURE CURE CURE 100258871 1
Product  ALL BE ALL BE ALL BE
Group Capsule  Capsule | Capsule
we we ws
Injection  Injection | Injection
Test CURE CURE CURE 100258871 1
Product  ALL BE ALL BE ALL BE
Group Capsule  Capsule | Capsule
wa we s
Injection | Injection  Injection
2.

Select Filter from the Edit Data menu options in the left frame. The Filter section

appears below the report output in the right frame. The Show only the following
list displays all the values in the column you selected.
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18 Cognos 8 BI Query Studio - New

*ATOVE

AiDScH@ sBXoo b TG-RNIE G:B- B
¥ isee ¥ A~ B 7 U S-E- 40

Conditioe:
Show only the following x|
T THCHA STUCS s, Rl [Codde Nk Brchen)

[ sigohesl
= s, Camphor, , Terpinesd
[F1Beon of ron comguny g —snd
oo TAR, COCOMUT O, SALICYLIC ACID

[Jicere 1 iG1)

[F] Cure A8 (ING1), Cure A0 (B4G1, Cure Al (INGS), Cure AI{INGH), Cure ADL(INGE), Cure Al (INGZ), Cure A1 {ING1}
[] Cure AR (ING1), Cure A {(I4GZ), Cure A (INGT)

(Defauk)
) Agply the fiter bo indhvadusl vskues inthe deta source

O Cancel

TG Costember | Come | Compuny | Company [Contry | Drop [ Orug [ Famdy | Fe | Pt | Fem | Geeerk | iternd | ntendl | 1o
Ferm Pernaey | Drug | Prodat Authorization | Type | Bare | Suipedt | Suipect | Suspect | Kame | Case B0 | Sequencn | N
Taks | Supect | Code Courtzy Product | Peoduct | Product [

Harve Froduct Gp | Hame | Hame
Harme wathout
Sy

It 58 AJUS-0003 Study  Daboen 1 Dubgen A Dubpen Distbpen Iraight  10GZRISZ 1
- gl Dng “Fardy  Produets ER
for L8 Elghie

for g
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L] v
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filter onc 1 Fre—

o'y [ Promet every: repart runs

In the Show only the following list, check the values by which you wish to filter

the report output.

Note:

The Show only the following list may not display all the

values if the list of values is very large. If you cannot find the desired
values to filter on, click the Search for values link and search for the

value by typing the value you are looking for.

If you want the system to prompt you to select the filter values each time you run

the report, check the Prompt every time the report runs checkbox.

If you want the report output to include those records which have a null value (no
value) in the selected filter column, check the Show missing values checkbox.

Click OK. The system refreshes the report and displays the filtered output. The

filter information is displayed above the report output.

Sorting Data

Use the following procedure to change the sort order in your report.

In the report output area, click within the header of the column that contains the
values by which you wish sort the report output. The selected column is

1.

highlighted.

Select Sort from the Edit Data menu options in the left frame. The Sort section

appears below the report output in the right frame.
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3. Select the required sorting option by using the Sort Order option buttons.
4. Click OK. The system refreshes the report and displays the sorted output.

Summarizing Data

You can use the predefined summary options to calculate the total, count, maximum,
minimum, or average of the values in columns of your reports. The summary options
available to you depend on the type of data in the column you wish to summarize. For
example, you can only use the Count option if your column contains text data whereas
you can use total, maximum, minimum, or average options if the column contains
numeric data.

1. In the report output area, click the column that you wish to summarize. The
selected column is highlighted.

2. Select the column to be grouped and click on the Group icon placed in the
grouping menu in the top panel. The selected column is grouped.
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3. Select Summarize from the Edit Data menu options in the left frame. The
Summarize section appears below the report output in the right frame.

4. From the Summary for footers list box, select the required summary option. The
options available depend on the type of values the select column contains.

5. Click OK. The report output displays the column summary at the bottom of the
report. Click the Bottom link to view the footer. If your report is grouped, the
summary values are displayed for each group.
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6. To remove summary information, select the relevant column and click
Summarize. Select None from the summary option list box and click OK.
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Formatting Data in Cells

You can use predefined formats to change the appearance of numbers, dates, and
times in your report. Formatting does not change the underlying data. The following
table describes the various formatting options available.

Format

Description

Default

Text

Number

Currency

Percentage

Scientific

The default format is the format of the report item before any formatting is
applied in Query Studio. Use default to remove formatting.

Use the text format to specify the number of characters that should be visible in
the text string.

Use the number format to change the number of decimal places, to specify
whether to use a thousands separator, to choose different symbols to represent
negative numbers, and to scale large numbers.

You can choose from many world currencies. Use either the currency symbol or
the international code. For example the currency symbol for the eurois and the
international code is EUR. You can also change the number of decimal places,
specify whether to use a thousands separator, choose different symbols to
represent negative numbers, and to scale large numbers.

This format shows a number multiplied by 100, using two decimal places and a
percent sign. For example, 0.7356 appears as 73.56%.

This format shows a number in exponential notation. For example, the number
224,110 is 2.24110E+05 in scientific notation.

Date and Time -You can choose from a list of date and time formats, including the 12 or 24 hour

clock.

1. In the report output area, click within the header of the column that you wish to
format. The selected column is highlighted.

2. Select Format from the Edit Data menu options in the left frame. The Format
section appears below the report output in the right frame.

3. Select the data format from the Category list box, as appropriate. The options for
setting the format appear.

4. Set the formatting options, as appropriate.

5. Click OK. The report output is refreshed and displays the formatted data.

Performing Calculations

While the Summary option lets you display calculation results in report footers, the
Calculate option lets you create a new column that displays the calculation results for
one ore more columns. For example, you can perform the following types of
calculations:

» an arithmetic calculation between several columns in a report

= analytic operations, such as maximum, minimum, average, or percentile, in
grouped reports

= percentage operations, such as percentage of total or percentage of difference

= operations on text, such as concatenating text in two columns or abbreviating text
in a column

The type of calculations or operations available to you depend on the type of
information in a column.
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1. In the report output area, select the columns on which you wish to perform
calculations. The selected columns are highlighted.

2. Select Calculate from the Edit Data menu options in the left frame. The Calculate
section appears below the report output in the right frame.
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3. From the Operation Type list box select the type of operation you wish to
perform. The operation types available depend on the type of information the
selected columns contain, such as text or numeric.

4. From the Operation list box, select the operator. The operators available depend
on the type of operation you specified.

5. Depending on the operator you selected, additional options may appear in the
Calculate section. Specify those options.

6. Use the New item name option buttons to specify whether you want to the result
column to have a new header title.

7. Click the Insert button in the Calculate section. The report output is refreshed and
displays the calculation result.

Changing the Report Layout

You can access Query Studio's report layout options by selecting the Change Layout
menu option. The layout options let you change the appearance of your reports
without changing the underlying data. For example, you can convert your report into
a chart or group the report into crosstab column headers. You can also group your
report by a specific column, swap rows and columns, or create sections within your

report.
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The sections explain how to use the various report layout options.

| Change Layout

Fun Report
Manage File [ Report Agency | Internal Case ID
Chart... EMEA - PHY 9
EMEA, - xML 1
B Define Conditional Styles. .. [AF] BR (JCB) 50
A4 Change Font Styles... LAFY M (3CM) 2
Change Border Styles. .. [HA] AT (G5K) 107
Reset Font and Border Styles EIEEEY) 104
ool Template. .. [HA] Ca (TPD) 73
[HA] CH (1KS) 33
Edit Title Area... [HA] DE (BFArM) 125
Set Web Page Size... [HA] DK {MEH) 103
Set Page Breaks [HA] ES (FES) 105
[HA] FI (NEH) 102
o G_rﬂlé [HA] FR (FMA) 132
) Fivet [HA] GB (MCA) 112
o tnaroup [HA] GR (NDOD) 63
) Create Sedlions [HA] HU (NIP) 102
Swap Rows and Columns [HA] IE (IME) 101
%‘_ Collapse Group [HA]IT (MDS) 102
B> Expand Group [HA] IP (MHLYW) 215
[HAJ LU (DS) 102

Note: This topic only describes the basic layout operations in Query
Studio. For detailed information, refer to the documentation supplied

with the Cognos 8 products.

Creating a Chart

Use the Chart option to graphically see patterns and trends in data. Charts can only be
created for reports that contain measures (numeric values). Use the following

procedure to create a chart from a report.

1.

While your report is displayed, select the Chart from the Change Layout menu
options. The Chart section appears below the report output in the right frame.
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Use the Chart Type list box to select the type of chart you want to create. For
example, column, pie, radar, and so on.

Check the Show the values on chart checkbox if you wish to display the measure
value in the chart.

Use the Show the following in the report option buttons to specify whether you

want the output to display only the chart or both chart and table.

5. Click OK. The report output refreshes. The chart is displayed.

[ Change Layout

]

Run Report
Manage File

[l chat...

A4 Change Fort vies...
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120

Internal Case 1D

40
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EMEA - XML
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50
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107
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Tip: The legends are displayed at the bottom of the screen.

Grouping by Row Headings
Use the Group option to reorder the rows of a selected column so that identical values
appear together. Grouping also suppresses display of duplicates. You can group only

those columns that contain text data or numeric data that is not a measure. Use the
following procedure to group a report
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1. In the report output area, click within the header of the column that contains the
values you wish to use to group the report. The selected column is highlighted.

| Case Murnber | Internal Case ID | Internal Sequence Mumber | Report Agency | Reporting Affiliate |

1998DEQODDOS
1998DEQOODOS
1938DEQODDOS
1998DEOOODOS
1998DEQODDOS
1998DEQOODOS
1998DEQODDOS
1998DEOOODOS
1938DEQODDOS
1998DEOOODOS
1998DEQODDOS
1998DEOOODOS
1938DEQODDOS
1998DEOOODOS
1998DEQODDOS
1998DEOOODOS
1938DEQODDOS
1998DEOOODOS
1998DEQODDOS
1998DEOOODOS

10021101
10021101
10021101
10021101
10021101
10021101
10021101
10021101
10021101
10021101
10021101
10021101
10021101
10021101
10021101
10021101
10021101
10021101
10021101
10021101

10413701
10413901
10414101
10414301
10414501
10414701
10414901
10415101
10415301
10415501
10415701
10415901
10416101
10416301
10416501
10416701
10416901
10417101
10417301
10417501

[HA] LS (FDA)
[HA] US (FDA)
[HA] JP (MHLYW)
[HA] JP (MHLW)
[HA] GE (MCA)
[HA] DE (BFArM)
[HA] FR (FMA)
[HA] SE (MP&)
[HA] LY (DP)
[HA] LU (DS}
[HA] ES (FES)
[HA] BE (BPY)
[HA] NE {DCBG)
[HA] DK {NBH)
[HA] IT (MDS)
[HA] HU (MIP)
[HA] MO (SLEK)
[HA] FI (NEH)
[HA] IE (IME)
[HA] AT (GSK)

LINITED STATES
UNITED STATES
JAPAN

JAPAN

LINITED KINGDOM
GERMANY
FRANCE
SWEDEN
LATVIA
LUXEMBOURG
SPAIN

BELGILIM
METHERLAMDS
DENMARK
ITALY
HUMNGARY
MORWAY
FINLAMND
IRELAKD
ALUSTRIA

2. Select Group from the Change Layout menu options in the left frame. The system
refreshes the report and displays the grouped output.

[ Reporting affiiate | Case Number | Internal Case ID | Internal Sequence Number | Report Agency |

AUSTRIA

1998DE0DO00S
19980E000009
1998DE0D0010
19980E000011
19980E000012
19980E000013
1998DE000014
1998DE0D001S
1998DE0D0016
19980E000017
1998DE00001S
19980E000019
1998DE0D0020
19980E000021
19980E0000Z2
19980E000023
1998DE000024
19980E00002S
1998DE0D0026
19980E000028

To Ungroup a Report

To ungroup a report, select the grouped column and select Ungroup from the Change
Layout menu options.

10021101 10417501
10021301 10466501
10021501 10462501
10021701 10455701
10021501 10453101
10022101 10449101
10022301 10442501
10022501 10438501
10022701 10433101
10022501 10421501
10023101 10404501
10023301 10396501
10023501 10392701
10023701 10388901
10023%01 10386301
10024101 10382301
10024301 10378301
10024501 10374301
10024701 10370301
10025101 10365501

[HA] AT (GSK)
[HA] AT (GSK)
[HA] AT (GSK)
[HA] AT (GSK)
[HA] AT (GSK)
[HA] AT (GSK)
[HA] AT (GSK)
[HA] AT (GSK)
[HA] AT (GSK)
[HA] AT (GSK)
[HA] AT (GSK)
[HA] AT (GSK)
[HA] AT (GSK)
[HA] AT (GSK)
[HA] AT (GSK)
[HA] AT (GSK)
[HA] AT (GSK)
[HA] AT (GSK)
[HA] AT (GSK)
[HA] AT (GSK)

5K,
5K,
5K,
5K,
5K,
5K,
5K,
5K,
5K,
5K,
5K,
5K,
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Creating Crosstab Reports

A crosstab report shows a measure at the intersection of each row and column. This
type of report is useful when you need to display a large amount of data in a small
area. For example, if a report shows Country as columns, Products as rows, and Case
Count as the measure, the value at the intersection of each column and row shows the
count of cases for that product and that country.

Note: You cannot create crosstab reports directly in Query Studio nor
does Query Studio permit you define measures. Use the following
procedure to create sophisticated reports, such as crosstab reports, use
the Cognos 8 Report Studio tool. The steps that follow explain how to
create a crosstab report by performing the "Count" operation on each
cell of the Case Number column to convert it into a measure. You can
use this method to create similar crosstab reports in Query Studio.

Tip: To create a crosstab report using the Count operation

1. Select the following datamart fields to include in your report.
= General - General Information > Case Number
= General - General Information > Country of Incidence
s Product - Product Information > Product Name

2. The Report Writer queries the datamart, automatically executes the query for
every field you selected, and displays the data for the selected fields in the report
output area within the right frame. The fields you selected are displayed as
columns in the report output.

Bun Bepord W Butive Case Series Fiter
Manage Fie
[ = i Products - Product Information a | [ Case turmber | Country of Inadence | Product Name

W Case Number 19990€000000  UNITED STATES Cure A1
W Case Primary Suspect Product 199505000000 UNITED STATES Test Drug 1
W company Drug Code 19995000001  UNITED STATES Cure Al
W Company Product 2001US000000  UNITED STATES Algohest
W country 2001U5000001  UNITED STATES Cure Al
W Famity Name 2001US000002 UNITED STATES  Cure &l
W internal Case 1D 2001U5000003  UNITED STATES % - 22 US vs PLACEBO
W) tnkernal Sequence Number 2001US000004  UNITED STATES Flunomere
W Generic Name 2001US000005  UNITED STATES MMR
M Maresfacturer 2001U5000006  UNITED STATES Cure Al
0 rotes 20015000007  UNITED STATES Cure Al
W Product as Reported 2001U5000007 | UNITED STATES Mausinct
T Product Generic Name 2001US000007 | UNITED STATES Painocide 40 mi syringe
W Product Name 200105000008  UNITED STATES Cure Al
W Froduct Type 2001U5000009  UNITED STATES Cure Al
i Protocol Followed 2001US000009  UNITED STATES Painocide Linknown
W sort Order 2001US000010  UNITED STATES Cure Al
W study Drug 2001US000011 | UNITED STATES Cure All
W study orug # 2001US000011 | UNITED STATES Wonder Drug

W wHO Drug Code 2 200205000000  UNITED STATES Cure All

3. Convert the Case Number column values into counts.
4. Select the Edit Data menu. The Edit Data menu options are displayed.
5. Select the Case Number column by clicking within the column. The Case Number

column is highlighted.

Summarize the Sections in the Report
Use the following procedure to summarize the sections in a report.
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1. Select the Summarize option from the Edit Data menu. The Summarize section
appears below the report output.

2. Click the Advanced link in the Summarize section. Additional options appear.

T | 7 s
T e, [ Cace Warbr | Covrtry of ccdoncn | Procant Hane
o Fi .Imﬁﬂ' UNITED STATES .rn\ﬂ
2 san.. 15SEURI00000 | UKITED STATES Test brug |
T samaks.. 150905000000 UNITED STATES Cure
o Eomal Data... 2001UE000000 | UKITED STATES Agcheal
[ T OU0OKO! UHITED STATES  Curedl
Difine Cucton Groupe. 0US000Z UHITED STATES  Cure il
01000001 UNETED STATES K- 225 vs PLACESO
qé Dl Jowin ZO0US00000H  UKITED STATCS Furcessic
S ol JOUBU0005 LMITED STATES MR

z = ¥ bagndoen = fotom

T

Set u bokals or other snmariss.

Summary for cells:
Courk A

11 Summary for facters
Tatal ~

3. Select Count from the Summary for cells list box.

4. Select Total from the Summary for footer list box.

5. Click OK. The report output refreshes. The Case Number column now shows the
case count for each row.

Change Lavout
mm!”! T Active Case Series Fiter
T Eiter... | Case Number | Country of Incidence | Product Name
Combine Filters... 4 UNITED STATES Algoheal
# sot... 30 UNITED STATES Cure Al
= Summarge... 2 UNITED STATES Flunomore
v FormstData... Z UMITED STATES MMR
B cacuste.. 2 UNITED STATES Nausinot
Define Custom Groups. .. 2 UNITED STATES Painocide 40 ml syringe
Z UNITED STATES painocide 20 ml syringe
o Dril Down 3 UNITED STATES Painocide Unknown
% Dl 2 UNITED STATES TYLENOL
R solo. 1 UNITED STATES Test Drug 1
Rename Column Heading... 11 UNITED STATES Wonder Drug
Z UNITED STATES ®-22U5
b Cuk 2 UNITED STATES % - 22 US vs PLACEBO
B paste 65
K Delete
Y Undo
© Redo

Convert to a Crosstab Report
Use the following procedure to convert to a Crosstab report.

1. Select the Change Layout menu. The Change Layout menu options are displayed.
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Change Layout

Bun Report
Manage Fie

E
Im]
‘3

Change Fonk Styles...
Change Border Styles...
Reset Foot and Border Styles

@B &

Edit Title Area...

Set Web Page Size.,.
Set Page Breaks
Group

Bivot

Ungroup

Create Sections
Swap Rows and Columns

Collapse Group
Expand Group

B9e? Eifig

T Active Case Series Fiter

| Case Number | Country of Incidence | Product Name
4  UNITED STATES Algoheal
30 UNITEDSTATES  Cure Al
2 UNITEDSTATES  Fhunomore
2  UNITED STATES MMR
Z UNITED STATES Nausinot
2 UNITED STATES Painocide 40 ml syringe
2 UNITED STATES Painocide 20 ml syringe
3 UNITED STATES Painocide Unknown
2 UNITED STATES TYLENOL
1 UNITEDSTATES  TestDrug1
11  UNITED STATES ‘Wonder Drug
2  UMNITED STATES r-22U5
2 UNITEDSTATES  X-22US vs PLACEBO
65

2. Select the Country of Incidence column in the report output. The column is
highlighted. The values of the selected column will appear as columns in your

crosstab report.

3. Select the Pivot from the Change Layout menu options. The report output
refreshes. The crosstab report is displayed.

| Change Layout

Bun Report
Manage File

Chart...

Define Conditional Styles...

Change Fonk Styles. ..
Change Border Styles...
Reset Font and Border Styles
Apply Template, ..

[ 2

Edit Title Area...
Set Web Page Size...
Set Page Breaks

Group
Pivat
Ungroup

Create Sections

Swap Rows and Columns

i Uil

@ Collapse Group
gm Expand Group

Creating Sections in the Report

W Active Case Series Filker

Case Number

MMR.

TYLEMOL

algoheal

Cure all

Mausinok

Fluriomore:

¥-22U5

Test Drug 1

Wionder Drug
Painocide Unknown

# - 22 U5 vs PLACEBO
Painocide 20 ml syringe
Painocide 40 ml syringe
Summary

UNITED STATES Summary

2 2
2 2
4 4
30 30
2 2
2 2
2 2
1 1
1 11
3 3
2 2
2 2
2 2
65 b5

Use the Create Sections option to group your report into section headings. The section
headings are based on the values within a column you select.

1. In the report output area, select the column you wish to use for creating sections.
The selected column is highlighted.
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‘ Change Layout

Run Report
Manaqe File

B Define Conditional Stvles...

Change Font Styles. ..

Change Border Styles. ..
Reset Font and Border Styvles

B 2

@pply Template. ..

Edit Title Area...
Set Web Page Size...
Set Page Breaks

Unaroup
Create Sections

Swap Rows and Colurns

Bl 0 0 0

Collapse Group
Expand Group

&7 [

W Active Case Series Filter

| Case Number | Counkry of Incidence Product Name
1923DEO00000  UNITED STATES Cure all
19295000000 UNITED STATES Tesk Drug 1
192905000001 UNITED STATES Cure All
200105000000 UNITED STATES Algoheal
200105000001 UNITED STATES Cure all
2001US000002  UNITED STATES Cure all
200105000005 UNITED STATES % - 22 US vs PLACEED
200105000004  UNITED STATES Flunomore
200105000005 UNITED STATES MMR,
2001Us000006  UNITED STATES Cure Al
200105000007 UNITED STATES Cure all
200105000007 UNITED STATES Mausinok
200105000007 UNITED STATES Painocide 40 ml syringe
200105000008 UNITED STATES Cure Al
200115000009 UNITED STATES Cure all
2001US000009  UNITED STATES Painocide Unknown
200105000010 UNITED STATES Cure all
200105000011 UNITED STATES Cure All
200105000011 UNITED STATES Waonder Drug
200205000000 UNITED STATES Cure all

2. Select Create Sections from the Change Layout menu options. The report output
refreshes. The report is grouped into sections.
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| Change Layout

Run Report
Manage File

[l chart...

Define Conditional Stvles. ..

Change Font Styles. ..
Change Border Styles...
Reset Font and Border Stvles

H @

Apply Template...

Edit Title Area...

Set Web Page Size...
Set Page Breaks

g Group
= Pivot
Unaroup

Create Sections

Swap Rows and Columns

Collapse Group
mm Expand Group

Swapping Rows and Columns

W Active Case Series Filter

Case Number: 1999DEODOODDOD

| Country of Incidence | Product Mame |
UMITED STATES Cure all

Case Number: 199905000000

| Country of Incidence | Product Mame |
UMITED STATES Tesk Drug 1

Case Number: 1999US000001

| Counkry of Incidence | Produck Name |
UMITED STATES Cure all

Case Number: 200105000000

| Country of Incidence | Product Mame |
UMNITED STATES algoheal

Case Number: 200105000001

| Country of Incidence | Product Mame |
UNITED STATES Cure all

Case Number: 200105000002

| Country of Incidence | Product Mame |
UMITED STATES Cure all

The Swap Rows and Columns option in the Change Layout menu lets you
interchange rows and columns in a crosstab report or a chart based on a crosstab.
However, this option does not let you swap rows and columns in a list report.

Swapping rows and columns is useful in situations where a crosstab report has few

rows and many columns.

Use the following procedure to make the report shown above easier to read, you can
select the Swap Rows and Columns and interchange rows with columns.

If there are multiple rows or columns in a crosstab report, the outermost rows become
the outermost columns, and the outermost columns become the outermost rows.

Running the Report in Specific Formats

Query Studioprovides you many options to run or preview a report. You can access
Query Studio's various run and preview options by selecting the Run Report menu
item. Select the desired option to run the report.
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(s Leok L Events Information
fun Report o
b . T diive Caes Sovies Flber
[b punsan sipas Casabhmber | Courtryof Incidencs | ProdutMame | StudyOrug# | Cass CrestionTme | Case Serc
1] Previews vt Limt 1999DED00000  UNITED STATES  Cure &l [ 01-Jan- 1993 07SS0PM o
W Previess with o Data 199905000000 UNITED STATES  TestOnug 1 o 193 1999 0543:0PM o
1FFUS000001  UNITED STATES Cure &l o 19-Janr 1997 05:50:0 P No
evt 0 PEF Foma 2001USO000G) | LNITED STATES Hgehesl 0 19302000 1103088 No
fozuly FEFantonn,. 2001USD00001 | UNITED STATES Cire &1 0 02-34-2001 11:04:0PM s
Ve Evcel 2 Sheet Fou Z001US000002 UNITEDSTATES  Curel 0 242001 11:07T:0PM  Yes
Yot i Eicel Form 2001US000003  UNITED STATES X - 22 US ws PLACERO o O5-fuag-2001 11:15:0PM  Yes
L Ok el i by Z001USO0004 | UNITED'STATES  Fhunomare [ 294032001 11:260PM | No
e (WA Z001USO00005 UNITED STATES  MMR [ 09-5e0-2001 11:35:0FM  No
Yo 0P Foumal W0IUSO0006 UNITEDSTATES  Cure 0 185002001 L14S:0FM  Yes
— 2001USO0000T UNITEDSTATES  Cure &1 0 10-Dec-2001 121110 AM  No
Z001USO0000T UNITEDSTATES | Nausinet o 10-Dec-2001 12:11:0AM | No
2001US000007 UNITEDSTATES  Painoode 40mi syrnge 0 10-Dec-2001 1Z:11L0AM | No
2001US000003  UNITED STATES Cure &l 1] OFOt-2000 12:20:0 AM  Yes
2001USO0000Y UNITEDSTATES  Cure &l [ 13Dec-2000 1250 AM | Yes
2001US000009 UNITEDSTATES  PsncodsUrknown 0 130462001 121790 AM | Y3
2001USO00010  UNITEDSTATES  Cure & o 27-Dec-2001 1ZAT0AM | Yes
2001US000011  UNITED STATES Cure &l (1] Z9Dec-2001 12:55:08M No
Z001USO00011 | UNITEDSTATES | Wionder Drug o 29-Dec-2001 12:55:0AM  No
20025000000 UNITEDSTATES  Cure Al [ 02-Ja0-2002 12100 AM | Yes
Mow 14, 2006 -1-

¥ pedown T Quodtom

The following table describes the various Run Report options available in Query
Studio.

Option Description

Run with All Data Select this option to run the report using the full datamart. Running a
report with all data can take a long time. If you plan to make several
changes to a report, you may run the report by selecting the Preview
with Limited Data option to limit the rows of data that your report
retrieves.

Preview with Limited Select this option to preview the report by retrieving limited data from
Data the datamart. The report output has a torn border at the top and bottom
of your report.

Preview with no Data Select this option to preview your reports with no data. The system
displays junk characters in the report and the datamart is not queried at
all.

View in PDF Format  Select this option to save a snapshot of your report data in PDF format.
Select Specify PDF Options to set the display options for the PDF
output.

View in Excel Single  Select this option to save a snapshot of your report data in a single
Sheet Format datasheet in XLS format.

View in Excel Format Select this option to save a snapshot of your report data in XLS format.

View in CSV Format  -Select this option to save a snapshot of your report data in comma
separated values (CSV) format.

View in XML Format -Select this option to view list reports in XML format. You cannot view
charts or a crosstab reports in XML format.

Saving and Accessing Saved Reports

Use the Manage File menu option to save the reports you create by using Report
Writer. You can save your reports in either Personal or Public folders. The reports you
save are not a snapshot of the data displayed in the report output. Instead, the system
stores the specific set of instructions (datamart fields you select) for extracting data
from the datamart when you run the report. For example, if you run a report that you
saved a week ago, the data in the report reflects any changes in the datamart as a result
of the ETL process.
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Chemy e Events Information
Bun Report
; T Active Cace Series Fiter
Manage File |
[ tiew Report | Casebumber | Country of Incidence | ProductMame | StudyOrug# | CaseCrestionTme | Case
E Save 19990E000000  UNITED STATES Cura 41 01-Jan-1999 0T:55:0FM  No
Save A, 199905000000  UNITED STATES Test Drug 1 19-Jan-1999 05:49:0 PM
199305000001 UNITED STATES Cure A1 19-Jan-1999 05:50:0 FM
B 2001U5000000  UNITED STATES Algoheal 19-Jul-2001 11:03:0PM

02-3u-2001 11:04:0PM
24-Aug-2001 11:07:0 PM
05-Aug-2001 11:15:0 PM
29-Aug-2001 11:26:0 PM
09-5ep-2001 11:35:0PM
18-5ep-2001 11:45:0PM

No

No

No

2001US000001  UNITED STATES Cure Al Wes
Yos

Yes

Mo

No

Yes

10-Dec-2001 12:11:0AM  No
No

No

es

Yes

Yes

Yes

No

No

Yes

200105000002 UNITED STATES Cure Al
2001US000003  UNITED STATES ¥ - 22 LIS s PLACEBO
200105000004 UNITED STATES Fhunomore
2001US000005  UNITED STATES MMR

200105000006  UNITED STATES Cure Al
200105000007  UNITED STATES Cure Al
200105000007 UNITED STATES MNausinot
2001US000007  UNITED STATES Painocide 40 ml syringe
200105000008 UNITED STATES Cure Al
200105000009 UNITED STATES Cure Al
200105000009 UNITED STATES Painocide Unknown
2001US000010  UNITED STATES Cure al
2001US000011  UNITED STATES Cura &1
200105000011 UNITED STATES ‘Wonder Drug
200205000000 UNITED STATES Cure Al

10-Dec-2001 12:11:0 AM
10-Dec-2001 12:11:0 AM
07-Oct-2001 12:20:0 AM
13-Dec-2001 12:3%:0 AM
13-Dec-2001 12:39:0 AM
27-Dec-2001 12:47:0 AM
29-Dec-2001 12:55:0 AM
29-Dec-2001 12:55:0 AM
02-Jan-2002 12:10:0 AM

o/lo oo oo oooooooo0o0o0o0o0oo

The sections that follow explain how to save reports and access saved reports.

Saving Reports
Use the following procedure to save a report.

1. Select the Manage File menu option in the left frame. The options for saving the
report appear.

2. Select the Save from the Manage File menu options. The Save As section appears
below the report output in the right frame.

Hﬁu“:flc |] [ Case Mumber | Country of Incidence | ProductName | Study Drug # |
ot 1999DE0D0000  UNITED STATES Cure All o
() tew Report 195905000000  UNITED STATES Test Drug 1 0
| save
=T &F F B -4
R saved Bagedown = fottom
Repor efee... B
Specify a name and location for this entry. You can also specify a description and screen tip.
Name:
Description:
Screen tip:
Location:
Public Folders > ReportWriter
oK Cancel

3. Enter the report name in the Name text box.
4. Enter the report description in the Description text area.

5. In the Screen tip text box, enter the screen tip text that should appear when a user
points at the report in the Report Writer interface.

6. Select a Location option button to specify the location where the report needs to be
saved:
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= Select the Public Folders > Report Writer option button if you want all users
to be able access the report

= Select the My Folders option button if you wish to save the report as a

personal document.

Saving a Report in a New Folder
Use the following procedure to save a report in a new folder within Public Folders >
Report Writer or My Folders

1. Select the Select Another Location link. The Select a Location section appears.
2. Select the Public Folders or My Folders tab and click the New Folder link.

3. Specify the name, description, and screen tip for the new folder and click Finish.

R .
kot | = Country of Incidence ProductName | Study Drug #
Manage File ]
19990E000000 UNITED STATES Cure Al o
[ HewReport 1999US000000  UNITED STATES Test Drug 1 [] =
=
B Smenn = - ¥ Pagedown T Battom

Report Definition,,

find where you want to place the entry, Sexch
@ [ Coonos > My Folders

Entries: s -

Name ®

No entries,

e Folder

QK Cancel
4. Click OK to save the report in the location you specified.

Accessing Report Writer Library

The reports you save can be accessed from the Report Writer Library. Use the
following procedure to open the Report Writer Library, select Case Series Reports >
Report Writer > Library in Argus Insight. My Folders is the default location that
appears when you open the Report Writer Library. All the reports you save as personal
documents are listed in the My Folders location.

Entries: |1 -2 +
] Mame & Modified & Actions
[0 [N Event Information anabysis Novermber 15, 2006 12:03:12 AM B b N B e,
[0 M events Information November 15, 2006 12:03:39 AM b N\ B @ree..

To view the reports saved as public documents select the Public Folders tab. You can
navigate the public folders and display the desired report.

To run the saved report, check the checkbox next to the report name and click the Run
icon . If there are any filtering prompts associated with the report, they are displayed.
Specify the prompt values and click OK to view the report output.

You can edit a saved report by clicking the report name. The report opens in the Query
Studio interface. After you edit the report, you can save it by another name by using
the Save As option in the Manage Files menu.

Using SMQs in Report Writer

If a user selects an SMQ, all the cases based on that SMQ are displayed. The following
section explains how to use SMQs in report writer.

Creating Custom Reports  7-28



Creating Custom Reports

Using SMQs

Use the following procedure to use SMQs in report writer.

1. Go to Case Series Reports > Report Writer > New. The following window is
displayed.

IBH Cagnos § B Guery Studio. - lew

IfDEH@ s BXon b TE-HEZEH R DE=ET3 8 &b o Vs A BT L BB AB
[ imsereoma
ooz Title
f——
Py
[ ‘Sebact and insert Rans fron the tres to il in the recart.
 [Elrepwanzer ou com ok dag and tho fer nks the reaord
o1k e i s 1 o e
P N A —
nsart |
= 4

2. In the left frame, expand the Report Writer control tree. The various datamart
views are displayed.
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Menu m
Insert Data |
Edit Data
Change Layout
Bun Report
Manage File

[ Reportwriter ~
= [B]reportviriter

# [l Activities - Action Items

@ i Activities - Case Closure

# (il Activities - Contact Log

@ Jfl Activities - Routing Log

# [l Add Info - Notes and Attachments
@ [l Additional Information - References
# [l Analysis - Case Assessment

@ il Analysis - Comments and Narratives
© {ili Analysis - Regulatory Reports

@ [ Case Series

# [l Events - Death Information

& i Events - Diagnosis Event

# [l Events - Event Assessment

@ [l Events - Event Information

# (il Events - Hospitalization Info

@ {ifl Events - Imputabiity

# (il Events - Primary Event

@ [ General - Case Classifications

# [l General - Case Folow-up

@ [l General - General Information

# [l General - Literature Information
# {ifl General - Reporter Informaton

# (il General - Study Countries

@ {ifl General - Study Informaton

# ({jl] MedDRA Dictionary - Al SOC

+ ﬂmnumv - Primary SOC
] Emﬁ[)lm'mu\r -5MQ

@ {fl MedDRA Dictionary - S5C

Insert =p|
[ - |

| £

<

3. Under Events - Event Information, either double-click Event SMQ (Broad) or
drag-and-drop it to the right pane.
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18 Cognos 8 BI Query Studio - New

oo HiDSeHd@ sBXwo ) TR-HEIBGER-Bo =273 T E
[ snsert pata Ip [Femt v |cee w A B 7 U AH-F 4@
Change Lk Title
mnm’ ’ :

W Ve S mness =1 ]

T— e {B) Pregrancy complicstiors (SHQ)

i “‘:"“ ) Akathisa (549

R {B) Glaceena (50)

W] Evert a3 (Narrow)

W Evert Soet Crder

] Evert Stop Date

H Evert Stop Date Partial

W Evert Trestmen: Received
W Everit Withade vl Rsaction
W trternsi Case 0

W rrtermial Sequance Number
W stire of Evert

shnet
{B) Gastreintestingd premalignant decrders (SHO)
{B) Emboli: aref Ehrombotic snveris, vencus (540
(B At cantral respanstony deprewion (S

{8) Parkirnon-the everks (5M0)
{B) Chelestasis ared jaurdicn of hwpatic orighn (SM0)

{B) Argioderma (SM)
= mm ComuReponed rr—
et () Perighar ol eurcpathy (SHQ)
Rwowiez {B) Dyl (543
Eowres (B) Evaris someticaly reperted a8 skcohokeelsbed (340}
W onates {B) Haacnorbuges (3MQ)
w0 naes {B) Systemic hgus erythematons (SMQ)
Hobwres (B) Carcine arehepthesias (M3)
W wopamer L
W wopaten
W wopates
¥ wooaten
W o oaten
W woatez
W o eeny
W o reenz
W Lo reena a
€ >
Iresirt =

Jul 22, 2010 “1- 30722 M
indormation - Event SMQ (Broad) &l -

T Pumden T Bution

4. Perform a similar operation as shown in the above step for Event SMQ (Narrow).

5. Under Events - Event Information, either double-click Case Number or
drag-and-drop it to the right pane. This displays all the case numbers that
correspond to the selected SMQ.

Using Case Annotations

The term Case Annotation means the addition of notes to a case. An annotated case
makes for better understanding about the case, due to the presence of notes added to
describe anything relevant and important about the case.

Users can annotate cases within a case series as shown in the first row of the Notes

column below.

Masrrie ¢ Cat Descriphion

Tewtrg-Datasnent P aracte e 7] [Tessrg-Dacasnent

Choose Flements Cloac 1.0 |

Cane Humber (o) aeportipe O Proguct () () Seriousness Criteria () Outcome () wotes

AP Cune &1V Fatque L] Fatal @@ anvoctate
T Cure A1_UKT Rescratory falure FH Coatn S to [ T
T Cure A1_MKT Hepats tahee FH Fatnl @ 1eee
At X 22 US va PLACERO pate: take FHLT rath cm 1o @ 1o
T Cure A1_JKT Preumcaa NOS UFH Deam suets @ om0
RAT Pangcee_MKT et ey FH Daath sua te @ e
) MuR_axT Hepatic takwe FOULT Death dus 1o @ e

The Annotate option for a case allows you to add a Note field for the respective case.
This note is saved with the case series, and gets copied to a new case series if the case
series where it was created is also copied.

While entering the notes, ensure that you do not exceed 200 characters. The note is
then added through a context menu.

The created note remains with a case if the case series has been subsetted. Once
entered, a note is saved for the case series. This means that you do not need to
explicitly save a case series to save the note entered in it.

This note is applicable for the case in only the same case series where it was saved. It is
not applicable even for the same case, if the case is in a different case series. This note
also gets exported to Microsoft Excel when the Export to Excel functionality is used.
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As shown in the following image, notes of a case series are retained when the case
series merges with another case series. The text in the header "Notes from this series
will be preserved in the merged case series" also displays the same.

CASE SERIES MERGE Actree Guery Rame: Verms OB Makery
ot Saved -

Case Sories £1 (Nates from Mis series wil be
L —

A note can be frozen along with a frozen case series. Therefore, you cannot edit, add,
or delete a note in a frozen case series. Similarly, if a user can access a case series, its
corresponding notes can also be accessed and vice versa.

To use notes in Advanced Conditions, go to Case Series > Cases > Case Annotations.
This field is a free hand text type field and supports single select only.

This Note is not available in Argus Safety and does not impact the case series there.
Using Case Annotations

Use the following procedure to use case annotations in report writer.

1. Go to Case Series Reports > Report Writer > New. The following window is
displayed.

IBM Cagros 8 BI Guery Studio. - liew

IfDcE@m s @ oo b TRE-HIB LR BEPETE & o %|[see WA B P U B E- AE

" ‘Select and insert ens from the tree ko il in the repart.
= Wesminnias Youcan s g e e,

Ui 2 el o sebct i s 1 e e et
Rg-chdk rag e ancings 10 accass conmarly e s,

Tsart wb|

o -

2. In the left frame, expand the Report Writer control tree. The various datamart
views are displayed.
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[ Reportvriter A
= [B]reportviriter
[l Activites - Action Items
@ i Activities - Case Closure
@ [l Activites - Contact Log
@ Jfl Activities - Routing Log
@ [l Add Info - Notes and Attachments
@ [l Additional Information - References
[l Analysis - Case Assessment
@ il Analysis - Comments and Narratives
@ {ilil Analysis - Regulatory Reports
@ [ Case Series
@ {iii Events - Death Information
@ {jfll Events - Diagnosis Event
# {fl Events - Event Assessment
@ [l Events - Event Information
@ [l Events - Hospitalization Info
® il Events - Imputabiity
[l Events - Primary Event
@ [ General - Case Classifications
[ General - Case Follow-up
@ [l General - General Information
[ General - Literature Information
# {ifl General - Reporter Informaton
# {ifl General - Study Countries
@ {ifl General - Study Informaton
@ {iil MedDRA Dictionary - All SOC
@ il MedDRA Dictionary - Primary SOC
= ﬂmmv—m
@ {fl MedDRA Dictionary - S5C

Insert =p

|€

-~
v

3. Under Case Series, click Case Annotation.
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184 Cogros 8 B1 Query Studio - New
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4. Click Insert. This displays all the case numbers that correspond to the selected

SMQ.

16 Cogros 8 BI Query Stdo - New .
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Using Cubes

A Cube is a data model that consists of dimensions and measures. The dimensions
represent key reporting aspects in rows and columns headers of the data model. At the
intersection of each row and column (a cell), the Cube shows a measure, such as case,
report, or event count. In this version of Argus Insight, you access Cubes through the
Cognos® Analysis Studio Web Explorer interface. The interface uses a web browser and
provides access to available dimensions and measures.

Using cubes enables you to run complex queries by selecting various datamart fields
as dimensions and display the output on the fly. You can also select the desired
measures. Use the following procedure to display the exact data you require, you can
add filters, add calculations, drill down hierarchical dimensions, and statistically
analyze the measures. Cubes also let you explore the interactions between different
dimensions by letting you nest dimensions.

Argus Insight lets you create demand Cubes (Cubes on the Fly) based on existing
standard Cubes in Argus Insight. The difference between the two types of cubes is-

Standard Cubes: These cubes are built-on the entire database.
Demand Cubes: These cubes are built on only specific case series for the required data.

The structure of a demand Cube is similar to the structure of the standard Cube you
select to build the demand Cube.

The following topics explain how to work with Cubes.
s Cubes Available in Argus Insight

s Creating Demand Cubes

= Saving Cubes Views

= Refreshing Cubes

Cubes Available in Argus Insight

Argus Insight provides five different Cubes grouped in categories to let you analyze
your safety data from Compliance, Management and Pharmacovigilance perspectives.

Category Cube Name

Compliance Submission Statistics
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Management

Pharmacovigilance

Administration Statistics

Clinical Trial Analysis
Medical Analysis

Overdose-Pregnancy-Interaction

The dimensions available in a Demand Cube depend on the type of analysis that the
Cube lets you perform. The following types of measures are available.

Measures

Case Count

Case Version Count

Record Count

Event Count

Available in

All Cubes in Pharmacovigilance, Management and Compliance
categories.

Available in Management category, Administration Statistics
Cube.

Available in Compliance category, Submission Statistics.

Available in Pharmacovigilance and Management categories.

The sections that follow describe the various Cubes available in Argus Insight. For
information on executing and working with Cubes, see theWorking with Cubestopic.

Compliance Cubes

The Compliance category consists of the Submission Statistics Cube

File Edit View Settings Run Help

DSE@ XooQ b-B 7-I-(5-4- HZ-B &-i- 0P

| Rower: Cohumn::

&Sq.tmﬁm Statistics
# < Case Creation Date

L. Reporting Destination
. DomfFron

-« Inial | Follow-up
+ L Receipt Yeur

£, Submession Indkcator
#, Submission Year

=, Shudy

5L Report Type

L. Reporter Type

+-o% Inbermediary
+ < FatalLT

5L Case Seriousness
L Case Cutcome

#- L Case Causality

SL Case Listedness
L Case Listedness Notes

£ F Case CrastionD... £ Reporting Desti... +

Case Count .|<1eruﬁod> A B C D F G H I 3 L M e ReportingDestination
= [RE'REREAENE-RERERERE-RE- R ] 3
0 0 0 0 0 0 0 0 0 1 0 0 1

2001 0 1] & 7 s 8 7 s 6 12 s 5 14
0020 2 20 18 32 27 18 0 40 18 23 a4
1 & 8 4 5 1w 9 s 6 12 s S 13

1

Case Creation Date 63 TO 32 59 83 T4 59 63 98 59 33 105

# -+ Elapsed Time to Submission (Aware)
# 5L Elapsed Time to Submission (Generate)
# [EMeasures

Submission Statistics

The Submission Statistics standard cube can be generated only for cases that have an
initial or follow-up date within the last 365 days. The Submission Statistics cube lets
you explore these dimensions:

Case Creation Date Year (YYYY) Quarter Reporting Destination Country of Agency Agency

(Q1,Q2, Q3, Q4) Month
Dom/Frgn Country of incidence Initial / Follow-up Initial Follow-up Significant or
Domestic/Foreign indicator (Country of Not

Incidence = Country of Agency or not)
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Receipt Year Year (YYYY) Quarter (Q1, Q2, Submission Indicator

Q3, Q4) Month (Not-Required /Non-Blank/Blank Submission Date)
Submission Year Month

StudyProtocol Number Study Number Report Type: (SR/LIT/CT/PMS- based on derivation

Center Number rule)

Reporter Type (HCP/Non-HCP/Unknown) Intermediary
(Primary Reporter only)

Fatal /LT: Fatal /LT indicator (Any event with Case Seriousness (Serious/Non-Serious)
Death or LT)

Case Outcome (Died/Improving/...) Case Causality (Related / Not Related)
Case Listedness (Listed / Unlisted / Case Listedness Notes
Unknown)

Elapsed Time to Submission(Aware): Time to Elapsed Time to Submission(Generated): Time to
Submission Submission

Management Cubes
The Management category consists of the Administration Statistics Cube.

D@ XowaQ B V-I-fe-2i- [E 2B &0l & B

| | Rows: Columns:
<

¢ Country of Indi... v | & nitialjFollow-... ~
[Eg administr ation Statistics Y I

canrchiididence Case Count Follow-up  Initial | Initial/Follow-up
5. Initial{Follow-up

. Shudy C & 0 6
. Report Type E 2 2 4
% Case Seriousness

<% Case Outcome € ¢ ! 3
-, Case Causality I 3 1 4
<% Case Listedness ] 4 3 7
-, Case Listedness Motes s 2 3 5
=% Praduct Family

%, Time to Entry v 3 18 #
= Time to Central Receipt Country of Incidence 44 28 T2

=it Time to Lock

. Blinding Status

o Site

5 Workflow Status

5 Workflow Group

. Case Creation Date
. Receipt Year

. Lock Date

Measures

S ] = 2 ] = 1 2 o g = = s 2 2 s 2 = 2

Administration Statistics
The Administration Statistics cube lets you explore these dimensions:

Case Creation Date Year (YYYY) Country of Incidence: Country of incidence
Quarter (Q1, Q2, Q3, Q4) Month

Initial / Follow-up: Initial Receipt Year Year (YYYY) Quarter (Q1, Q2, Q3, Q4)
Follow-up Significant or Not Month

Study Protocol Number Study Report Type: (SR/LIT/CT/PMS- based on
Number Center Number derivation rule)
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Case Seriousness
(Serious/Non-Serious)

Case Causality (Related / Not
Related)

Case Listedness Notes

Time to Entry (In days, based on
derivation rule)

Time to Lock

Blinding Status: Unblinded Status
(Blinded / Broken by sponsor /
Broken after study / Open Label
Trial / Not Blinded)

Workflow Status

Case Outcome (Died /Improving/...)

Case Listedness (Listed / Unlisted / Unknown)

Product Family: Family Name (Primary Suspect
Drugs)

Time to Central Receipt

Lock Date Lock Year Lock Month

Site: Master owned by Site

Workflow Group Workflow group User Name

Pharmacovigilance Cubes

Pharmacovigilance (PV) Cubes let you perform data mining for cases based on events,
medical history, cause of death, and other key indicators. The Pharmacovigilance
category has three Cubes: Clinical Trial Analysis, Medical Analysis and
Overdose-Pregnancy-Interaction.

Clinical Trial Analysis

The Clinical Trial Analysis Cube can be generated only for clinical trial cases and
enables you explore these dimensions.

Rows:

¢ Repott Type |+

Case Count IEI DIF |G |I

Compassionate Lise 100 0 2
Mon Relsys Study 00 0 10
Post Marketing Surv. o100 1
Relsys Study ojojz|1|3
Relsys Study, Published 000 2 0
Sponsored Trial 00 0 01
Report Type 11 2 4 7

N o o o o

Columns:

¢ Country of Inci.,. |+

N [P

00

U Country of Incidence

1] 5
1] 1
1] 2
4 12
1] 5
-4 4
6 29

Initial Receipt Date Year (YYYY)
Quarter (Q1, Q2, Q3, Q4) Month

Country of Incidence
Gender

Events: (all events) SOC HLGT HLT
PTLLT

Case Listedness (Listed / Unlisted
/ Unknown)

Case Outcome
(Died /Improving/...)

Event Seriousness: (Yes/No)

Report Type: (SR/LIT/CT/PMS- based on
derivation rule)

Age Group

Relevant History: Description PT

Case Seriousness (Serious/Non-Serious)

Case Causality (Related / Not Related)

Leading Event/Diagnosis: Diagnosis (Yes/No)

Event Death: (Yes/No)
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Event LT: (Yes/No) Event Hospitalized: (Yes/No)

Event Disability: (Yes/No) Event Congenital Anomaly: (Yes/No)

Event Medically Significant: Conservative Event Causality Conservative

(Yes/No) Event Causality (Derived field for the Study
Drug)

Event Listedness Event Listedness ~ Study Drug: (Investigational Products) Family

(for the Administered /Blinded Name Study Number Center Number

Drug and Datasheet with Name

"IB")

Administered Drug Family Name  Drug Type: (Suspect / Concomitant / Treatment)
or "Blinded" <Drug> (Administered
Drug or "Blinded")

Additional Products (only WHO Blinding Status: Unblinded Status (Blinded /
Drugs) Chemical subgroup: ATC Broken by sponsor / Broken after study / Open
Code Pharmacological subgroup: Label Trial / Not Blinded)

ATC Code (ATC Text) <WHO Drug

Name> (Preferred Term)

Treatment Duration - Hours Treatment Duration - Days
Treatment Duration - Weeks Treatment Duration - Months
Treatment Duration - Years Daily Dose Daily Dose

Route of Administration: Route of  Time to Onset from First Dose - Hours
administration

Time to Onset from First Dose - Time to Onset from First Dose - Weeks
Days

Time to Onset from First Dose - Time to Onset from First Dose - Years
Month

Time to Onset from Last Dose - Time to Onset from Last Dose - Days
Hours

Time to Onset from Last Dose - Time to Onset from Last Dose - Months
Weeks

Time to Onset from Last Dose-Years

Medical Analysis

You can generate the Medical Analysis standard cube only for Priority Drugs as
configured by the administrator. The Medical Analysis Cube lets you explore these
dimensions.

D@ Xoad p-B 7-I-G-4- ZZ-8- 4-- O P
| I Rt okt

- £ instial Riociegt.., v § Report Type

[nechcn Anatrsis

: :p’;‘::’:‘: Lo Case Count _]cmns Compassioriste Use  Other PMS  Reguistory Authorky Relsys Study  Rlsys Study, Published  Sponscred Trial

: : :’:Lva‘ ey Initial Reclept Date ﬂ 30 4 2 3 17 4 2 . 1
Initial Receipt Date Year (YYYY) Report Type (SR/LIT/CT/PMS- based on
Quarter (Q1, Q2, Q3, Q4) Month derivation rule)
Reporter Type Country of Incidence

(HCP/Non-HCP/Unknown)
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Age Group
BMI ( as per Derivation Rule)

Events: (all events) SOC HLGT HLT
PTLLT

Case Causality (Related / Not
Related)

DechallengeResult
(Pos/Neg/NA /Unk)

Leading Event/Diagnosis: Diagnosis
(Yes/No)

Event Death: (Yes/No)
Event Hospitalized: (Yes/No)
Event Congenital Anomaly: (Yes/No)

Conservative Event Causality:
Conservative Event Causality

Company Product: Family Name
Product Name

Additional Products (only WHO
Drugs) Chemical subgroup: ATC
Code Pharmacological subgroup:
ATC Code (ATC Text) <WHO Drug
Name> (Preferred Term)

Treatment Duration - Days
Treatment Duration - Months

Daily Dose: Daily Dose

Route of Administration: Route of
administration

Time to Onset from First Dose - Days

Time to Onset from First Dose -
Month

Time to Onset from Last Dose -
Hours

Time to Onset from Last Dose -
Weeks

Time to Onset from Last Dose - Years

Gender
Relevant History: Description PT

Case Seriousness (Serious/Non-Serious)

Case Outcome (Died/Improving/...) (Died is a
derived value based on derivation rule)

RechallengeResult (Pos/Neg/NA /Unk)
Event Seriousness: (Yes/No)

Event LT: (Yes/No)
Event Disability: (Yes/No)
Event Medically Significant: (Yes/No)

Event Listedness: BPI Event Listedness (for all
Company suspect drugs and Datasheet with Name
"BPI")

Drug Type: (Suspect / Concomitant / Treatment)

Treatment Duration - Hours

Treatment Duration - Weeks
Treatment Duration - Years

Indication: (for Company Suspect Drugs)
Indication (for Company Suspect Drugs)
Time to Onset from First Dose - Hours

Time to Onset from First Dose - Weeks

Time to Onset from First Dose - Years
Time to Onset from Last Dose - Days

Time to Onset from Last Dose - Months

Overdose-Pregnancy-Interaction

The Overdose-Pregnancy-interaction standard cube can be generated only for cases
where at least one of the following fields is mentioned: Overdose Interaction

Pregnancy Lack of Efficiency.
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Rows: Columns: Context:

¢ Initial Reciept.., * ¢ Report Typa v

Case Count ICTNPMS Compassionate Use  Other  PMS  Regulatory Authority  Relsys Study  Relsys Study, Published  Spor
I ————

1999 0 1] 0 1] 0 0 2
2001 9 1] 0 1] S 0 1]
2002 17 2 1 3 9 3 0
2003 4 2 1 a 3 1 1}
Initial Reciept Date 30 4 2 3 17 4 2

The Overdose-Pregnancy-Interaction Cube lets you explore these dimensions.

Initial Receipt Date: Case Creation Age Group

Date Year (YYYY) Quarter (Q1, Q2, Q3,

Q4) Month

Gender BMI (As per Derivation Rule)

Relevant History Events: (all events) SOC HLGT HLT PT LLT

Case Listedness: (Listed / Unlisted /  Case Outcome: (Died /Improving/...)
Unknown)

Leading Event/Diagnosis: Diagnosis ~ Event Seriousness: (Yes/No)

(Yes/No)
Event Death: (Yes/No) Event LT: (Yes/No)
Event Hospitalized: (Yes/No) Event Disability: (Yes/No)

Event Congenital Anomaly: (Yes/No) Event Medically Significant: (Yes/No)

Event Outcome (Fatal/Improving/...) -Event Listedness BPI Event Listedness (for all
suspect drugs and Datasheet with Name

"BPI")
Company Product Family Name Drug Type: (Suspect / Concomitant /
Product Name Treatment)

- Additional Products (only WHO Daily Dose Daily Dose

Drugs) Chemical subgroup: ATC Code

Pharmacological subgroup: ATC Code

(ATC Text) <WHO Drug Name>

(Preferred Term)

Indication: (for Company Suspect Route of Administration: Route of
Drugs) Indication (for Company administration

Suspect Drugs)

Time to Onset from First Dose - Hours Time to Onset from First Dose - Days
Time to Onset from First Dose - Weeks Time to Onset from First Dose - Month
Time to Onset from First Dose - Years  Time to Onset from Last Dose - Hours

Time to Onset from Last Dose - Days ~ Time to Onset from Last Dose - Weeks

Time to Onset from Last Dose - Time to Onset from Last Dose - Years
Months

Overdose (as per Derivation Rule) Interaction (as per Derivation Rule)
Pregnancy (as per Derivation Rule) Lack of Efficacy (as per Derivation Rule)
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Working with Cubes

This section provides information about using and executing Cubes. Be aware,
however, that this section only discusses the basic features of Standard and Demand
Cubes. For detailed information, refer to the documentation supplied with the
Cognos8 products.

Refer to the section onCreating Demand Cubesfor detailed information on creating
Demand Cubes

Executing a Cube
Use the following procedure to execute a Cube.
1. In Argus Insight, select Datamart Reports >Cubes > All. The Cubes page displays

all the built-in Cubes in Argus Insight and the Demand Cubes which the group
users have created.

[ ORACLE |ARGUS INSIGHT Armit Aggerweal, Wednesday hiy 21, 2010 (ARGUSHSIGHT). T I L
| T | [emmerrn e T
Dotsmart Reports
Cubes Active Guery Hame:
Active Case Series: testd
Choose Hements
Hame o Description Last Modified Author Category
D0H-0000
004940000 - v
Admaristration Stabistics Adiandstration Statistcs A3-JUL-2010 Ovchs Corporation Managamart
Chinical Trial Anabysis Chnical Trinl Anabysis A13-A0-2010 Crmcle Corporation Pharmacovigiance
MSCH AnBySiE Ml ATy HE 1302010 Oriche Corporation Pharmacovigiance
Overiiose-Pregrancy-ntenction Ovardiss Pregnancy-iesctin 13402010 Ovicte Coepoeation Phamacoviplancs
Subemission Stahstics Submisson Stadists A3-AL-2010 Ovmchs Corporation Comghance

2. Select the Cube you wish to execute.

3. Click Execute. A separate Analysis Studio Explorer window displays the option to
view the cube in either the Default Analysis or Blank Analysis state.
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File Edit Yiew Settings Run Help

DESEHB Xoaq [ b-B- [ TI@EH E-Z-B &0 @8

®

Blank Analysis Default Analysis

Shaow this dialog in the Future

| K || Cancel |

4. Select Default Analysis to view the Cube in the interface similar to the one shown
in the following figure.

Fhe fde P St Btk
DEEHE Koad (k-R- 7-I-G-4- BI-8- &8 EPF

= =

[ =T -I' {vasainmcme. = {tmest Toem =

& . it e Dt [or— ]mu- manse o b Sttty Cates  Puost Mkatng . bwdtary dutherty e

1

] ] 0 0

£ a 8 0 [

£ £ i L] i

B i

sl Brued Date £l ‘ L] ¥
.

Mooaoom

Tip: Alternatively you can select the Blank Analysis option. This is
useful when you want to select the Cube dimensions and measures
based on your analysis requirements.

The Default Analysis option is helpful when you need to perform
Cube analysis on the default dimensions and measures displayed in
the Cube.

The left frame of the Cognos Analysis Studio Web Explorer window displays the
available dimension categories (reporting aspects) in a tree hierarchy.

The Measures folder in the tree structure contains the available measures for the Cube.
The report output area in the right frame displays the Cube structure, which is similar
to a crosstab report. The dimensions from the first two categories appear as rows and
columns in the Cube, respectively. Use the following procedure to explore dimensions
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from other available categories, you can replace the existing dimensions in the Cube or
nest other dimensions with the existing dimensions. You can also filter the output or
drill down the dimensions in the Cube to display specific data.

The sections that follow explain the basic Analysis Studio Web Explorer options that
let you work with Cubes.

Performing Drill Operations

You can drill-down and drill-up hierarchical dimensions to explore different aspects of
your work and to move between levels of information. You can drill-down and
drill-up multiple levels at a time. When you drill-down on a dimension that groups
other dimensions in a row or column, some information may be removed from the
Cube. For example, in a Cube that shows years and quarters asgrouped dimensions,
drilling down on a specific year removes the redundant years levels.

An example to demonstrate the drill functionality follows.

Use the following procedure to drill down to the next level in a hierarchical
dimension, such as Product.

1. Click in the area between the top-left cell (measure cell) and the first header cell of
the dimension row/column as shown in the following figure.

| | Rowsi Cobarmns

R Meclal Anlysis A 7 [nitial Reciept. .. | v ¢ Report Type |»

=% [nitial Reciept Date

Case Counkt Compassionate Like | Other  PMS  Regulatory Autherity

|t
F- Repork Type
= u} u} u} o
E3] z Listedness % Dotll Doy
[+ Reporter Tvpe 2001 E o 0 0 3
= : #]
] Country of Incidence 002 T v 2 1 3 q
[+ =% Age Group !EI .
* . Gender 2003 i 2 ! v :
[+ BML Initial Reciept Date Jo 4 Z 3 1T
¥

. Relevant Hstory i

2. Click the Down a Level icon in the context menu that appears. The Cube output
changes to display the data for all the next level dimensions.

Fows: Colurnns:

g 1999 v ¢ CTNPMS »

Case Count ] CTNPMS
———)
19990 1 0

1999Q 2
1999Q 3

1999 G 4

1999

3. If the dimension has another lower level, you can drill down further by
performing step 2.

4. While the above steps let you display the data for all the lower levels for all the
products, you may change the reporting focus by only displaying the lower-level
data for a specific product. Use the following procedure to do this, simply click on
the dimension in the Cube output.
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Filtering Data

You can select a dimension to filter a Cube in order to reduce the data displayed in the
Cube output. Unlike thedrilloperation, filtering does not change the existing Cube
layout. Instead, it changes the measure values displayed in the Cube output according
to the dimension you select as the filter. An example follows.

In the Medical Analysis Cube, the default row dimensions are from the Initial
Receipt Date category and the default column dimensions are from the Report Type
category. At the intersection of each row and column dimension the Cube displays the
total Case Count. However, instead of viewing the total Case Count for the existing
dimensions, you may wish to view the Case Counts for a specific country of incidence.

Rowst Columns:
¢ Initial Reciepk.,.. |* J ¢ Report Type =
Case Count CTNPMS  Compassionate Use  Other | PMS | Regulatory Authority
1999 o o o o o
2001 9 o o o 5
2002 17 2 1 3 9
2003 4 2 1 o 3
Initial Reciept Date 30 4 2 3 17
Kl

1. While the Medical Analysis Cube is open, the left panel in the Analysis Studio
web browser window lists all the dimension categories available for the Medical
Analysis cube.

File Edit Yiew Settings Run Help |

LEHig XoonQ PRy V-2l [EZ-BEy & ll- &

Insertable Objects Rosesl Calbo
—— | ¢ Emnitial Reciept.... v #| Repart Type v
cal Analysis J
S .
+ o Initial Reciept Date Case Count CINFMS | Compassonate Lse | Other | A5 | Regulatory Authcrity
* < Report Type
+ o Listedness 1999 o 1] 0 0 ]
+ ot Repoiter Type 2001 9 1] 0 0 s
= <% Country of Incidence
_“c"’ 2002 17 2 1| 3 9
\6 o CANEDA B & z| 1] 9 :
) Initial Recicpt Date 30 + 2 3 17
¥ GEG |
&) cam I
B o)
o cmS
4 U

2. Drag and drop Country of Incidence > Canada, from the left-panel into the
Context drop-down list as shown in the following figure.

File Edit View Settings Run Help

DEH@ Xnaq p-B 7-I-fE-4- EZ-B- &-M- QB

| | Rows Columns:
< . . @
¢ Initial Reciept.,, '« ¢ Report Type v
[ medical Analysis e s | P
# <™. Initial Reciept Date
Case Count CTNPMS | Compassionate Use Other PMS | Requlatory Authority
=% Report Type E
# P Listedness 1999 0 0 0 0 0
== Reporter Type 2001 0 o 0 o0 0
=}« Country of Incidence
2002 [u] o 1 0 1
- - C
== CAMADA 2003 [u] o 1 0 1
[+ cmF Initial Reciept Date (1] 0 2 0 2
o -G Kl
+ ]
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3. While the layout of the Medical Analysis Cube remains the same, the data in the
Cube output changes to display the measure values specific to the selected
country. Additionally, the Context drop-down displays Canada to indicate that the
Cube output is filtered by the Canada dimension.

4. You can filter the output further by selecting another dimension as the filtering

criterion.
‘ Rows, Columns: Context:
d | e , |
 Initial Reclept... v £ Report Type 4 I—
W Medical Analysis A DRul Redeet i
S
i< Initial Rediept Date Case Count CTNPMS | Compassionate Use | Other | PMS | Reguistory Authorty | Re| 7% DSiete 1
# < Report Type
4+ . Listedness 1099 o 0 o0 o [ 4
# L Reporter Type 2001 9 0 o o 5 = 4
= . Country of Incidence 5 »
2002 17 2 1| 3 2
= wmC 1 3
e 2003 4 H 1 o 3 : R
+ cmF Initial Reciept Date 30 4 2 3 17 5 »
@ -G <« u »
&) o
5 o) Use as "Go To" Parameter
¥ .S Q Search (Country of Incidence)...
4wy

Removing the Filter

You can eitherresetthe Cube output or click the undo icon or in the Context drop-down
list, right click to view the delete option. For example, to remove the filter described in
the example above, select Country of Incidence>Canada in the Context drop-down
and click Delete.

Conbexk:

T
s XD—E%E .

= B = =@ mom
*r T ¥ v ¥ w w

Use ac "iso To" Parametar

O, Search [Country of Incidence). ..

Replacing Rows and Columns

You may want to replace the existing row or column dimensions with dimensions
from another category to observe the interaction between dimensions from different
categories. Use the following procedure to do this, you can drag a category or a
dimension from the left-panel of the Cognos Analysis Studio Web Explorer window
into the middle of any header cell of the column or row you want to replace. An
example follows.

In the Medical Analysis Cube, the default row dimensions are from the Initial
Receipt Date category and the default column dimensions are from the Report Type
category.
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e Edt view Setwmgs Run bep |
D@ XonaQ p-B- T-I-[E-4- EZ-8- h-l- B 9P

bl Obiect: Eoaws) Cobaming

| £ tokial Reciept... = £ Report Type

I talee Dhjpects
[Egreecnd aratysis i
+ " Irikial Reciepk Diake

# % Report Type

Case Count CTNPMS  Compasionats Use  Other PME  Regulstory Muthorty  Re

H o, Listaciness 1559 i} 0 1] 1] u]
+ +% Reporter Type 2001 9 0 6 0 5
+ - |

etaph oo il 2002 1 2| 1] 2 5
# . Age Group
b B Gand 2003 1 2| 1| o 3
# LB Initial Reciept Date | 30 4 2 3 17
4. Redevank History |

Use the following procedure to replace the existing row dimensions.

1. With the Drug Type dimensions, select and drag the Drug Type dimension from
the left panel to the middle of any row header cell in the Cube.

2. The existing row dimensions in the Cube are replaced with the Drug Type
dimension.

File Edit View Settings Run Help

DG Xonad b-B 7-I-f5-5- EE-B- &-l- @ ®

| Rows: Coburna:

't Dbject | ;
ﬁmﬁcd T Combination - | .__Rgport Type =
£+ Iriisl Reciept Date Case Count CTNPMG  Compassonatese | Other | PMS | Regulatory futhority
4 <™ Report Type
4 < Listedness 1999 [} 1] 1} [1] o
#-FL Reporter Type 2001 9 o o o 5
= |
#- < Country of Incidence e s i 5 5
o Age Group
4 . Gander 2003 4 2 10 3
4 L BMI Initial Reciept Date 30 4 2 3 17
4 . Relevant History | ————
Suspect 29 4 0z 16
# L Events |
# < Case Seriousness ‘Concomitant 3 ] 2 1 1
# % Case Cousalty Treatment o o 2 o 1
- |
# <%, Case Oubcome Drug Type 30 4 2 3 17
# ot Dechallenge Resuk Al

# "% Rechallenge Resul

41 <. Leading Event/Diagnosis
#-FL Event Seriousness

# -« Event Death

# " Event LT

#-<% Event Hospitalized

##% Event Disability

3 <=, Event Congenital Anomaly
4 <. Event Medicaly Significant
&< Conservative Event Causality

Similarly you can replace the existing column dimensions with other dimensions.
You can also replace the existing row/column dimensions with a single category
from a dimension by dragging the category from the left panel into the middle of a
row /column header cell.

Grouping Multiple Rows and Columns by a Dimension or Category

You can have multiple rows and columns in a Cube by dragging additional entities
(dimensions or categories) from the tree structure into the Cube. When you add a new
entity to a Cube, the output is automatically grouped to let you view data easily. Row
grouping happens by the leftmost row entity and column grouping happens by the
topmost column entity.
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Obtaining a New Row Grouping
Select an entity from the tree structure in the left frame of the Analysis Studio Web

Explorer window and drag it into the left or right edge of the row header area within
the Cube.

The Cube output refreshes to show the grouping depending on the edge of the row
header area where you dragged the new entity.

G

Gt e Gt el Yo

Selected Entity Dragged to Left Edge of Row Header Area

b e ! .
6 .
Cane {ourt. E} *
o vaksrs ® .
o '
Dhnded ¥ Ll
ety ek ® »
® '
Dewhcn By Sponsor 1 H
ot Sndded ° *
< Ungrufied - C
'
.
.
6
s
[
.

Row Grouping Obtained

# 1 Study Center ID
Selocted Entity

Selected Entity Dragged to Right Edge of Row Header Area

Row Grouping Obtained

Obtaining a New Column Grouping
Use the following procedure to obtain a new column grouping.

1. Select an entity from the tree structure in the left frame of the Analysis Studio Web
Explorer window.

2. Drag the entity to the upper or lower edge of the column header area in the Cube.

3. The Cube output refreshes to show the grouping depending on the edge of the
column header area where you dragged the new entity.

ot Seriows Seros
Case Count:
S (el (ually  Gse (el OnCasity
. ] ] | ]
Eirded 1 [} 1 1 i
rgken by '
et ? ] ] ] '
rskrn By Spontor ! ! 3 !
Selected Entity Dragged to Upper Edge of Column Header Area St Binded 1 ] 1 H "
Ansgecked 1l E:J “ 7 q
Columnar Grouping Obtained
Selected Entity
L (et b L (oot Yes
Case Count
i vaoes
Yot Sevoy Sorious Cane Seriows. Yol Serwuy Sevioes (ase Serioes.
lnded 1 2 ] 4 4
broken By brvestigalee L 2 L} L "
ruken By Sponser L ] 1 e 1
it e 12 3 [ "
Selected Entity Dragged to Lower Edge of Column Header Area igpeofied: [ 7 " 5 W L]
[ W I — L —

Columnar Grouping Obtained
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Removing a Dimension Row from a Cube
Use the following procedure to remove a dimension row from a Cube.

1. Click in the white space between the top-left cell (measure cell) and the first
header cell of the dimension row.

Rows: Cohamns: Context
Combination v ¢|Repart Type|> <"
Case Count CTNPMS | Compassionate Use | Other
[— e
1999 Properties o 0 0 ° 2 .
| {| P save as Custom Set...
sl || % Delete 0, 0 S 0 0 0
2002 —dm 1| 3 9 3 0 o
2003 T Topor Bottom » : = s . o 0
 FEiker 3

Initial Reciept Date J A | 2 3 17 4 2 1
— R 4

Suspect o 2 16 4 2 1

| Totals and Subtotals,.. |
Concomitant E S F 1 1 1] 1] o
| & Summarize v
Treatment 2 1] 1 0 1] 1]
= E Caloulate, .,
Drug Type | 2 3 17 4 2 1
Expand Report Type | I
Down a Level

2. In the context menu that appears, click the Delete icon to delete the dimension
row.

Removing a Dimension Column from a Cube 1.
Click in the white space area between the top-left cell (measure cell) and the first
header cell of the dimension column.

2. In the context menu that appears, click the Delete icon to delete the dimension
column.

Creating Charts
You can display a Cube as a chart to graphically see patterns and trends in data.

1. Perform the necessary operations on the Cube to get the desired reporting focus.

2. Click the arrow next to the Chart icon on the Analysis Studio Web Explorer
toolbar. A context menu displays the available chart types.

Using Cubes 8-15



Using Cubes

Column Chart
Bar Chart

Pie Chart
Line Chart
Pareto Chart

v v vy v v

Colurnn-Line Chart

Area Chart »
Radar Chart »
Point Chart

FFOREER oME

Show Values on Chart

3. Select a chart type from the context menu, as appropriate. The report output
refreshes; the chart is displayed.
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Swapping Rows with Columns

You may want to swap the rows with columns in a Cube that has few rows and many
columns. This improves the readability of the Cube output.

Use the following procedure to interchange rows and columns in a Cube, click the
Swap icon on the Analysis Studio Web Explorer toolbar. If there are multiple/grouped
rows or columns in the Cube, the outermost rows become the outermost columns, and
the outermost columns become the outermost rows.
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Exporting the Cube Output to Specific Formats

You can export the Cube output to formats, such as PDF, XLS, CSV and XML and save
the file on the local machine.

1. Perform the necessary operations on the Cube to get the desired reporting focus.

2. If required, change the Cube layout to a crosstab or chart ,as appropriate .

T

Crosstab
Zhart
e Crosstab and Chart

3. Click Run in the Analysis Studio Web Explorer toolbar. A context menu displays
the available export options.

Run

P RunReport (HTML)
Run Report (PDF)
Run Report (Excel 2000 Single Sheet Format)
Run Report (Excel 2000 Format)
Run Report (Excel 2002 Format)
Run Report (C5Y)
Run Report (ML)

Repork Opkions...

4. Select the desired run option. The file appears in the selected format in a new
window.
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Changing Measures

B Save a Copy || Print e Email ﬁ Search '3 ‘-'v'—'J Reviev & Comment ~ Z Sign -
o | Trig _EE@ .y . - . . 15
(] Tiseeree - @ @ - ) D] @© 7% - ® 103 &
i3
jﬁ" ~
T
5 3z Report Type
2 W CTNPMS
? 28 M Com
W Other
] BMS
g 24 W Regulatory Authority E
£ W Relsys Study
5 2 20 H Relsys Study, Published
e g [ Sponsored Trial
,57 =3 M Spontaneous
@ Y s
5 2
E 8 u
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-
a 4 I ]
H AN IET AT | TR
g 1999 2002 Suspect Treatment
© 2001 2003 Concomitant -
Ve EhEad hm mim ks P Prram Foomm |4
& o] sSxilin
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The reporting focus of Cubes that have multiple dimensions available can be changed
by replacing an existing measure within the Cube with another measure. For example,
Pharmacovigilance Cubes have both Case Count and Event Count as available

measures. While the default

measure displayed in these Cubes is Case Count, you can

replace it with Event Count to change the reporting focus.

1.

In the left panel displayed in the Analysis Studio Web Explorer window, select
Measures. The measures available for the Cube are displayed.

Row: Cohumns: ontex

. Event Seriousness
3 . Event Death
# L Evert LT

# . Event Hospkalzed 1999 o o 0 0 o o z 1
& oL Event Disablity 2001 9 o o o 5 0 0 o
# % Event Co sl 1

venk Congental Ancmely 2002 | 7 z 13 a 3 o 0
& S Event Medcally Sinficant |
% . Conservative Event Causally 2003 | 4 2 10 3 ! ] ]
31 . Event Listedness Initial Reciept Date 30 o 2| s 17 P 2 1

3 Company Product
. Drug Type

l‘ £ Intial Rediept. .. ~ £ Report Type ~ )

A

Case Count Icwms Compassknate Use | Other PMS  Reguistory Authorty Relsys Study | Relsys Study, Publshed | Sponsored Trisl - Spontaneos

H

4| |

. addrional Products
# % Treatmen Duration «
# %, Treatment Duration -
3L Trestment Durstion - Wesks
<31, Treatment Duration - Months
4%, Treamen Dueation - Years
3 Dady Dose:

# . Indication
# % Route of Adminstration
# <. Time to Onset from First Dose -
& o1, Teme to Onset from First Dase -
# <22 Time to Orsset from First Dose -
# <%, Time to Onset from First Dose -
1 % Time bo Onaat From First Dose -
# <%, Time to Onset from Last Dose -
4<% Time to Onset from Last Dose -
% Time o Oriset From Last Dose -
4 5. Time to Onset From Last Doss -
% Time to Orset From Last Dose =
5 [BMeasres

[LCase Count

[LEvent Count

2 @

Hou's
Days

Hours
Days
Wesks
Months
Years
Hours

Weeks

Morihs
ears

3

2.

Click and drag the category required under Measure. Alternatively you can also
right-click the measure in the cross-tab output and select the required option.
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1999 Chanju:;'1~| Default Measure P Case Count | ©
2001 38 Event Count |0

3. The crosstab output is refreshed; Event Count is the new measure added to the
Medical Analysis Cube.

‘ ‘ [ Columns: Context:

~ ¢ Einitial Redept... ~ J é report Type '~ N
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[#-cT Event Medically Sigrificant
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[#<% Company Product A o
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2003 10 8 5 0 8
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<, Treament Duration - Years

®

£ Daily Dose
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®

2 Route of Administration

I

<2 Time ta Onset from First Dose - Hours

&

<% Time to Onset from First Dose - Days
< Time to Onset from First Dose - Wieeks

=

2. Time to Onset from First Dose - Morths
-+ Time to Onset from First Dose - Years
<% Time to Onset from Last Dose - Hours
<% Time to Onset from Last Dase - Days
&< Time to Onset from Last Dose - Weeks
<% Time to Onset from Last Dose - Months
<% Time to Onset from Last Dose - Vears
= [E Measures
[L,Case Count

Modifying a Cube

Use the following procedure to modify a cube.

1. In Argus Insight, select Datamart Reports >Cubes > All. The Cubes page displays
all the built-in Cubes in Argus Insight and the Demand Cubes which the group
users have created.
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ORACLE' |ARGUS INSIGHT Amit Aggarswal, Wiednesday s 21, 2010 (ARGUSIHSIGHT)
- == O —

Dotamert Reports

Cubes Active Query Hame:

Active Case Series; lest3
Choose Elements [ Searcn T Ceewr |
Mame 2 Description © LastModified ~ Author Category
00-1044-0000
[ 00-MM-0000 | k| v

Ackinistroficn Staistics Admiistrtion Safistics 1302010 Oracle Corporation Menagement

Clrical Trisl Analysis Clrical Tril Anaiysis 132010 Oracle Corporstion Prarmocovigiance

Medcal Analysis Medcal Ansiysis 1302010 Oracle Corporstion Prarmocovigiance

o Interscli o 13002010 Gracle Corporstion Pharmacovigiance

Submission Sttistics Submission Statistics 1302010 Oracle Corporstion Complance
I | I | T || e | | [Permissions | [ Execue |

2. Select the required Cube and click Modify.

3. The Modify cube interface appears. This interface helps you to capture
information to modify the Demand Cube.

a Argus Insight - Standard Cube Properties -- Webpage Dialog

Standard Cube Properties

Report Hame Author

|Clinic:al Trigl Analysiz | |Orac:|e Corpaoration |
Initial Creation Date Modify Date

[i3-00L-z010 | [r3-Juczomo |
Category

|Pharmacovigilance |

Description:

Clinical Trial Analysis

= Expiration Date informs you about the expiration date of the cube. You are
notified when the expiry date is due and you can save or delete the existing
cube as per preference. This field is visible only for Demand cubes.

= Initial Creation Date captures the date when the Cube was loaded in the
repository for the first time.

= Modify Date captures the date when the Cube was last modified.

= ETL Run captures the date of ETL run on which the case data is based. This
field is visible only for demand cubes. This field is visible only for Demand
cubes.
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= Case Series captures the name of the case series on which the cube was built.
This field is visible only for Demand cubes.

Deleting a Cube
Use the following procedure to delete a cube.
1. In Argus Insight, select Datamart Reports >Cubes > All. The Cubes page displays

all the built-in Cubes in Argus Insight and the Demand Cubes which the group
users have created.

Note: Standard Cubes cannot be modified/deleted.

2. Select the required Cube and Click Delete.

3. The Delete cube confirmation dialogue appears. Click OK to confirm the
operation.

5 Argus Insight - Delete Cube -- Web Page Dialog | X

Delete Cube

@ Are you sure you want to delete this cube?

Setting Access Permissions

You can set group-level access permissions for the Demand Cubes. This determines
which user groups will be able to view, modify, or delete a Demand Cube.

Note: You can set permissions only on Demand Cubes you have
saved to the system.

Use the following procedure to set Demand Cubes permissions.
1. Inthe Argus Insight page, select the Datamart Reports > Cubes > All

2. Click Permissions. The Permissions dialog box appears. A list in this dialog box
displays the names of all the groups (except the Administrator group) that the
system administrator has created.
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Workflow_Testing
w
Ok ‘ | Cancel

3. Use the list box next to a group name to assign permissions to the group members
on the Demand Cube you have selected. You can select from these options:

Permission Description
No Access (Default)  No group members will be able to access the Case Series

Full Access You can modify/delete /view the Cube

4. Click OK. The system saves the permission settings.

Creating Demand Cubes

Argus Insight lets you create demand Cubes based on existing standard Cubes in
Argus Insight. The structure of a demand Cube is similar to the structure of the
standard Cube you select to build the demand Cube. For more information on
performing operations on Cubes refer to the section onWorking with Cubes.

Demand Cubes are based on a specificCase Seriesinstead of the entire datamart.
Therefore, you can use demand Cubes to analyze a reduced data set based on a
specific Case Series and quickly obtain the desired reporting focus without having to

Using Cubes 8-22



Using Cubes

drill down or filter data. However, this feature makes the demand Cubes static, which
means that each time the Case Series is modified, you need to delete the demand Cube
and create a new one.

1.

In Argus Insight, select Datamart Reports >Cubes > All. The Cubes page displays
all the built-in Cubes in Argus Insight.

Select the standard Cube using which you wish to create the demand Cube. The
Cube name is highlighted; the Build button becomes active.

Click Build. The Cube Properties dialog box appears.

a Argus Insight - Build Cube -- Webpage Dialog

Cube Properties

Cube Hame: | |
Description:
Case Series: | active Caze Series v
Case Series
Description:
Author Hame:
Building cube
from:
Standard Clinical Trial Analysis
Categony Pharmacovigilance
| Buig Cube | | cancel |

Enter the demand Cube name in the Cube Name text box.
Enter the demand Cube description in the Description text area.

Use the Case Series list box to select the Case Series on which you want to create
the demand Cube. The description of the selected Case Series appears in the
associated Description text area.

Click Build Cube. The Cubes - Build dialog box notifies you that the Cube has
been scheduled for generation on the Cognos8 server.

2} Argus Insight - Cubes - Build -- Web Page Dialog | X|

Cubes - Build

@ Your Cube has been scheduled for generation.
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8. Click OK. The Cubes page displays the demand Cube name in grey.

9. When the Cognos8 server generates the demand Cube, the Cubes Generated
dialog box notifies you. After the Cube is generated, you can execute it by
selecting the Cube name and clicking Execute.

Cube Generated

Cube-on-the-fly has been generated: Your personal cube
| "Medical &nalysis 2005" is ready.

Note: The maximum number of cases for creating Demand Cubes is
configured on the List Maintenance items.

Demand Cube Life Span

Demand Cubes have a limited life span on the system. The system deletes the demand
Cube after 14 days (default) from the date of creation. You can configure the
Cube-on-the-fly Lifespan list maintenance item to set the expiration period.

Modify Attribute I

Attribute
| CUBE-ON-THE-FLY-LIFESPAHN

Value
Key
CUBE_LIFESPAN

Description
The default lifespan (in days) for the cubes crested on | =
he fly based on & case series.

| Ok | | Cancel |

When the demand Cube has reached the expiration date, the system notifies you
through the following dialog box.
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Cube Save - Continue
Cube-on-the-fly has expired: Your personal cube
"Medical Analysis 2005" has expired.

Do you wish to save this cube for another 14 days or
delete now?

| Delete |

At this point, you can either delete the demand Cube or retain it for another 14 days

(default).

Saving Cubes Views

This section describes the procedure to save Cube views (based on the drilled-down

data).
Use the following procedure to save Cube views.

1. Click Datamart Reports->Cubes All to view all the cubes

ORACLE [ARGUS INSIGHT Wednesday Juby 21,

e I I I |
Dntamart Reports:
Cubes ‘Active Query Name:

Active Cose Series: test3
Choose Eiements [Semch J e ]
Mome o Description Last Modified Author
04040000
1 o0 ] = ]

Admsretin Staistes Armisraton Siastc: 1302010 Cracle Corporation Mansgemert
Clvical Trsl Anaiysis Curical Tral Ansiysis 132010 racle Corporation Framacovigiance
Wedical Ansysis vedical Andlyses 1302010 Oracle Corporation Franmscovigiance
Overdose Pregnancyrteraction Overdase Pregrancy-teraction 130200 Gracle Corporation Phammacoriance
Subnission Sttistics Sumission Statistcs 1302010 Oracle Corporation Conglance

Lerenesn | oy | | | [permissions | | execuas |

Tip: You can also search for specific Cubes by using any of the search

options displayed on the screen.

2. Select the Cube view that you want to save. The name of the cube is highlighted.

3. Click Execute. The Cognos Analysis Studio web explorer is displayed.
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o e
< g m
e ~ ¢ manesn.. | framtrmes
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# . Report Type
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4. Perform the desired drill through operation. The cube view is displayed
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5. From the File menu, click Save. The Save As dialog appears.
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L@ ]|

armes

_' Save Cancel |

6. Select My Folders>CubeViews to save the cube view in the CubeViews folder.
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Tip: If the CubeViews folder is not visible, create the CubeViews
folder by clicking on the create new folder icon.

When naming the folder, do not leave a space between the letters.

7. Enter and save the Name of the Cube view. The Cube view is now saved.

cm Recovered
‘ X
Save in: [ cube Yiews - cl
Public Folders
= Unchanged
= Unknown
My Folders
o Worsened
# = Leading Event/Diagnosis 8
# <= Event Seriousness
= <= Event Death v
% @ Clirical TrialView
‘ 2 | Save Cancel

Viewing Saved Cubes
Use the following procedure to view the saved Cube view.

1. Click on Datamart Reports ->Cubes -> Library option. The Cube view name
appears in the list of cubes saved in the library.

Note: Standard Cubes: If the data mart has been updated since the
last saved view, the information displayed within the cube will reflect
the updated data as the view of the Cube is saved.

Demand Cubes: If the data mart has been updated since the last
saved view, the information displayed within the cube will remain
static as it is based on static case series.

The Cube views can only be viewed by the owner or author of the Cube View.

Refreshing Cubes

Although the ETL process updates the datamart on a regular basis, you need to
separately update each Cube after the incremental ETL process is completed. Use A
batch process needs to be set up to update the Cubes installed as part of the Argus
Insight application. The batch process performs the following tasks:

= Updates Cube data- the data in the Cube is updated with the latest data from the
datamart

= Copies the updated Cubes in the backup folder- the updated Cubes are copied
into a backup folder that contains subfolders for each Cube; the backup folder
path is: <Argus Insight Installation
path>\PowerReports\cognos\backup\PPESCubesFor example:C:\Program
Files \Relsys\PowerReports\Cognos\backup\PPESCubes

s Copies the updated Cubes in the published folder - the updated Cubes are copied
into the published folder at this location: <Argus Insight Installation
path>\PowerReports\cognos\PPESCubes For example: C:\Program
Files\Relsys\PowerReports\Cognos\PPESCubes

Individual tasks need to be scheduled to update each Cube. Use the following
procedure to improve the performance of the batch process, make sure that
individual batch execution processes do not overlap with each other.
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Note: Demand Cubes are refreshed sequentially.

Setting up Batch Generation through Task Manager
This section provides instructions for scheduling batch generation using Windows
Task Manager. You must perform this procedure for each of the five Cubes.

1. On the Cognos8 Server, select Start > Settings > Control Panel. The Control Panel
window appears.

2.

| Fle Edit View Favorites Tools Help
J J Back r \_) r I’A 7 ' Sgarch i Folders g
IRQ&BSS |E}' Control Pangl
_I\_I;g_ne i | Comments
'_ﬂm:a Filter Configures speaker ..,
(_‘)Accessi)ility Opti,,.  Adjust vour comput. .,
M Add Hardware Installs and trouble...
Lhadd or Remove P... Install or remove pr...
4 administrative Toals Configure administr...
[!l Adobe Gamma Calibrate monitor fo...
“ Automatic Updates  Set up Windows to ...
7 Date and Time Set the date, time, ...
é-DispIay Change the appear...
/) Falder Options Customize the displ...
@Fonts #dd, change, and ...
‘@ Game Controllers  Add, remove, and c..,
lj’lnl:ernet Options Configure your Inke. .,
2. Java Plug-in Java Plug-in Control..,
FmKeyboard Customize your key...
£ypail Microsoft Outlook ...
)Mouse Customize your mo...
@r,Netwurk Connect... Connects to other c...
€ NVIDIA nview De,.. Configure your NVT...
LPhone and Mode,.. Configure your tele...
%y Power Options Configure energy-s...
© JPrinters and Faxes  Shows installed prin...
@ QuickTime Configures QuickTi...
Q Regional and Lan,,. Customize settings ...
< Scanners and Ca...  Add, remove, andc...
[f)scheduled Tasks Schedule computer ..,
@ Security Center View your current s...
@, sounds and Audi,..  Change the sound s...
afSpeech Change settings for...
W System See information abo. .,
aTaskba and Star... Customize the Start...
8 User Accounts Change user accou...
&Windom Firewsall Configure the Wind..,
i Wireless Metwork,.. Setuporaddtoa...
|34 abjects

Double-click the Scheduled Tasks item. The Scheduled Tasks window opens.
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J File Edit ‘ew Favorites Tools Advanced Help

@

Q- Q- 1Y

P Search u_ Folders

5 5 X 9

!.
3

J Address Ihﬂ Scheduled Tasks

H8e

Mame = | Schedule

| Mext Run Time | Last Run Time |

|21 add Scheduled Task

<] |

2

3. Double-click the Add a Scheduled Task item. The Scheduled Task Wizard starts.

Scheduled Task Wizard

to perform.

and then schedule it for a convenient time.

Click Mext to continue,

Thiz wizard helps you schedule a task for Windows

You zelect the program you want Windows ta run,

Cancel

4. Click Next. The next screen of Scheduled Task Wizard appears.
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Scheduled Task Wizard E3 |

Click the program pou want Windows to run.
To see more programs, click Browse.

Application Wersion | :I
@Access Manager - dministrat... i 7.3.631.0 —
@Access Manager - &dministrat... 7.1.322.10
QAccess Manager - Batch Mai.. 7.3.631.0
QAccess Manager - Batch Mai.. 7.1.32210
Access Manager - Configurati...  7.3.631.0
Access Manager - Configurati..  7.1.322.10
B Acmcnn hd manmmmr D mmiabe mbim FacMn ll

Browse. .. |

| Cancel |

5. Click Browse. The Select Program to Schedule dialog box appears.

Look i | ‘3 BatchGeneration-Cubes

~| « EcfE

File name:

Files of type:

ﬁlcul:le_generation_driver_cube_g. sql

1L cube_generation_driver_cube_3.sql
L cube_generation_driver _cube_4.sql
Lcube_generation_driver_cube_5.sql
L cube_generation_driver_cube_6.sql
ﬁ[ cube_generation_driver_cube_7 sql
5:'"31 cube_generation_driver_cube_g.sql

[ Generatetubes.bat
4 GenerateCubes. cfg

2

]F'mglarns

E3

Open |
Cancel _

Navigate to the following location: <Argus Insight Installation

Path>\PowerReports\Cognos\Cubes\BatchGeneration-Cubes

Select the Cube_Generation_Driver.bat file.

Click Open. The next screen of Scheduled Task Wizard appears.

Using Cubes 8-30



Using Cubes

Scheduled Task Wizard x|

Tvpe a name for this tagk. The task name can be
the zame name as the program name.

]Medical Analyziz

Perform this task:
Daily
Weekly
Tonthly

Ore time only

0,00 0 [0,

when my computer starts

P o

“When | log on

Cancel

< Back | Nest » |

9. In the text box for entering the task name, type Cube Generate 1. The task name
should be entered in the format Cube Generate <Cube ID>. The Cube IDs are
listed in the table below.

Cube Name Cube ID
Medical Analysis 7
Clinical Trial Analysis 8
Overdose-Pregnancy-Interaction 9
Submission Statistics 10
Administration Statistics 11

10. Use the Perform this task option button group to set the frequency of the task, as

appropriate.

11. Click Next. The next screen of Scheduled Task Wizard appears.

Scheduled Task Wizard E3

Select the time and day pou want this task to start.

Start time:
EazPv =

Start date:

I 741372005 "'I

< Back I Mext » I

Cancel
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12. Set the start time and day.
13. Click Next. The next screen of Scheduled Task Wizard appears.

Scheduled Task Wizard Ed

Enter the name and password of a user. The tagk will
run as if it were started by that uzer.

Enter the user name: |SHVENGINDDDSM&dministrE

Enter the password: I““‘“‘"’“‘

Confirm password: |xxxxm1

< Back I Mext » I Cancel

14. Enter the user name and password of the user authorized to run this task.

15. Click Next. The next screen of Scheduled Task Wizard appears.

Scheduled Task Wizard E3 |

You have successfully scheduled the following task:
Cube_Generation_Driver

Windows will perform this task:
At 832 PM on 741342005

Open advanced properties for this task when | click
v =5
Finizh.

Click Finish to add this task to your Windows schedule.

< Back I Finizh I Cancel

16. Check the Open advanced properties for this task when I click finish checkbox.
17. Click Finish. The dialog box for setting advanced properties for the task appears.
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Cube Generate 1 ilﬁl

Task IScheduIe] Settings | Securty |

ﬁ C:\Program Filez'\R elsyshPowerReportz\CognoshCubeshCube...

Run: IE:'\F‘rogram Files\Relsyz'\PowerReports\CognoshCubesh,

Browsze... |

Start in; ID'"
Comments;
R un as; SERVINDENGODZ Administ __ gel password_ =

I” Runonly if logged on
|v Enabled [scheduled task runs at specified time]

0K Cancel Apply

18. In the Run text box within the Task tab, enter the run-time parameter for this task
in p[the following format: <Argus Insight Installation
Path>\PowerReports\Cognos\Cubes\ BatchGeneration-Cubes\Cube_
Generation_Driver.bat" <Cube ID> <Cognos user name> <Cognos password>
where CubelD is the ID of the Cube for which you are scheduling the batch
generation, Cognos user name is the user name of the Cognos admin user, and
Cognos password is the password for the Cognos admin user. Include the double
quotation marks (" ") while entering the runtime parameter. The following table
lists the Cube ID for each cube and provides examples of the run-time parameter
to be entered.

Note: The Cognos administrator password is blank in the following
examples.

19. Click Set Password. The Set Password dialog box appears.
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Set Password K E3

Ixxxxxxx

Password:

: p—
Confirm password: I 1

| oK I Cancel

20. Enter the password for the Cognos8 Server admin user.

21. Click OK.

22, Select the Schedule tab. The Schedule tab page appears.

Task  Schedule ISe{lingsl Securilyl

ﬁ At8:32 PM on 7/13/2005

Schedule Task: Start time:
[ S— - | | 8:32 PM =1 Advanced.. |
r Schedule Task Once
Bun on: IWednesday, July 13,2005 j

™ Show multiple schedules.

ITI Cancel I Apply

23. Set the schedule options, as appropriate.

24. Select the Settings tab. The Settings tab page appears.
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Task | Schedule Settings ISecul}ll

— Scheduled Task Completed

[~ Delete the task if it is not scheduled to run again,

¥ Stop the task if it runs for. |1 = hour(s)|D

ﬁ minute(s),

—Idle Time

[~ Only start the task if the computer has been idle for at least:
I _l: mitute(s)

If the computer has not been idle that long, retry for up to:
I _l: mitute(s)

[~ Stop the task if the computer ceases to be idle.

— Power Management

¥ Don't start the task if the computer is running on batteries.
¥ Stop the task if battery mode begins.

[~ ‘Wake the computer ta run this task.

0K | Cancel |

Apply

25. In the Scheduled Task Completed and Power Management sections, set the

options as shown in the figure above.

26. Select the Security tab. The Security tab page appears.

Task I Schedulel Settings SEUJFitPI

€7 SYSTEM —

................... I |
@ Administrators (SRVEMNGINDOO3\Administrators) |

Permizzsions: Allow Deny
Full Control M O
Modify O
Read & Execute |
Read |

Write O

Advanced... |

u Allowe inheritable permissions from parent to propagate to this
object

P 0 = [ =0

27. Verify that the user has full permissions assigned.

28. Click OK. The system creates the new scheduled task Cube Generation 1. Repeat

the above steps to schedule batch generation for the remaining cubes.
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Viewing Dashboard Indicator Reports

Dashboard Indicator Reports

Dashboard Indicator reports are special reports that provide an insight into key
parameters that let you monitor product performance and workflow efficiency. These
reports are generated directly from the datamart so they display the latest data.

Argus Insight has three Dashboard Indicator reports: Executives, Reporting, and Data
Entry. Each of these reports consist of a number of sub-reports, as the following table

shows.
. Sub Report
Dashboard Indicator
Report Name Description
Executives Executives Profile This report provides a tabulation of case

count for each site. The total count of
serious cases for all sites is also listed.

Top 5 Products This report is a listing of the top 5
products having the largest total case
count sorted in descending order. The
serious case count for each product is
also listed.

Cases in Workflow This report is a graphical summary of
the initial, follow up, and total case
count in each workflow state.

Late Reports This report is a detailed listing of all
cases for which reports are past the due
date. Days past due are provided for
each destination.

Reporting Compliance This report provides a graphical
overview of reporting compliance count
broken down by days remaining to due
date and days past due date.

Receipt Latency This report provides a graphical
overview of receipt latency (from initial
receipt date to central received date) by
country of origin.
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Dashboard Indicator

Report

Sub Report

Name

Description

Reporting

Data Entry

Reporting Profile

Reporting Compliance (Count)

Reporting Compliance (Percentage)

Outstanding Submissions by
Responsible Group (Summary)

Outstanding Submissions by
Responsible Group (Listing)

Data Entry Profile

Receipt Latency

Cases in Workflow

Case Load

Case Workload by Site and Country

This report is a summary of scheduled
report and past due report count for all
the reporting groups.

This report provides a graphical
overview of reporting compliance count
for each reporting destination. The
counts are broken down by days
remaining to due date and days past
due date.

This report provides a graphical
overview of reporting compliance
percentage broken down by days
remaining to due date and days past
due date.

For the selected reporting groups, this
report shows the outstanding report
count by reporting destinations. Against
each destination, the outstanding
reported count is further broken up in
these groups:

- Due in greater than seven days - Due
in 3-7 Days - Due in 0-2 days - Past the
due date

This report provides a detailed listing of
cases for which report submissions are
coming up.

The listing is grouped by the
responsible group. Within each group,
the listing is sorted in ascending order
of days remaining for submission.

This report provides a tabulation of case
count for each site. The total count of
serious cases for all sites is also listed.

This report provides a graphical
overview of receipt latency (from initial
receipt date to central received date) by
country of origin.

This report is a graphical summary of
the initial, follow up, and total case
count in each workflow state.

This report provides a tabulation of
cases received, cases in processing, and
pending case counts for each workflow
state.

This report provides a tabulation of
serious, non-serious, and total case
counts grouped by site. For each site,
the counts are displayed for each
country.

Depending on your profile and reporting requirements, the system administrator
configures and assigns a specific Dashboard Indicator report to you.
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To view the pre-configured Dashboard Indicator report assigned to you, select
Datamart Reports > Dashboard Indicator. The report (PDF format) opens in a
separate browser window. The samples for each report type are provided below:

s Executives

~—
T Dashboard Indicators
—
— 21-JUL-2010 12:09 GMT+5:30
Executives
Profile: USER Cases In Workflow
120 Inttal
Germany E Fotoap
Jay 1 ot
?an a3 100 |
United States
80
Serious: 242 60
40
20
0 ol ull r-.rll'l
TR
EREREE
.
H
Top 5 Products Reporting Compliance
B o senzane
Pos  Product Total  Serious =j:=
1. Cure All 208 115 ¢ =W
2y
2. Wonder Drug 73 41 =
3 Diabpen 55 34 ED:;
Jod 2o
4 MMR 26 10 e

= Reporting
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— Dashboard Indicators
\\\ 21-JUL-2010 1213 GMT+5:30

Reporting

Profile: USER

Administrator Group -

Central Administrator -

Germany Bookin -

Germany Expedited Reporting :-
Japan Data Medical Review -
United States Reporting -

Scheduled: 2230
Past Due: 0
Reporting Compliance (Count)
45 [ o= man s ys
a0 =j::
35 R
[
30 o
25 me=
. 1ovar
20 Wz
.30'&(
15 Wi
10 W=
| | .molema'\ 5 over
o Lkl nrw

88 ¢ F§ EE§ @ i F § g £ 8§ ;88 g gLg§é
SERSR SRS RS RE RS R REEE

s Data Entry
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Dashboard Indicators

21-JUL-2010 12:18 GMT+5:30

Data Entry
Profile : USER
Germany
Japan
256
United States
Serious: 145
Receipt Latency
250 . Unk
. 0 days
. 1 days
200 . 2 days
. 3 days
150 [ 4 days
. 5 days
H -15 davs
100
50
o n . J n nll o M
i3 3 ¥ § ¢ 5§ ¥ § & § 3 e 8§ 3 ¢ 3 § % 1
L - i i g I
3 £ : B
400
Initial
350 .Folmwp
I Total
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Glossary Term Element Structure is GlossEntry Followed by GlossTerm

The definition follows in a GlossDef element and a child Para or other appropriate
element. The GlossDef element can contain informal examples, lists, and so on.

A LINE_OF_SYNTAX

Or you might have a line of code as part of your definition.

#
.CSV

In computers, a CSV (comma-separated values) file contains the values in a table as a series of ASCII
text lines organized so that each column value is separated by a comma from the next column's value
and each row starts a new line.

A

Adverse Experience

Any adverse event (AE) associated with the use of a drug or biological product in humans, whether
or not considered product-related, including the following: An adverse event occurring in the course
of the use of a drug product in professional practice;An adverse event occurring from drug overdose
whether accidental or intentional; An adverse event occurring from drug abuse; an adverse event
occurring from drug withdrawal; and any failure of expected pharmacological action. Reporting an
adverse experience does not necessarily reflect a conclusion by the applicant or the FDA that the
product caused or contributed to the adverse experience. Adverse experience is synonymous with
adverse drug experience, adverse biological experience, adverse product experience, and adverse
event.

Affiliate

Any individual or entity related by employment or organizational structure to the applicant,
including all subsidiaries, whether domestic or foreign.

Applicant

An individual or entity who holds the new drug application (NDA), abbreviated new drug
application (ANDA), or the biologics license application (BLA). For purposes of this glossary, this
term includes any person whose name appears on the label of a marketed drug or licensed biological
product as its manufacturer, packer, distributor, shared manufacturer, joint manufacturer, or any
participant involved in divided manufacturing.

C

Causality Assessment

Determination of whether there is a reasonable possibility that the product is etiologically related to
the adverse experience. Causality assessment includes (for example) assessment of temporal
relationships, dechallenge/rechallenge information, association with (or lack of association with)
underlying disease, presence (or absence) of a more likely cause, and physiologic plausibility.
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Challenge

Administration of a suspect product by any route

Chart

A picture defined in graphics primitives and graphics attributes.

Column

A character position within a print line or on display. The positions are numbered consecutively from
1, starting at the leftmost character position and extending to the rightmost position. In relational
database, a field defined for a given record.

Command

A way to start database administration functions to access and maintain the database manager. A
statement used to initiate an action or start a service. A command consists of the command name
abbreviation, and its parameters and flags if applicable.

D
Data Mart

A subset of a data warehouse that contains data that is tailored and optimized for the specific
reporting needs of a department or team. A data mart can be a subset of a warehouse for an entire
organization, such as data that is contained in online analytical processing (OLAP) tools.

Data Mart ETL

In Data Warehouse, the extract, transform, and load (ETL) process that extracts a subset of data
from the central data warehouse, transforms it, and loads it into one or more star schemas. These
schemas then can be included in data marts to answer specific business questions.

Data Mining

The process of collecting critical business information from a data warehouse, correlating the
information and uncovering associations, patterns, and trends.

Data Warehouse

A central repository for all or significant parts of the data that an organization's business systems
collect. A subject-oriented nonvolatile collection of data used to support strategic decision making.
The warehouse is the central point of data integration for business intelligence. It is the source of
data for data marts within an enterprise and delivers a common view of enterprise data.

Dechallenge

Withdrawal of a suspect product from the patients therapeutic regimen.
Disability

A substantial disruption in one's ability to conduct normal life functions.

E

Electronic Document

A document that is stored on the computer, instead of printed on paper.
Encode

Use the following procedure to convert data by the use of a code in such a manner that
reconversion to the original form is possible.

Event Log

A log that contains information about events for a particular system or group, for a particular
metric, or for all the events that are associated with a specific monitor.

Expected Adverse Experience

Adverse experience listed in the current FDA-approved labeling for the drug or licensed biological
product. This would include any section of the labeling that refers to adverse experience
information.
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F
Field

In a record, a specified area used for a particular category of data. For example, a record about an
employee might be subdivided into fields containing the employee's name, address, and salary.

Field Description
Information that describes the characteristics of data in a field.
Field Format

A format in which the output consists of structured field introducers and variable data rather than
output in line format.

Filter
A device or program that separates data, signals, or material in accordance with specified criteria.
Form

In query management, an object that describes how to format the data for printing or displaying a
report. A display screen, printed document, or file with defined spaces for information to be
inserted.

H
Home Page

The top-level web page of a portal. Sometimes used as a synonym for default portal page.
I

Initial Reporter

The original source of information concerning an adverse experience (e.g., consumer, healthcare
professional).

L

Life-threatening Adverse Experience

An adverse experience that in the view of the initial reporter, places the patient at immediate risk of
death from the adverse experience as it occurred. It does not include an adverse experience that,
had it occurred in a more severe form, might have caused death.

N
Negative Dechallenge
Continued presence of an adverse experience after withdrawal of the suspect product.

Negative Rechallenge

Failure of the product, when reintroduced, to produce signs or symptoms similar to those observed
when the suspect product was previously introduced.

P

Positive Dechallenge

Partial or complete disappearance of an adverse experience after withdrawal of the suspect
product.

Positive Rechallenge

Reoccurrence of similar signs and symptoms upon reintroduction of the suspect product

Q
Query

A request for information from the database based on specific conditions.

R
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Rechallenge

Reintroduction of a suspect product suspected of having caused an adverse experience following a
positive dechallenge.

Report

In query management, the formatted data that results from running a query and applying a form to
it. Data that has been selected and extracted according to the reporting tool, the type of report
desired and formatting criteria

Report Type

A data source and how it is mapped.

Role

A job function that identifies the tasks that a user can perform and the resources to which a user
has access. A user can be assigned one or more roles. A definition of the access levels that users
have and the specific resources that they can modify at those levels. Users are limited in how they
can access information if they do not have the proper role. Multiple roles are permissible.

S

Serious Adverse Experience

An adverse experience occurring from any dose that results in any of the following outcomes::
Death- Life-threatening adverse experience - Initial inpatient hospitalization- Prolongation of
hospitalization Significant or persistent disability/incapacity Congenital anomaly /birth defect
(including that occurring in a fetus);- Important medical events, based upon appropriate medical
judgment, that may jeopardize the patient or subject and may require medical or surgical
intervention to prevent one of the outcomes listed above.

Spontaneous Report

A communication from an individual (e.g. health care professional, consumer) to a company or
regulatory authority that describes a suspected adverse experience. It does not include cases
identified from information solicited by the applicant such as individual cases or findings derived
from a study.

Study

Any organized data collection system (e.g., adverse experience information derived from a clinical
trial, patient registry including pregnancy registries). Reports from company sponsored patient
support programs and disease management programs should be handled as if they were study
reports and not as spontaneous reports.

Suspect Product

Drug or biological product associated with an adverse experience as determined by the initial
reporter, regardless of the opinion of the applicant.

T
Type Ahead

The functionality that offers you to type-in a value and the like values are displayed in the listbox.
It also enables you to select the desired value from the list of values.

8]

Unexpected Adverse Experience

Adverse experience not included in any section of the current FDA-approved labeling for the drug
or licensed biological product. This includes an adverse experience that may differ from a labeled
adverse experience because of greater severity or specificity (e.g., abnormal liver function versus
hepatic necrosis). Adverse experiences listed as occurring with a class of drugs or biological
products but not specifically mentioned with a particular drug or biological product are considered
unexpected (e.g., rash with antibiotic X would be unexpected if the labeling said "rash may be
associated with antibiotics"). This is because the labeling does not specifically state "rash is
associated with antibiotic X." Reports of death from an adverse experience are considered
unexpected unless the possibility of a fatal outcome from that adverse experience is stated in the
labeling.
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w
Web-based application

An application that is downloaded from the Web each time it is run. The advantage is that the
application can be run from any computer, and the software is routinely upgraded and maintained
by the hosting organization rather than by each individual user.

Web browser

A client program that initiates requests to a Web server and displays the information that the server
returns.

Web page

Any document that can be accessed by a URL on the World Wide Web.

Web Server

A software program that is capable of servicing Hypertext Transfer Protocol (HTTP) requests.
Web Site

A related collection of files available on the Web that is managed by a single entity (an organization
or an individual) and contains information in hypertext for its users. A Web site often includes
hypertext links to other Web sites.

World Wide Web (WWW Web)

A network of servers that contain programs and files. Many of the files contain hypertext links to
other documents available through the network
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